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ABSTRACT 

We are living in an era of modern science. Technology is way too much updated than 

before and it's developing very fast that anyone can't imagine. Because of this modern 

technology computer graphics, 3D animation, visualization have seen great development 

and expansion. Computer hardware and graphics software are too much powerful than 

before because of technological upgrade. We now see the use of computer graphics and 3D 

almost everywhere. TV commercial, advertisement, education, architectural work, 

engineering, medical science, technical research, 3d animated feature film, VFX in modern 

films, AR/VR are some excellent example of use of computer graphics and 3D.  

However, I am very much interested in 3D animation and visualization. To complete my 

final project in this particular topic I got an internship from AAVA 3D. There I got three 

individual topics to work on. And those topics are: 

1. 3D Product Modeling 

2. 3D Visualization 

3. Story Based 3D Animation 

There was a challenge to make the model as commercially usable and give those very detail 

to look like those are real products. And another challenge was the story based 3D 

animation which is actually kind of CG short animated film. I did this project with the 

collaboration of AAVA 3D. The challenge was to give the detail of the models, managing 

the scene properly with props, proper light setup, animating the objects, characters and 

cameras, rendering by managing the time. I tried my best to make the scenes to look like 

actual CG film.  

About the software that I used for these projects were 3ds Max, Blender 3D, Photoshop 

and After Effects which is from Adobe. I did most of my works in Blender, 3ds Max was 

used for some modeling. And After Effects for compositing and editing. 
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CHAPTER 1 

Introduction 

 

1.1 Description 

AAVA 3D is not just 3D animation training and research center, it further provides proper 

guidelines and mentorship [9]. Nowadays AAVA3D is the top choice for a creative mind 

to build their career. AAVA 3D also works for different companies and do their visual 

works. Here in AAVA 3D, I am doing my internship in three different topics. Those are 

3D product modeling, visualization and story based 3D animation. 

 

3D Modeling and Visualization: 

3D modeling is actually shapes of many things that we see in our everyday lives. From the 

video games to architectural works, we've all benefited from 3D modeling technology. So, 

what is exactly 3D modelling? What is it used for? How does it work? We are going to 

start with the definition of 3D modelling. 3D modelling is a process of creating 3-

dimensional statements of objects or the surface. 3D models are made within computer 

based 3D software. In the time of 3D modelling process, you can determine size of object’s, 

shapes and textures. This process works with points, lines and polygons to create 3D shapes 

in a 3D software. A 3D model is basically made with vertices, which come together to form 

a mesh. It's act as the core of a 3D model. Every point on the model is possible to 

manipulated to change the shape. By using the coordinate data, the 3D software identifies 

location of every vertical and horizontal point. 

 

A 3D model is basically made with vertices, which come together to form a mesh. It's act 

as the core of a 3D model. Every point on the model is possible to manipulated to change 

the shape. By using the coordinate data, the 3D software identifies location of every vertical 

and horizontal point. Most common technique to making a 3D model is to start with a basic 

shape like cube, cylinder, sphere, plane or whatever best suited. From your starter shape, 

you can start refining and molding it into what you wish. 

3D visualization gives digital 3D representation of the real life objects. It basically refers 

to the process graphical content by using 3D software. The purpose is to provide a digital 
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presentation of how the object may look like. The term of 3D visualization is used 

synonymously with graphics, rendering and computer generated imagery (CGI). 

 

It’s a technology that has become mainstream over the last few decades and has made very 

much popularity and evolved into one of the most necessary methods to producing next 

level digital content. Many industries ranging from engineering, architecture, games, films, 

medical, manufacturer are taking advantages of this technology. 

 

3D Animation: 

From our favorite Disney movies to our favorite video games, 3D animation is now present 

in most of the things we watch. Technology continues to improve and animation is getting 

livelier, sharper and cooler. So, what is actually 3D animation? 3D animation is a graphic 

technique that utilizes motion in order to bring objects, characters, props and more to life, 

that take place in a digital environment. Although 3D animation has primarily been used 

in video games, films, and TV shows. Now it's usages have grown alongside its popularity. 

Now, 3D animation is used to create visual of materials for companies that can help them 

market their products and services. 

 

The process of giving movement and life to the objects is divided into three main parts, 

which are modeling, layout and animation and rendering.  

 

Modeling is a stage in where the objects or characters are generated. This can be done 

either by using a 3D modeling tools or by scanning real objects into computer. Both 

techniques are incredibly useful and offer different advantages. Creating a model 

completely of your own, you have much more control over the entire look. Scanning real 

world objects into your computer saves a lot of time. No matter which method is used for 

modeling, textures must be added to the object or character before moving onto the next 

step. Textures allow a more realistic look, and give the model some personality. 

After the models are completed, they are moved into the layout and animation stage. There, 

they are placed and animated into a particular scene. At first, a layout must be determined 

by creating a set and adding the objects into it. Then the objects and characters must be 
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animated by assigning animation into it. Rigging is a technique to make characters and 

objects animatable. Another method, which become increasingly popular is motion capture 

technique. A live actor’s motions and movements are recorded by using markers and 

videos. Then the motions and movements directly applied to the model. 

 

The final stage is rendering, where the scene is generated into final image. This usually 

done using specific render engine, as the process of rendering is not something a typical 

computer could handle. A scene can be rendered with more realistic results, which is called 

photorealistic rendering and another is non-photorealistic rendering, which can be rendered 

to apply a particular art style. This two types of render depends on the project requirements. 

Photorealistic render requires more powerful hardware and it consumes much more time 

than the non-photorealistic render. 

 

Each of these steps of the process requires a lot of planning and work. 3D artists spend a 

lot of time on the entire process, ensuring that each model is tailored to their client’s 

expectations. 

 

 

1.2 Beginning of 3D 

Although 2D animation has been around since the 1800s, 3D graphics developed with the 

move toward fully computerized graphics in the middle of the 20th century. [7] 

 

In the 1970’s that there was the first movement towards true 3D animation, when the film, 

name FUTUREWORLD used 3D wire-framing to create a hand and face. By the end of 

the 1970’s wireframe rendering and wireframe model graphics had been used in some 

major Hollywood blockbuster movies including Star Wars for the Millennium Falcon and 

in Alien movie to create the alien. [6] 

 

3D Software continued to be refined throughout the 1980s, and 3D animation became the 

medium in the early 1990s. Veggie Tales was the first fully 3D animated series in 1993, 

and Hollywood blockbusters Terminator 2 in 1991 and Jurassic Park in 1993 both used the 
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style extensively. In 1995, 3D animation took the biggest challenge ever. A full-length 

feature film was released that year, name Toy Story by Pixar studios, and the movie 

claimed the title of the first-ever completely computer animated film. [7] 

 

1.3 Target Audience 

In the beginning as much as 3D graphics was developed for the arts and it was also being 

used for research and science. But today it doesn’t just stop there. Popularity of 3D graphics 

and animation is continuing to growing. Let’s take a look at the audience of 3D graphics 

and 3D animation. 

 

 Gaming: 3D modeling and 3D animation is central of this booming industry. 

 TV and Movies: Creating special effects (VFX) in live action movies and 

television shows or to create entirely animated programs, 3D graphics and 

animation is everywhere in TV and movies in the 21st century. 

 Commercial and Advertising: Nowadays 3D visualization and animation are 

widely using in advertisements, not just commercials, but also online such as social 

media platform and in-app advertisements. It highly attracts the audience and 

increases the selling rate. 

 Marketing: 3D graphics can punch up any marketing campaign a lot, and help to 

reach more customers. 

 Design and Architecture: 3D visual provides advantages to create a building 

design. An architect can create and analyses whole buildings model before it builds. 

3D visual and animation provides the experience of being able to walk through a 

space that does not yet exist. An engineer can create model of machines, different 

engines and automobile by using 3D graphics. 

 Prototyping: Important particularly to the manufacturing industry, prototyping 

allows to an object to be virtually created, tested and explored prior to 

manufacturing. This can further use to create machinery products. 3D animation 

allows to do the progress at much lower overhead costs. 
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 Medical Science: In medical science 3D helps to create visuals of different organs 

of human body. 3D animation also helps to understand how different organs works, 

explain about DNA, enzymes, microcellular and even submicroscopic processes. 

With the help of 3D animation, demonstrates medical equipment’s, its uses and 

features. It could be also used as a training info for its customers and healthcare 

professionals. It is an excellent way to show how a medical device works and how 

to operate that. 

So, target audience of 3D modeling, visualization and animation is almost every sector. 

 

1.4 Project Timeline (Gantt Chart) 

Project 1: 3D Modeling and Visualization (Bubble Tea Shop Modeling and Sato V Trap 

Installation Process) 

Gantt Chart 1 

 

Table 1.1: Project 1 Timeline 
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Project 2: 3D Animation (Story Based Short CG Animation) 

Gantt Chart 2 

 

Table 1.2: Project 2 Timeline 
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CHAPTER 2 

Background Study 

 

This paper is based on three different projects given from AAVA 3D, in which I'm 

currently doing my internship. So, background study will be different from each other. I’m 

going to explain those differently. 

 

2.1 History of 3D Modeling 

Surprisingly, history of 3D modeling began before the first PC invented. It all started with 

mathematical ideas that are behind visualization of 3D. Some of the basic ideas came from 

Euclid, sometimes referred to as the “founder of geometry”, who lived in the third century 

BC. Then, Rene Descartes in the 1600s gave the world analytic geometry, it also known as 

co-ordinate geometry, which allowed to accurately track distances and also the locations. 

 

 

Figure 2.1: Euclid's Elements of Geometry 

In the mid-18th century, English mathematician, name James Joseph Sylvester invented 

matrix mathematics, which is now work for every computer generated image where one 

can see reflections and light distortion. In the 1950's, computer was developed and put to 

many mathematical uses, only for scientific and military. 
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First advancements in the history of 3D modeling came when the first commercially 

available Computer Aided Design systems (CAD) started coming out in 1960's. The 

biggest breakthrough came from Ivan Sutherland who introduced Sketchpad in 1963 with 

its revolutionary interface. It also known as Robot Draftsman. Sketchpad can be used not 

only for engineering or repetitive drafting but interactively by designers and potentially 

artists. At the end of the decade, Ivan Sutherland and David Evans founded the first 3D 

graphics company, name “Evans & Sutherland”. They started the company to produce 

hardware that can run the systems, but were soon also for software development. Their 

appearance and success inspired others to start up their own companies and work on 

developing the technology. 

 

ADAM is a CAD system released in 1971. It was developed to work on as many machines 

as possible. MAGI was a company, they introduced solid 3D modeling, and creating new 

demand for CAD, universities were working hard to advance the history of 3D modeling 

and discover new and more useful technologies to visualize 3D model.  

 

Year 1981, the first IBM PC was introduced, caused an extensive use of CAD in not just 

automotive and aerospace industries but also in the commercial engineering businesses. 

Solid 3D modeling then became the mainstream with the development of software such as 

Unigraphics UniSolids CAD. In year 1983, 2D system of AutoCAD was released and it 

was the first significant CAD program in the history of 3D modeling for the IBM PC.  

 

In 1990's, because of IBM PC, CAD software was widely spread and being tested to its 

limits. It became cheaper and easier to access, and professional programs and hardware 

allowing for any company, freelancer and hobbyist to create 3D models. The software was 

then constantly developing and changing, was allowing for faster access and a more user-

friendly experience. [12] 

 

2.2 Background Study 

As this report is about 3D product modeling and visualization, so I studied on some related 

documents to get more information. 
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3D Product model has transformed the way of product development works. Today it is 

used by several industries and has been heavily impacting their businesses. Do you know 

that 3D product modeling was originated in year 1960? it’s evolved in the most captivating 

ways ever since. 

3D Product modeling is a composition of geometry, science, design and mathematics. It is 

defined as the method of creating a mathematical depiction of a 3D structure using 

specialized 3D software. This is a representation of a formation called 3D model, which is 

the best way to visualize a real product. 

- 3D artists are able to make product modeling prototypes on their digital screens. 

- The influx of new functional and technological applications has improved the way 

3D modeling works. 

- The new developments in product modeling have helped to remove all the 

limitations of outdated processes. 

- It increased the functionality and productivity across design teams. 

 

3D product modeling can influence your business. Showcasing 3D Product models can 

simplify the magnificent representation of your innovative product designs. 

- Product modeling can offer your potential clients an impressive experience giving 

them a very detailed view of what the actual product will look like. 

- Marketing team can use 3D product models for campaigns purpose. 3D product 

models can showcase all the features and capabilities of the products. 

- You can interact with the 3D product model through various functionalities like 

rotating, disassembling and reassembling. 

- It is possible to show 3D products in virtual reality through VR headset which gives 

more experience. 
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Figure 2.2: 3D product modeling and visualization 

 

3D product visualization provides visuals that showcase products in a much more 

impressive way than a simple text-based product description. These can be anything like 

360-degree video, showing the products from different angles and an interactive view 

which shows a product’s internal components. 

 

Imagine you’re shopping online for a new bag from your home. With a 3D visualization, 

you can filter and choose between multiple variations of the same bag, and narrow your 

selection by size, color, and materials. This allows you to gather information and easily 

determine which bag will fit your needs. 3D product visualization enables brands to offer 

the highly engaging experiences what today’s customers look for. Potential customers can 

inspect in detail a product before buying it and allowing them to better understand what 

they are purchasing. Customers are able see products from every angle, and switch between 

various colors and models with a simple click. 

 

3D product visualization is an alternative of product photography. However, photography 

has its place and can artfully exhibit a completed project, where 3D visualization offers a 

few advantages over traditional product photography. 
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- You can showcase every angle your product at once that provides a better user 

experience.  

- You can be designing a 3D model of a product while the product is still being 

developed and can show it to the consumer. In that way, you can launch your 

marketing campaigns just as the product is ready.  

- 3D visualization offers more flexibility of a product and modifications are very 

easy, if you change an element of their design your products don’t have to be reshot, 

and you can quickly create so many product variations. 

3D product visualization and photography both can clearly and efficiently highlight a 

product’s selling points. 
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CHAPTER 3 

Details of Software Used 

 

3.1 Software Used 

To complete the entire projects, I had to use software. Because these whole projects were 

done by using software. To make 3D modeling, visualization and 3D animation, from the 

beginning to the final output different software were used in different stages.  

 

Software: 

- Autodesk 3ds Max 

- Blender 3.0 

- Nextlimit Real Flow 

- Adobe After Effects 

- Adobe Media Encoder 

- Adobe Photoshop 

- Adobe Illustrator 

- Audacity 

 

Figure 3.1: Software Logo 
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3.2 Software Details 

 

Autodesk 3ds Max: 

3ds Max, earlier known as 3D Studio Max or just 3D Studio. It was developed by Yost 

Group, a company started by the renowned filmmaker and software designer named Gary 

Yost, and was first published by Autodesk Inc. in 1996. 3ds Max is a 3D professional 

modeling, animation, and rendering application which was developed for making 3D 

models, animations, interactive games, visual effects for the entertainment industry and, 

3D models and visuals for the engineers. It can bring characters to life by using a special 

feature called the inverse kinematics. It plays a huge role in designing 2D cross section 

shape of 3D models. It is capable of architectural modeling and visualization, and it serves 

as a tool in product design and manufacturing. It is a massive 3D software that is in used 

of almost every industry for different purposes. Understanding this software is little hard 

for a beginner. [14] 

 

3ds Max has an amazing set of tools, commands and it supports unique features that make 

it a user-friendly 3D software. It has various unique built-in primitive shapes such as plains, 

cubes, cylinders, teapots, cones, pyramids that are used as a foundation for modeling. 3D 

graphics programs, that using geometric data to create objects is called 3D models. There 

are four main methods of 3D modeling which are polygon, primitive, non-uniform rational 

basis spline (NURBS) and rational basis spline. 3ds Max basically uses the polygon 

modeling method. Polygon modeling gives a user specific control over the individual 

meshes through X, Y and Z coordinates, which appear as a group of vertices, edges and 

faces. This program is also used in the simulation of mechanical parts as it supports the 

NURBS features. NURBS allows smooth modeling by using mathematical formulas. 

Character modeling is also made simpler in 3ds Max as it includes simulations for skin, 

hair, fur and cloth. These inbuilt tools reduce the time taken for modeling and enhance the 

detailing of an object or character. [15] 

 

Besides, 3D Studio Max supports 3D rendering characteristics. One of the interesting 

abilities of the program is that users can view the rendering results without rendering the 
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scene. This feature can be turn on by starting the “Active Shade Mode” in the program 

itself. 

 

 

Figure 3.2.1: 3ds Max 2020 Interface 

 

3ds Max offers a multipurpose interface that sets itself different from competing products 

such as Blender and Maya. The interface of 3ds Max is clear and very user-friendly. Users 

can also customize their own user interface in different ways. For example, command 

panels and toolbars can be moved around for a more convenient workflow. New toolbars 

and buttons, and custom recording scripts and keyboard shortcuts can take the interface 

even further. Plugins can be used with great ease and without any lagging with render 

programs like V-ray, Corona, Redshift and others. 

 

Some of the major advantages: 

- It supports huge numbers of tool that are easily available for modeling. 

- It’s very user-friendly, especially in modeling. 

- It supports the "Material Editor" that allows the user to create and edit materials 

and maps in the objects. 

- It supports multiple tools for animation and it supports plugins. 

- It works and blends with other Autodesk products perfectly. 
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- It has strong rendering abilities and advanced usage with industry-standard 

products. 

 

Blender: 

Blender is a free and open source 3D creation software that supports almost every aspect 

of 3D development. With a strong foundation of modeling capabilities, texturing and 

shading, rigging, animation, lighting, and a host of so many tools for complete 3D creation. 

Whether you want to deal static models or get into the world of animation, this software 

will bring your imagination to visual. Blender is also a great tool to deal with 2D graphics. 

Many professionals who work as modelers, texturing and skinning, skeleton, rendering, 

rigging and animation, simulation, motion graphics, videogame, and movie VFX artists 

can use this application for the project pipeline. Blender become very popular among the 

video game developers and animators because of its user-friendly interface, which has both 

3D editing mode and scripts-based editing for effective and best-quality data output. This 

application has all sets and presets to work along with the most suitable plugging as 

required. Blender can be compared with other similar software like Cinema 4D, MAYA, 

3Ds Max and more. Though Blender is free, it is accessible and valuable for a wide range 

of users, from the beginner to the professional animator. Even NASA uses Blender for 

many of its public models. [16] 

 

A Dutch animation studio NeoGeo started to develop Blender as an in-house application, 

and January 2, 1994 is considered to be Blender's birthday. Blender Version 1.0 was 

released in January 1995, with the primary writer being company co-owner and software 

developer Ton Roosendaal. The name Blender was inspired by a song by the Swiss 

electronic band Yello, album name "Baby", which NeoGeo used in its showreel. Some 

design choices and experiences for Blender were carried over from an earlier application, 

called Traces. This application Roosendaal developed for NeoGeo on the Commodore 

Amiga platform during the 1987–1991 period. In 1998, January 1 Blender was released 

publicly online as SGI (Silicon Graphics, Inc.) freeware. [19] 
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As you may have known, one of the best things about Blender is it’s completely free to 

use. Blender has been released under GNU (General Public License), which allows people 

to: 

 Use Blender for any intention. 

 Distribute Blender. 

 Study how Blender works and change it. 

 Distribute changed versions of Blender. 

 

 

Figure 3.2.2: Interface of Blender 3.0.1 

 

Main Features of Blender: 

- For development of 3D contents blender provides a wide range of essential tools 

that includes modelling and sculpting, shading and texturing, animation & rigging, 

rendering, video editing, VFX, compositing, and so many simulation forms. 

- It has high quality of 3D architecture tools that enables fast and efficient creation 

of workflow. 

- Blender has so many built-in addons which make its user to work fluently and it 

supports many external addons that developed by the creators. 
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- Blender application is a cross-platform tool which is developed in collaboration 

with a uniform OpenGL GUI on all major platforms and besides it allows to 

customize with Python scripts. 

- It has active community support, those who assist in solving problems of 

community members, blender.org/community. 

- Blender allows a wide variety of tasks, and when first attempting to understand the 

fundamentals, it can seem Irresistible. However, after practicing few hours, it is 

possible to familiarize yourself with Blender with the help of right learning content. 

 

A user can use blender for multiple reasons based on the project pipeline as described 

below: 

- Animated films and VFX scenes can be developed as imagined and by adding 

and adjusting all technical attribution of lighting and using camera angles to 

achieve the resulted output to entertain the audience. 

- Engineering presentations and details of mechanical design can be added to the 

model. Performance of engine, pressure, material and other engineering 

calculation can be explained through demo. 

- Game concepts and models can be developed, and regulation can be added by 

python scripting and experiencing them by its own game engine to check 

visually compatible for all mobile system and other electronic device. 

- Students can learn and study about animation of movie-making and gaming 

concepts and technical aspects. 

 

Nextlimit Real Flow: 

RealFlow is an industry standard, out of the box fluid and dynamics simulation software 

mostly used by 3D and visual effects industry, which was developed by Next Limit 

Technologies in Madrid, Spain. RealFlow is compatible with ALL major 3D application 

to simulate fluids, water surfaces, soft bodies, rigid bodies, and meshes, and can simulate 

anything from a single drop of liquid to a massive tsunami. For large-scale simulations like 

floods or oceans with breaking waves, RealFlow's cutting-edge HyFLIP solver, Hybrido, 

provides you with endless possibilities. Dyverso is a multiphysics solver that can be used 
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to simulate a wide range of different type of materials, rigid, granular, elastic, liquid, etc. 

All of them interacting with each other and using the modern GPUs to calculate simulation 

data. RealWave is a very powerful simulation tool of realflow, ideal for simulating small 

to massive ocean surfaces quickly and effectively. Caronte is RealFlow’s built-in rigid and 

soft body dynamics solver. [20] [21] 

 

RealFlow was first released in 1998 by Next Limit Technologies. In year 2008, Next Limit 

Technologies was awarded by the Academy of Motion Picture Arts and Sciences for their 

development of the RealFlow software. In 2015, Next Limit Technologies released the 

RealFlow Core for Cinema 4D. [20] 

 

RealFlow technology uses particle based simulation system. These particles can be 

influenced in various ways by point-based nodes, which can do several tasks such as 

simulate gravity or recreate the vortex like motion of a tornado. RealFlow can also simulate 

soft body and rigid body collisions and interactions. The inclusion of Python scripting and 

C++ plug-ins allows users to program their own tools to improve RealFlow capabilities, 

adding more control to the aspects of the RealFlow workflow including batch runs, events, 

daemons, fluids and waves. RFConnect is a plugin of RealFlow that supports following 

DCC applications: 3ds Max, Maya, Cinema 4D and Houdini. 

 

In 2015 RealFlow was released to the public. Features of this major release are: 

- New DYVERSO solvers with GPU acceleration. 

- Maxwell Render facility. 

- Enhanced quality of simulations. 

- Improved user interface. 

- Rapid OpenVDB meshing and DYVERSO solvers speed up the simulation times 

by 10x. 

- More controllability splines nodes, text tools, daemons falloff and crown daemon. 
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Figure 3.2.3: Interface of RealFlow 10 

 

Adobe After Effects: 

Adobe After Effects is a motion graphics, visual effects and compositing application which 

was developed by Adobe Systems and it used in the post-production process, commercial 

and television production. Among other things, After Effects can be used for keying, 

tracking, compositing, social media content and 2D animation making. For scientific and 

technical achievement Adobe After Effects won an Academy Award in 2019. [22] 

After Effects was originally created by David Simons, David Herbstman, David M. Cotter, 

Daniel Wilk and Russell Belfer at the Company of Science and Art in Providence, Rhode 

Island, where the first two versions of the software, 1.0 in January 1993 and 1.1, were 

released by the company, CoSA. After Effects was then acquired by Aldus Corporation in 

July 1993, which was acquired by Adobe in 1994. Version 3.0 was Adobe's first new 

release After Effects. [22] 

 

After Effects helps graphic designers and motion graphics artists to give animation to 

logos, cartoons, and objects with the help of a key framing process. The application is 

specially designed in such a way that created files do not get destroyed. It also hence the 

program supports in a non-linear editor. it has so many editing tools, features, effects and 
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presets that make Adobe After Effects an important and immensely attractive software. 

There is a feature in after effects which is Camera Tracking that helps the user to track and 

edit the original video and modify and add any text, objects or video in between the original 

video clip. There is another special feature in After Effects called Expression that helps the 

user speed up the animation process by controlling the animation sequences using codes. 

 

With the help of tools and features After Effects is generally used to create compositions. 

With the help of the 360-composition editor users can compose and edit videos for VR. 

This application also features a visual keyboard shortcut editor, user can create keyboard 

shortcuts of their own, which helps them to modify and animate the videos more easily and 

speedily. This application farther helps the user to create Null object and create Masks, 

Shapes, and Brush lines. Roto Brush Tool that helps to change background of a scene. 

Before, it was difficult for the users to edit the background that has motion in it, but now 

with the help of the Roto Brush tool, the users can easily edit the background with a single 

stroke of a brush. [23] 

 

Functional of After Effects can be extended through a different of third-party integrations, 

which are: plug-ins, scripts and extensions. Plug-ins are mainly written in C or C++, which 

extend the functionality of this application, allowing for more advanced features such as 

particle systems, 3D effects and reduce the gap between After Effects and another 

application. 
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Figure 3.2.4: Interface of Adobe After Effects CC 2020 

 

Adobe Photoshop: 

Photoshop is a photo editing and raster graphic design application that allows users to 

create, edit and manipulate various graphics as well as digital art. it offers its users the 

ability to create, enhance and edit images, artwork, and illustrations, changing 

backgrounds, simulating a real-life painting or creating an alternative view of the universe. 

It makes use of layering to allow depth and flexibility in design and editing process. It is 

the most widely used software for photo editing and image manipulation, creating image 

compositions, website mockups, adding affects and retouching for numerous image and 

video file. Photoshop makes possible to edit individual images as well as large batches of 

photos. Photoshop CC, Photoshop Elements, Photoshop Lightroom and Photoshop Express 

are some different types of Photoshop. 

 

Adobe Photoshop was originally developed by two brother Thomas and John Knoll in 

1987, and later in 1988 Adobe Systems Inc. bought the license to distribute. 

Thomas Knoll, a Ph.D student at the University of Michigan, wrote a program on his 

Macintosh Plus that basically displayed images on a screen and called it “Display”. His 

brother John, who worked at industrial Light & Magic convinced him to make a full 



©Daffodil International University   22 

program of it. Thomas choose a name for this program, which is ImagePro, but the name 

was already taken by another company. Thomas then renamed his program Photoshop.  

They made a short-term deal with Barneyscan. It's a scanner manufacturer. They distribute 

copies of the program with a slide scanner they were selling. Around 200 copies of 

Photoshop were shipped this way. John traveled to Silicon Valley and gave a demonstration 

of the program to the engineers of Apple Computer and art director of Adobe, Russell 

Brown. Adobe purchased the license to distribute it. February 19, 1990, Photoshop version 

1.0 was released for the Macintosh exclusively. Price of Photoshop 1.0 for Macintosh was 

$895 in 1990. [24] 

 

Figure 3.2.5: Interface of Adobe Photoshop CC 2020 

 

Photoshop is specifically designed to create and edit raster images in multiple layers. These 

layers can support transparency and also can act as masks that can alter underlying images 

in the layers below them. Shadows and several effects such as alpha compositing can be 

applied in Photoshop. It is also possible of apply several color models to these layers like 

RGB, CMYK, Spot Color and Duotone and Lap color space. Photoshop Document (.PSD) 

is the default file extension for Photoshop. PSD file has maximum of 30,000 pixels for 

width and height and a file length limit of 2GB. Photoshop Big (.PSB) is the largest file 
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format of Photoshop with maximum 300,000 pixels for width and height and also extends 

the length limit to around 4 Exabytes. 

There are many advantages of this best drawing software: 

- Resizing images to a desired pixel height and width can be very easily done by 

using Photoshop. 

- Photoshop gives the ability to customize images, graphics and more that fit your 

brand’s specific needs. Photoshop supports numerous file types and invites 

collaboration and ensure accessibility to every designer on your team. 

- Photoshop is also widely used for designing graphics and layouts for websites and 

it offers a wide variety of patterns and features to make an impressive website 

design with a website layout. 

- You can restore old and damage photos in Photoshop with the help of special tools 

and filters. 

- PSD is the master file type and these are some other file formats Photoshop can 

work with and export: JPEG, TIFF, PNG, GIF, MOV, DPX, MPEG4, PDF etc. 

- Basic image editing such as red-eye removal, skin tone adjustments, adding or 

removing blur, teeth whitening, background adjustments are just a click away, 

which can be done by Photoshop and save a lot of time. 

- There are lots library of digital painting brushes for Photoshop that can help you to 

make artworks. 

- Highly customizable keyboard shortcuts for a smooth and time saving workflow. 

- Photoshop can be installed on Windows, macOS, iOS, iPad OS, Android. 

Adobe Illustrator: 

Adobe Illustrator is a design based software for creating vector graphics, logos, drawings, 

banner, posters, typefaces, presentations and other artworks. It's a vector-based software 

which is made specially for graphic designers. Adobe Illustrator can be defined as the only 

software which was previously made for graphic designers. Adobe Illustrator provides a 

perfect user friendly interface. If you are working in a team, then it makes your job easier 

to train new employees.  
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Adobe Systems was founded in 1982 by two American mathematicians John Warnock and 

Chuck Geschke and Illustrator was the first software application from Adobe Systems and 

it was released in 1987 for the Apple Macintosh. The most significant feature is its pen 

tool, which allow the user to draw smooth curves and create high-resolution shapes and 

images. In 1989, Adobe released Illustrator for Microsoft Windows PC. In 2003, Adobe 

released Illustrator CS version 11, CS means Creative Suite, which bundled together 

Illustrator, Photoshop, InDesign and Acrobat. Illustrator CS6 was the last version of 

Illustrator CS that was released in 2012. It has already developed a lot of new features that 

we see in new illustrator versions today. After Version CS6, Adobe introduced new 

Illustrator version which is CC (Creative Cloud), in 2013. So, future versions of Illustrator 

and its other software would be available only through an Internet subscription service 

called Adobe Creative Cloud. Through the years, Illustrator continued to expand, adding 

support for TrueType, more-complex drawing tools, an ever-increasing number of drawing 

“Layers” and support for 3D figures. 

 

Working with Adobe Illustrator makes more comfortable as it has enough advantages: 

- You can make a banner or poster of any size start from a small dot to large flex. 

- It has some readymade tools from which you can make variety of shapes. 

- Importing, editing and modifying of images can be done with just one platform. 

- This is very easy to use with other Adobe products. 

 

Graphic designers mostly use Illustrator for creating logos, banners and posters, 

illustrations and artwork, typeface, infographics etc, mostly vector-based graphics. You 

can resize any vector graphics without losing the quality of it. For logo design Adobe 

Illustrator is the best and it's an industry standard design software. Another reason why 

most of the graphics designers love Illustrator is the flexibility. You can really do a lot with 

it, from changing colors, modifying shapes and fonts, and so much more, huge tools and 

presets are available in it. The default file format for projects created in Illustrator is AI 

format, but it can also save files as EPS (encapsulated postscript), PDF, SVG, AIT. It can 

export graphics as JPEG, PNG, BMP, DWG and other graphics formats. 
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Figure 3.2.6: Interface of Adobe Illustrator CC 2020 

 

Audacity: Audacity is a free, open-source digital audio editing software that allows users 

to record, edit, and manipulate sound files. It is available for Windows, macOS, and Linux 

operating systems, and offers a wide range of features such as multi-track editing, effects, 

noise reduction, and support for various audio file formats. 

Audacity is popular among podcasters, musicians, and sound engineers due to its versatility 

and ease of use. It allows users to create professional-quality audio recordings and edit 

them with precision. With its wide range of features and intuitive interface, Audacity is a 

powerful tool for anyone looking to create, edit, or manipulate audio files. 

 

Figure 3.2.7: Interface of Audacity Software 
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CHAPTER 4 

Workflow 

 

Three different project given from AAVA 3D. But, here I’m going to explain my workflow 

step by step in three different point. 

1. 3D Product Modeling (Bubble Tea Shop) 

2. 3D Visualization (Sato V Trap Installation Process) 

3. Story Based 3D Animation (Story Based Short CG Animation “Alien: First Kill”) 

 

4.1 3D Product Modeling (Bubble Tea Shop) 

“Bubble Tea Shop”, It’s a drinkable food item. I created model of it and render that out as 

3D product modeling. This task was from AAVA 3D. 3ds Max, RealFlow, Blender, 

Illustrator and Photoshop was used for this project. 

Modeling:  

Most of the time modeling starts with a reference image. I got reference image from AAVA 

3D to start the product modeling. I had to model exact same model like the reference image. 

There are several applications available for 3D modeling. Different application provides 

different technique for modeling. But I choose 3ds Max, because there is some easy 

technique to model a tea glass like the reference image. 

 

 

Figure 4.1.1: Reference Image for Tea Glass Modeling 
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Here I used spline to draw the basic 2D shape of the glass. After that I applied a modifier 

called “Lathe”. Lath modifier is a modifier, that has the ability to convert spline shapes into 

3D. It’s a fast modeling technique that modelers widely use to make 3D shapes in where 

it’s little hard to make model manually. 

 

 

Figure 4.1.2: Glass Modeling 

 

After that I converted the glass model into Editable poly. Without converting the model 

it’s not possible to apply texture or render out the model properly. Then I applied another 

modifier called “Shell”. Shell is a modifier that gives a depth to the plane model.  

Shell: 

Inner Amount: 0.0cm 

Outer Amount: 0.483cm 

Segments: 1 
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Figure 4.1.3: Shell Modifier 

 

Before I head to the next step I exported the model as .OBJ file with Triangle Faces. 

Because RealFlow software can’t work with Quad Faces. 

 

 

Figure 4.1.4: .OBJ Export 
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Fluid Simulation: 

To Fill the glass with fluid I used one of the best software for fluid simulation “RealFlow”. 

It’s really needed to fill the glass with fluid, because the fluid will visual as tea. After 

importing the glass model onto the Realflow software, there was several particles system 

to fill it. Here I used Dyverso Circle. I resized the Circle according to the needs. Then I add 

Gravity Daemon, so that particles can flow towards ground. 

 

Adjustment of the parameters: 

Dyverso Domain: 

Particle Type: Liquid-PBD 

Resolution: 5.0 

Density: 1000.0 

Internal Pressure: 1.0 

External Pressure Scale: 0.1 

Surface Tension: 0.0 

Tensile Strength: 0.1 

Dyverso Emitter: 

Volume: 0.0 

Speed: 2.0-0.0 

Simulation Type: Active 

Gravity Daemon: 

Affect: Force 

Strength: 9.8 

Object: 

Volume Cell Size: 0.035 

Volume Mode: Shell 
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Figure 4.1.5: Relationship Editor (Dyverso Parameter) 

 

Particle & Daemon tools, object, Particle Mesh should be connected through Hub in 

relationship editor. We can connect it by Pressing “CTRL>Drag L Mouse Button”. Object, 

Gravity Daemon, Dyverso Domain should be directly connected to the Hub and Dyverso 

Emitter with the Dyverso Domain. 200 frames were good enough to complete the 

simulation and fill the glass. After selecting the frames, I started the simulation with 1000 

density and speed limit 2.0. At frame 148 I added a keyframe on the speed limit and at 

Frame 150 I added another keyframe and set the speed limit to 0.0, so that the particles 

don’t get over flow. After the simulation complete, I converted the particles into mesh by 

using Particle Mesh VDB. There is problem here, which is only a single frame convert into 

mesh. So, I again simulated all the frames. The next step was stitch the files to make it just 

one file. Alembic (.abc) file is what RealFlow create for simulation. To stitch the Alembic 

sequence files there is a tool in RealFlow called “Stitch alembic files”. I used that tool to 

stitch all that Alembic files together to make it single.  
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Figure 4.1.6: Filling The Glass 

 

Adding Condensation or Water Droplets: 

Condensation is water droplets around the object. In the “Bubble Tea Shop” reference 

images, the glasses have water droplets added. Water droplets condensed around an object 

when that object is cold. Bubble tea is a cold drink item, so there must be water droplets 

around it.  

I imported the fluid simulation .abc file and the glass model in the Blender for the final 

works. Here I added water droplets around the glass. 

 

Figure 4.1.7: Water Droplets 
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There are several ways to add water droplets in an object. But I used Blenders’ Geometry 

Nodes for this process, because it is the most efficient way. At first I created a single water 

droplet model. Then, by using the Geometry Nodes I spread water droplets around the 

glass. 

Process of adding water droplets using Geometry Nodes: 

- Group Input 

- Group Output 

- Distribute Points on Faces 

- Object Info 

- Random Value 

- Instance on Points 

- Join Geometry 

 

 

Figure 4.1.8: Geometry Nodes for Water Droplets 

 

- Group Input < Distribute Points on Faces < Instance on Points < Join Geometry < 

Group Output 

- Object Info < Instance on Points < Join Geometry < Group Output 

- Random Value < Instance on Points 
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Here, Distribute Points on Faces node adds points on the surface of the input geometry 

object. Object Info node allows to which object will appear on faces. Random Value node 

controls the location/rotation, minimum or maximum amount. Instance on Points node 

are a fast way to add same geometry to a scene many times without duplicating it. Join 

Geometry node join the data together. 

 

 

Figure 4.1.9: Water Droplets Material 

 

For water droplets material I used Principled BSDF:  

Roughness 0.0  

Transmission 1.0  

IOR 1.33 
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Adding Ice-cubes and foam: 

Ice cubes are just cubes with subdivide many times. I sculpted those to look different from 

each other. Then I added displace modifier and on the texture properties I used cloud 

texture to displace the cubes to look more realistic ice cube. 

 

 

Figure 4.1.10: Ice Cube Material 

For the ice cubes material, I used Noise Texture, Bump node, Color Ramp node and 

Principle BSDF node. Principle BSDF (Transmission 1.0 and IOR 1.33), Bump node 

(Strength 0.483), Noise Texture (Scale 3.9, Detail 2.9 and Roughness 0.558). 

 

 

Figure 4.1.11: Ice Cube Rigid Body 
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To place the cubes inside the glass, here I used Rigid Body Dynamics. This process helps 

to simulate and place the cubes perfectly inside the glass. Inside the glass I places a 

collision object. So, that the cubes could not pass through the glass. 150 frames were good 

enough for this Rigid Body simulation. 

 

For the foam, I selected the glass model first. In the edit mode I selected the top faces. By 

separating the faces (Shift D for duplicate > P for separate selection), I fill the upper and 

low portion (By pressing F key). Then I subdivide it few times. After that I switched to 

sculpting mode to sculpted the model to look like it’s foam. I used “Draw” and “Inflate” 

tool for sculpting.  

 

Figure 4.1.12: Bubble Tea Foam 

For texturing the foam model, here I used Texture Coordinate node, Mapping node, 

Voronoi Texture (Scale 6.0 and Randomness 1.0), Bump node (Strength 0.358) and 

Principled BSDF (Emission Strength 0.4 and Emission Color #7F8080). 

 

Figure 4.1.13: Foam Shader Node 
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Adding Bubble Tea Shop Logo: 

Adding “Bubble Tea Shop” logo in front of the glass was little difficult for me. Because I 

used completely new method here which I never used before. But the method was very 

efficient. 

 

 

Figure 4.1.14: Bubble Tea Shop Logo 

 

At first I added text logo to the scene. In the text properties, geometry section I extruded 

the text (0.01m). Then I added “Remesh” modifier, then Sharp (Octree Depth 8, Scale 0.9 

and Sharpness 1.0). After that I added “Shrinkwrap” modifier. Shrinkwrap modifier helps 

to place object onto the surface. 

Snap Mode - On Surface,  

Axis - Z,  

Negative - checked,  

Positive - checked, 

Face Cull - Off, 

Target Object - Cup, 

Offset - 0.01m 
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Shading & Texturing: 

Total fourteen different bubble tea drinks I had to texture like the reference images. It was 

quite complicated to make exact same, because those have to look more realistic like the 

reference images. 

 

 

Figure 4.1.15: Reference Image of Bubble Tea Drinks 
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First of all, the glass material, it should be transparent kind of water color material. There 

is a shader node called “Glass BSDF”. For the glass I used Glass BSDF material 

(Beckmann, Color #FFFFFF, Roughness 0.2, IOR 1.45). 

 

Figure 4.1.16: Glass Material 

 

Next step is to texture the drinks which is bubble tea. Total fourteen different bubble tea 

drinks. 

1) Cranberry: Cranberry is a red tea drink. To get that specific effect, I used Texture 

Coordinate node, Mapping node, Separate XYZ node, ColorRamp node (Color 

#FF7A47 and #EE2B2B) and a Glass BSDF (Roughness 0.0). 

 

Figure 4.1.17: Cranberry Texture 
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2) Passion Fruit: It has the same Glass BSDF material, But Roughness 0.285 and IOR 

2.0 and Color #D69721. 

 

Figure 4.1.18: Passion Fruit Texture 

 

3) Kiwi: Texture used here, Texture Coordinate node, Mapping node, Separate XYZ 

node, ColorRamp node (Color #FAFF9F, #D8D148 and #C3C38F) and a Glass 

BSDF (Roughness 0.592 and IOR 1.650). 

 

Figure 4.1.19: Kiwi Texture 
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4) Taro: Glass BSDF material, Roughness 1.0 and IOR 166.6 and Color #CABDE6. 

 

Figure 4.1.20: Taro Texture 

 

5) Bubble Tea Original: Glass BSDF material, Roughness 1.0 and IOR 166.6 and 

Color #E6B296. 

 

Figure 4.1.21: Bubble Tea Original Texture 

 

6) Yin Yang: Texture Coordinate node, Mapping node, Gradient Texture node, 

ColorRamp node (Color #D18F57 and #FFC77C) and a Glass BSDF (Roughness 

1.0 and IOR 166.6). 
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Figure 4.1.22: Yin Yang Texture 

 

7) And rest of the tea textures are almost similar with various Glass BSDF roughness 

and IOR, various ColorRamps color and Gradient Texture node. By adjusting nodes 

parameters several times, I got the exact result for those bubble tea drinks. 

 

 

Figure 4.1.23: Other flavors Texture 
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Lighting & Camera Setup: 

For the light setup, I used two planes and then I applied two different emission shader. 

Emission shader usually use for glow up an object and lighting the environment. Two 

different planes, one is on the top and another as back light. 

Top emission shader: Strength 12 and Color #FFE6CE. 

Back emission Shader: Strength 5 and Color #FFE6CE. 

For the environment, no HDRI was used, just white color with 1.0 strength. 

 

Figure 4.1.24: Bubble Tea Camera 

For the camera setup, 

Focal length: 50mm 

Sensor size: 36mm 

Resolution: X 1920px and Y 2700px 

 

Render Setup: 

Render Engine: Cycles 

Device: GPU Compute 

Render Sampling, 

Samples: 2048 

Time Limit: 0 sec 

Denoise: checked 

Denoiser: Optix 

Passes: Albedo and Normal 
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Final Output: 

 

Figure 4.1.25: Bubble Tea Shop Final Output 1 

 

Figure 4.1.26: Bubble Tea Shop Final Output 2 
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4.2 3D Visualization (Sato V Trap Installation Process) 

Sato V Trap, slogan “A Better Life. Every Day”, is a toilet pan which uses a mechanical 

and water seals to close off pit latrines form open air. It’s a sanitary product. I got a task 

from AAVA3D to make a 3D visualization for Sato V Trap installation process and it was 

their client's project. For modeling and texturing, animation, simulation, lighting and 

rendering I used Blender Software. And for the final edit I used Adobe After Effects and 

Adobe Illustrator. 

Modeling and Texturing: 

5 different Sato pan 3D models were provided by the client to work on: 

- Upper Housing 

- Lower Housing 

- Diversion Bucket 

- Flap Door 

- Sato Pan 

 

Figure 4.2.1: Sato V Trap All Models 

 

For texturing those models, I used several shader node. As the actual Sato pan is made of 

plastic, so I adjust the shader node parameter to make is look like real plastic.  
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Upper housing, Sato pan and flap door, material for these three are same and here is the 

material that was used, Diffuse BSDF (Color #293EA6, Roughness 0.0), Glossy BSDF 

(Color #293EA6, Roughness 0.192), Mix Shader (Fac 0.5). Diffuse BSDF and Glossy 

BSDF was mixed by using Mix Shader. Than a glossy plastic look appeared. 

 

 

Figure 4.2.2: Sato V Trap Materials 

 

Lower housing and Diversion Bucket, material for these two are same and black plastic 

material was used here. Diffuse BSDF (Color #1D1D1D, Roughness 0.0), Glossy BSDF 

(Color #3F3F3F, Roughness 0.292), Mix Shader (Fac 0.5). 

 

For modeling the toilet, at first I model the pan holder and the base. I used cube mesh for 

the base model. Then I added another cube as the pan holder. I modified and made a hole 

inside the cube as same shape as the pan, so that I can fit the pan inside the cube. To make 

the hole similar to the pan I used a modifier called “Boolean”. 

Boolean modifier > Select Difference > Operand Type - (Object) > Object - (Select “Pan 

model”) > Solver Type - (Exact) 

Finally, I applied the modifier and the exact hole like the pan model was created. 
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Then the pillar model, pillar models are just the cube mesh with some modification. I UV 

unwrapped the model and applied cement texture onto it. I placed all 6 pillar models around 

the four corner of the base model. 

 

Figure 4.2.3: Toilet Pillars 

 

Next step is the fence model. Plane mesh was used to model the tin fence. In the edit model 

I added few loop cuts, then I move the edges a little bit. CTRL+A select all edges, then 

CTRL+B to bevel the edges. For texturing, I used Principled BSDF as it’s a metal object I 

set metallic all the way to full (1.0), roughness 0.4, and SATO logo Texture. Finally, I 

placed all the tin shade around the pillar. And one is on the top of the toile. 

 

 

Figure 4.2.4: Sato V Trap Toilet Model 



©Daffodil International University   47 

For the pit house, I modified the cylinder mesh, selecting the top round face in edit mode, 

then Press “I” to inset face and “E” to extrude face inside. Another cylinder mesh was 

added as the lid of the pit house. Here I used smart UV unwrapped technique which is a 

built in function in Blender. Then I used same cement texture which I used before for pillar. 

I used Node Wrangler add-on to create this material. Node Wrangler add-on can add all 

the nodes together at once. 

 

Figure 4.2.5: Pit House 

 

For the ground modeling and texturing, I used cube mesh, subdivide it few times in edit 

mode. After UV unwrapping I started texturing the model and by using the Node Wrangler 

add-on it got easier to add texture properly on the ground. 

 

Figure 4.2.6: Ground Texture 
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Finally, for the ground, I added grass model and spread it all over the ground. It is not easy 

to spread grasses one by one on the ground. I used here “Blender Particle System”. It’s so 

powerful tool, It’s mainly use to create particle in a scene.  

Particle System properties > Hair > Render > Collection > Instance Collection “Grass”. 

Particle System properties, 

Hair: Advanced - checked 

Emission Number: 5000 

Hair Length: 5m 

Segments: 5 

Source Emit from: Faces 

Distribution: Jittered 

Rotation: Global Y 

Render Scale: 0.250 

 

 

Figure 4.2.7: Ground Grass 

 

I have removed grass particles in front of the toilet model by using “Weight Paint” tool. 

Weight Paint tool helps to increase or decrease density of particles in a specific area. 

Particle System properties > Hair > Vertex Group > Density - group collection.  
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For tub and cement mixer modeling, I used cylinder and plane mesh. In edit mode, I 

modified the meshes to create the actual shape of the model. 

 

 

Figure 4.2.8: Tub and Cement Mixer Model 

 

I created a box model for packaging the “SATO V Trap”. A box texture was provided from 

the client. I followed the measurement of the texture and created the box model. Then I 

unwrap the box and place the texture onto it.  

 

Figure 4.2.9: SATO Box Texture 
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Figure 4.2.10: SATO Box Model 

 

 

Figure 4.2.11: SATO Box Model with Texture 
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Environment Design: 

For environment design, I used some pre made tree models and placed those randomly 

behind the main toilet model.  

 

 

Figure 4.2.12: Random Tree Model 

Adding sky and the cloud in the environment scene was quite complicated. In the world 

shader editor I used very complex shader nodes to create the sky and the cloud. By using 

mapping node of that shader nodes, it’s possible to animate the cloud randomly. I animated 

the cloud using “X” rotation of the mapping node.  

 

 

Figure 4.2.13: Dynamic Sky and Cloud Shader Node 
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Animation: 

First part of animation was to mixing the cement and water in the tub. I took a mesh circle 

and resided it so that is fit inside the tub model. Then I added a subdivision modifier, then 

displace modifier with the texture of cloud and finally vertex weight proximity modifier. 

Displace modifier created a displacement to the mesh object. In weight paint mode I created 

a vertex group. Then in displace modifier > vertex group > select group. vertex weight 

proximity modifier > vertex group > select group. As influencer a sphere was used. In 

vertex weight proximity modifier > target object (select that sphere). And finally a curve 

circle to animate the sphere around the tub, which is path animation using the Follow Path 

constraint. Here the sphere worked an influencer to simulated the cement and the mesh 

circle was used as a cement. Sphere move around the tub and the circle mesh displace 

randomly, and it looks like cement mixing animation. 

 

 

Figure 4.2.14: Cement Mixing 

 

For the handle (cement mixer) animation I used another curve circle. Then I applied 

Follow Path constraint on the handle. And as the target object that curve circle. Here I 

applied path animation technique. 
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Figure 4.2.15: Follow Path Constraint 

Most of the animation was camera animation and object location/rotation animation using 

the key frames. Here I used 6 different cameras to visualize the product from different. In 

front of the cameras object was moving and rotating, I used key frames to make those 

object animated. The entire animation was 1760 frames with 30 fps.  

 

 

Figure 4.2.16: Sato V Trap and Camera Animation 

 

The toiler tin fence and pillar animation. Here the pillars and fences was moving toward 

“Z” axis and placing exact same position it should be. The toilet door opened at the last 
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scene. It was rotation animation. The 6th camera was moving following the direction of the 

object. The Camera was in zoom in position, then it zooms out the scene. 

 

 

Figure 4.2.17: Toilet and Background 

Box opening animation, at first I rigged the box. I took a single bone armature. In edit mode 

I duplicated the bone three times and placed it four different side. After that I parent the 

box with the bone (Armature Deform > with Empty Groups). Next by selecting the box in 

the edit mode I created four vertex group and assign the four bones with it. Now it’s ready 

for animation. 

 

Figure 4.2.18: Box Cover Rigging 

For animating the cover of the box, in the pose mode I used rotation and added key frame 

each bone separately. The objects inside the box was animated by adding key frame on the 
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location properties and camera animation was added from different angles by using 

location, rotation. 

 

Simulation: 

In the entire process of the project there are two simulation part, water falling in the tub 

and pit filling. Here I am going to explain about the water falling first. 

 

Water Falling Simulation- 

At first I created a sphere near the jug mouth. Sphere dimension was around 0.01425 meter 

XYZ. I rename it water flow. By selecting the sphere, in the physics properties I choose 

“Fluid” option as it is a water simulation. Next I created a cube as domain object. Without 

domain fluid simulation will not work. For the cube I again choose “Fluid” option in the 

physics properties. As an “Effector” I use the tub model as all the water will take place 

inside it. By selecting the tub, I again choose the “Fluid” option.  

Sphere settings,  

Fluid Type > Flow 

Flow Type > Liquid 

Flow Behavior > Inflow 

Flow Source > Mesh 

Initial Velocity Y Axis = 0.1 m/s 

 

Cube/Domain settings,  

Fluid Type > Domain 

Domain Type > Liquid 

Resolution Division = 64 

Mesh Upres Factor = 2 

Mesh Particle Radius 2.0 

In the Cache option, 

Start - End frame 1 -175 

Type > All 

Tub/Effector settings, 
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Fluid Type > Effector 

Effector Type > Collision 

Surface Thickness = 2.5 

Use Effector = Checked 

 

 

Figure 4.2.19: Tub Water Flow 

 

At the frame 54 “Use Flow” option, I unchecked and added a key frame on it. So that water 

can’t start flowing till frame 54. At frame 56, I checked and added a key frame on “Use 

Flow” option. So that water start flowing. I applied location and rotation key frame on the 

jug at frame 15 to 55. So that, it looks like water is falling from the jug. At 160 frame “Use 

Flow” option was checked and at frame 164 I unchecked the “Use Flow” option and added 

a key frame so that water stops flowing. I baked all the simulation and created a cache file 

of it from frame 1 to 175. 
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Pit Filling Simulation - 

About the pit filling simulation, it is almost similar like the previous one. I created a sphere 

at the end of the drainage pipe, dimension 0.044941 m at XYZ axis. Then I created a cube 

as the domain of the fluid and concrete pit as the effector. From the physics properties I 

choose “Fluid” option for these three different object as before. For the sphere option is 

“Flow”. For the cube option is “Domain” and for the pit cylinder option is “Effector”. I 

adjust few more settings before the final simulation. 

 

Figure 4.2.20: Pit Filling Simulation 

 

This simulation starts from frame 660 and ended at frame 850. I checked and unchecked 

few times and added key frames on the “Use Flow” option so that fluid drops randomly 

inside the pit cylinder. I baked all the simulation and created a cache file of it from frame 

660 to 850. 

Sphere settings,  

Fluid Type > Flow 

Flow Type > Liquid 

Flow Behavior > Inflow 

Flow Source > Mesh 

Initial Velocity XYZ Axis = 0.0 m/s 

Cube/Domain settings, 
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Fluid Type > Domain 

Domain Type > Liquid 

Resolution Division = 64 

Mesh Upres Factor = 2 

Mesh Particle Radius 2.0 

In the Cache option, 

Start - End frame 660 - 850 

Type > All 

 

Tub/Effector settings, 

Fluid Type > Effector 

Effector Type > Collision 

Surface Thickness = 1.0 

Sampling Substeps = 2 

Use Effector = Checked 

 

Lighting and Rendering: 

The dynamic shader node already has sky light and I added a sun light to make the scene 

look more natural and realistic.  

Sun Color: White 

Strength: 2.0 

Angle: 0.526 degree  

Max Bounces: 1024 

Cast Shadow: checked 

Render Engine: Cycles 

Device: GPU Compute 

Render Sampling, 

Noise Threshold: .009 

Max Samples: 4096 

Time Limit: 2.4 min 

Denoise: checked 
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Denoiser: Optix 

Passes: Albedo and Normal 

Render Resolution: 1920px X 1080px 

Frame Rate: 30 fps 

Frame Range: 1 to 1760 frames 

Render Output: PNG image sequence 

 

 

Figure 4.2.21: Sato V Trap Render Image 1 
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Figure 4.2.22: Sato V Trap Render Image 2 
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Figure 4.2.23: Sato V Trap Render Image 3 
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Editing and Final Output: 

I render out the scene as image sequence and after that there were some requirement of 

adding some text and information, logo animation on the “Sato V Trap installation 

process”. After Effects is the best software for post processing, compositing and motion 

graphics work. 

 

At first I animated the “SATO LOGO” with simple keyframe animation. I mask the logo 

layer with “Ellipse Tool”. Mask feather was 409 to look the mask very soft. I animated the 

logo with mask. Two different color was required for the text, #000C68 and #387EE0. I 

added “Drop Shadow” effects of every text and logo. “Sofia Pro Regular” font was used 

for the text. 

Drop Shadow effects, 

Shadow color: #000000 

Opacity: 30% 

Distance: 5.0 

Softness: 15 

 

Figure 4.2.24: SATO Logo 
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Figure 4.2.25: Sato 324 Universal V Trap Logo 

Motion tracking was used to display two information of the product. As the camera is 

moving around the Sato V Trap, I used After Effects build-in motion tracking system to 

track a particular part of the model. Here motion tracking was “X and Y” location on a null 

layer, and text information layer was parented with the null layer. Two different text 

information was tracked with Sato V Trap, “Efficient Grip” and “Farm Lock System”. 

“Sofia Pro Regular” font was used for the text. 

 

 

Figure 4.2.26: Text Motion Track 1 



©Daffodil International University   64 

 

Figure 4.2.27: Text Motion Track 2 

I animated the “SATO” icon by using the “Stroke” effects. This particular effect helps to 

animate lines and it looks like some kind of drawing.  

 

Figure 4.2.28: Sato Icon 

A background with specific pattern was use for the entire video. Background color was 

#F7F6ED.  

 

Figure 4.2.29: Pattern 
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Figure 4.2.30: Background with Pattern 

Other text animation was added key-framing position and opacity several times. 

Sometimes layer mask added on the text layer for the purpose of position animation. 

“Specialty of Sato V Trap”, there were some point explained in this part. To animate those 

point, I applied “3D Fly Down and Unfold” effect, so that those points visible on the screen 

one by one. 

 

 

Figure 4.2.31: Point Text Animation 

An appropriate background music was added to the final scene. A perfect background 

music can subtly set the mood and maintain attention. 

Composition setting, 

Width - 1920 px 

Height - 1080 px 

Frame Rate - 30 fps 

Final render was exported as a video footage, “SATO V-trap Installation Process”. 
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4.3 Story Based 3D Animation (Story Based Short CG Animation “Alien: First Kill”) 

Science think, an alien refers to a hypothetical or extraterrestrial life form that may exist 

outside of our own planet, Earth. This can include any form of life, such as a single-celled 

organism, a complex animal, or even an intelligent being like human. The popularization 

of the idea of aliens took off in the 20th century, with the advent of science fiction and the 

rise of the space age. The first-ever UFO sighting was reported in 1947, and since then the 

topic has become a staple of popular culture, with countless books, movies, and TV shows 

depicting aliens and extraterrestrial life. 

 

A film name "Alien" was released in 1979, it's a science fiction horror film directed by 

Ridley Scott and starring Sigourney Weaver, Tom Skerritt, John Hurt, and Ian Holm. The 

film is set in the future and follows the crew of the commercial spaceship Nostromo as they 

respond to a distress call from an alien planet. Upon landing on the planet, they encounter 

a mysterious and hostile alien creature that begins to stalk and kill the crew one by one. 

The film is known for its suspenseful atmosphere, groundbreaking special effects, and 

iconic alien design. 

 

I created a story based animated Sci-Fi, horror CG short film, name “Alien: First Kill”. 

This short animated film is totally fictional and it's based on a scientific concept. As it is a 

3D film, I used 3D software to complete the project. Blender was mostly used for this 

project, besides I use 3ds Max for some modeling, for compositing and editing I used After 

Effects. 

 

Every video or film production has three major stages, which are, 

 Pre-production 

 Production 

 Post-production 

I followed these steps to finish my entire short animated film which took around four 

months. 
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Figure 4.3.1: Sci-Fi Animated Short Film Production Pipeline 

 

Pre-production: 

Story Idea: At pre-production stage at first I had to think about the animation story. 

Because without story it’s not possible to make a CG short film. So, after brainstorming I 

got a story idea, which I shared with my mentor of internship, name Shibli Zaman Annan. 

Then we discussed about the story in detailed. We fixed the story and wrote down it. The 

Title of this short animated film is Alien: First Kill. 

 

Story Writing: Year 2071. Bangladesh has become advanced in technology, smarter than 

ever. It’s future and everything is futuristic. Now we have space administration like NASA, 
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which is Daffodil Space Research Association. Numerous spaceships go outer space and 

different planet from here for the purpose of research and innovation.  

23 January around 11:25 pm, place Ashulia subway station, Dhaka. it's almost a quiet place, 

because it's almost mid-night. three or four people are waiting for train to arrive. Time is 

running, tik tik. 11:30 pm, a train arrived in the station. A night time construction worker 

then gets down from the train, he actually works on Daffodil Space Research Association 

construction site. He is already late for his work. So, he starts walking faster. Then he 

reached his destination Daffodil Space Research Association. The name of the worker guy 

is Jahid Ali. He then looked at the sky, a spaceship was flying over his head and some 

drones was flying around. It’s a restricted area. So, for verification he reached near the 

Gate no. 3. After scanning he entered through the gate. He was seven minutes late for work. 

Other workers were doing their job. Everything was perfect just like the other days. He was 

walking and looking around. Then he reached near an elevator. By using the elevator, he 

reached at the top level. But when the elevator stopped at its position, he noticed something 

wrong going on this place. Everything was quiet. He starts walking forward slowly. 

Suddenly, he thinks he saw something little far. So, he stopped there and turned right. 

Nothing was there, but he heard some unusual sound. So, he again looked his right side. 

He saw two workers was running far away. Then he quickly turned left and got shocked. 

He started Breathing fast and lost his ability to move from there. An alien creature was 

looking at him and it starts terrible screams. Then it attacked. Before he knowing anything, 

he fell down and died. Through this killing, aliens began to spread on earth. This is the 

story of Alien: First Kill. 

 

Scripting: Scripting is a crucial aspect of a film production. Scripting refers to the process 

of writing a screenplay or script for the film. The script outlines the story, characters, and 

dialogue for the film, and serves as a blueprint for the production team to follow during 

filming. To complete my whole animation process, I followed a script for creating scenes. 

In the story I have two scenes with various shots. 

1) Scene 1: A train station, which is Ashulia Subway Train Station. First, some camera 

shots will take place from different angles of the station. First shot, a camera is 

moving forward through the platform. Second camera shot, sci-fi globe hologram 



©Daffodil International University   69 

is rotating, Moon and Mars video is displaying in the side monitor of the platform. 

Third camera shot, escalator is moving upward and downward, light flickering. 

Fourth camera shot, station billboard where station name is written. Fifth camera 

shot, ATM machine’s close shot. Sixth camera shot, two top monitors showing a 

lava planet and sun, then camera focus on top digital clock of the station where time 

is changing from 11:25 pm to 11:26 pm. Seventh camera shot, camera is panning 

left to right where two top monitors and escalator is in focus. Eighth camera shot, 

two men is waiting and another man began to sit on the station chair, then a train 

entered the station. Ninth camera shot, this shot will be the front part of the train in 

where the train stops at the station. Tenth camera shot, side view of the train and 

door is opening, a worker starts to coming out from the train. Eleventh and twelfth 

camera shots, where camera switches in between, front and side view of 

construction worker where he is coming out from the train. Thirteenth camera shot, 

here camera will work as First-person view (FPV). First person view is what a 

person see. It's an electronic reproduction of the visual information captured by a 

camera. So, here the camera starts walking as a person toward the escalator and 

train starts leaving the station. This is the last shot of “Scene 1”. 

2) Scene 2: Camera shot one, camera will pan left to right and will capture the lower 

environment of “Daffodil Space Research Association”. Camera shot two and 

three, second camera will capture the upper environment of “DSRA” and third 

camera will capture the upper research houses closely. Fourth and final camera, 

fourth camera will work as First-person view, it will act like a person. So, at first 

the camera person will look up from the outside of the DSRA gate-3 and a spaceship 

will fly over his head and some drones will fly around. Then the camera or the 

person (worker) will start walking toward the DSRA gate-3. A scanner machine 

will scan him with a laser light. Then the gate will open. Every single mechanical 

iron part of the gate will rotate to open the gate. After that he will pass through the 

gate. A worker will pass through. After some steps he will look top left side, a space 

shuttle will be there and then he will walk through the passing bridge and he will 

look top right side. There two astronauts will be gossiping. Then he will walk faster 

toward the elevator and in this time he will look around. Near the elevator another 
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worker will pass through him. Next he will ride the elevator and will start to go up. 

After a few seconds he will reach at the top and elevator will stop there. Then he 

will start walking and at that moment First-person view camera will look up a little. 

After some steps he will stop, because he will feel he saw something. Then the 

camera will rotate right, there will be nothing. Next the camera will rotate more 

right, there two workers will be running faster. Then he will quickly turn left and 

he will see an alien creature. That alien creature will scream very loudly and will 

attack the worker that means the FPV camera and he will fall down and die. This 

will be the last shot of “Scene 2”. 

For the entire screenplay, first of all we will show a simple note where written, “Please use 

headphones for better sound experience”. After that our DIU and MCT intro will show. 

Next “AAVA 3D” and “Racy Blue Animation” logo intro. After that a message will show 

on the screen, “Alien. They exist or not we don’t know that yet clearly. But if they exist, 

they could be terrible for mankind”. Then the main story scene 1 and scene 2 will play. 

After that another message will display, “They just arrived”. And at last the title animation 

of the short film “Alien: First Kill” and name text will display. 

 

Production: 

Modeling and Texturing: At the production stage at first I start modeling the necessary 

3D models and props for the train station. I start modeling base of the platform. Every 

modeling should start with a reference image. I followed two reference images to design 

the train station.  

 

Figure 4.3.2: Train Station Reference Image 1 
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Figure 4.3.3: Train Station Reference Image 2 

I started modeling the station base following the reference image 1. I added a cube and 

scaled and modified it. So that it looks like a base of the platform. Then I added a loop-cut 

in the middle and deleted half of its side and applied a “Mirror” modifier. “Mirror” modifier 

helps to create same geometry at the opposite side. So that if you work on side of the 

geometry it will affect the other one. Step by step I developed the platform base. Next I 

took another cube and resize it. I applied “Wireframe” and “Array” modifier. I placed this 

grill model at the corner side of the platform. I duplicate it and place the second one another 

side. For the platform railing, I took a cylinder mesh and made it look like a pipe, applied 

“Simple Deform” modifier and choose “Bend” option to make the pipe bend. To make 

multiple copy of it I used “Array” modifier. Then I placed the railing two side of the 

platform. 

 

Figure 4.3.4: Platform Base model 
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For texturing the platform, I used mixed texture material. In the middle part I use Blender 

brick texture and Marble texture from third-party. 

 

Figure 4.3.5: Platform Marble Texture 

At the corner side of the platform, I used yellow metallic dot texture. 

 

Figure 4.3.6: Platform Yellow Metallic Dot Texture 

 

Figure 4.3.7: Final Shading of the Platform 
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This is the final shading of the platform. I used metallic yellow color for the railing and 

black metallic color for the ground grill. 

 

Figure 4.3.8: Station Chair Model 

I modeled the station chair corner area in 3ds Max using spline. It’s kind of easy process 

in 3ds Max to create curves. The inner mesh is plane, and I applied “Wireframe” modifier 

to make it look like a net. Stands that is holding the chairs, was made using the cubes. 

 

Figure 4.3.9: Station Chair Shading 

For shading the chair and chair stand model I used procedural texture node of blender. Here 

I used Principled BSDF, Bump node, Noise Texture, Mapping and Texture Coordinate, 

Mix and Layer Weight node. In Mix node color was Black and White. Metallic percentage 

1.0, Roughness 0.3, Clearcoat 1.0, Clearcoat Roughness 0.5. 
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Figure 4.3.10: Station Billboard and Monitors Model 

For modeling the station billboard and the monitors I used cube mesh. I resized those in 

the edit mode. I used inset, bevel, extrude and loopcuts to make the model perfect as 

needed. 

 

Figure 4.3.11: Station Billboard and Monitors Textures 

For monitors display I used some image and video textures. Image texture was created by 

using Adobe Illustrator and video texture was created by using After Effects. Planet 
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animation was made by using “Earth Orb” plugin in After Effects. Billboard animation was 

made by using texts and shapes. 

 

Figure 4.3.12: Station Billboard and Monitors Final Shading 

Monitors outer area and stands textures were made by using procedural texture nodes, 

which are Principled BSDF, Bump node, Noise Texture, Displacement, Mapping and 

Texture Coordinate, Mix and Layer Weight node. 

 

Figure 4.3.13: Rail Line Model 
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Rail line model and its lower base was made using the cube mesh. I modified it in the edit 

mode of the blender using the extrude, inset, bevel and loopcuts. Then I created a single 

lower base of the rail line and applied “Array” modifier to make multiple copies of it. Line 

holder was created by using the plane and cylinder mesh, and “Array” modifier also applied 

on it to make multiple copies. 

 

Figure 4.3.14: Rail Line Shading 

 

Figure 4.3.15: Rail Line Wood Texture 

For texturing the rail line base, I used PBR wood texture. I UV unwrapped the base model 

and applied the texture properly onto the model. 
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Figure 4.3.16: Rail Line Texture 

For shading the rail line, I used here procedural texture node, which are Principled BSDF, 

Bump node, Noise Texture, Mapping and Texture Coordinate, Mix and Layer Weight 

node. Mix node color was #1C1100 and #000000. Layer Weight blend was 0.5. 

 

Figure 4.3.17: Escalator Stair Model 

At first I modeled the escalator stairs using the cube mesh. I resized it and in the edit mode, 

by selecting lower edge I applied bevel and loopcuts. Next in the middle area I applied 

around 32 loopcuts and then I selected one after one faces by pressing “Shift” and “Alt” 

key. Then I extrude the faces. In the next steps I applied “Array” modifier to make 17 

copies. Array > Fixed Count > check Constant Offset > Direction Y = 0.315 m & Direction 

Z = -0.24 m. 



©Daffodil International University   78 

 

Figure 4.3.18: Escalator Model 

For the lower base of the escalator, I used plane mesh and resized it in the edit mode 

according to the stair size. Then I applied “Solidify” modifier. I deleted the inner part where 

the moving stairs placed. For the handrail, I used circle mesh and removed half of it. By 

duplication it I placed one in the top side of the escalator and another in the bottom side. I 

connected those to by pressing “F” key in the edit mode. Next I applied “Solidify” modifier. 

After extruding, inset few more times I made the glass and the handle parts of the handrail. 

I detached the handle from the glass part. By duplicating those I placed those on the 

opposite side of the escalator. This is how I modeled the escalator. 

 

Figure 4.3.19: Escalator Shading 
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Figure 4.3.20: Escalator Handrail Shading 

To make the handrail look like glossy rubber, I used here procedural shader node. Mix 

Shader, Fresnel, Glossy BSDF, Principled BSDF, Bump, Noise Texture, Mapping and 

Texture Coordinate was used to make the glossy rubber texture. 

 

Figure 4.3.21: Escalator Stair Shading 

For shading the escalator stairs, I used here, Principled BSDF, Mix, Bump, Noise Texture, 

Mapping, Texture Coordinate. Mix color1 #000000 & color2 #987D23, Metallic 1.0, 

Roughness 0.605, Clearcoat 1.0 & Clearcoat Roughness 0.5. 
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Figure 4.3.22: Escalator Glass Shading 

For shading the side glass of handrail, here I used Principled BSDF node, where Metallic 

0.0, Roughness 0.15, Transmission up to 1.0. One thing to mention here, for the light that 

is glowing side of the handrail, I used Emission shader node for that, where Strength is 7.0 

and color #49C0FF. 

 

Figure 4.3.23: Elevator Modeling 
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For modeling the elevator, I used a reference image from the web. At first I took cube mesh 

and by observing the reference I made the elevator model. 

 

Figure 4.3.24: Elevator Reference Image 

 

Figure 4.3.25: Elevator Shading 

For texturing the elevator, procedural texture node Principled BSDF, Mix and Layer 

Weight, Bump, Noise Texture, Mapping and Texture Coordinate was used. Mix color1 

#9B9B9B & color2 #AEAEAE, Bump Strength 0.01 & Distance 19.5, Noise Scale 20.0 & 

Detail 50.0, Mapping Scale XYZ 15.0, Layer Weight blend 0.5. 
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Figure 4.3.26: Station Pipe and Cable Models 

I modeled the cables and pipes from cylinder mesh in the edit mode. I also added cube as 

cable holders. Procedural texture node was used for texturing the pipes and cables. 

 

Figure 4.3.27: Transparent Monitors 
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For decorating the station, I created some transparent display. I used video and image 

textures on the transparent glass material. Earth, Sun, Saturn and Lava planet animation 

was created by using After Effects “Orb” plug-in. In the image texture node, I added the 

video files so that the videos appear on the transparent glass monitor. On the other side 

Ashulia Subway Station texture was created by using Illustrator.  

 

Figure 4.3.28: ATM Machine Model 

For modeling the ATM machine I took a reference image. The monitor was designed 

following the reference image. At first I took a mesh plane. In the edit mode I extrude, 

scaled, inset it as I needed. I applied a “Solidify” modifier on it. When the monitor model 

it ready I UV unwrapped it. Second part was modeling the lower box of the ATM machine. 

I used mesh cube for that. I added some detail on the model to give it more futuristic look. 

 

Figure 4.3.29: ATM Machine Monitor Reference 
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Figure 4.3.30: ATM Machine Final Render 

I used animated video and image textures for the ATM monitor. Futuristic animated data 

analysis video was created using Adobe Illustrator and After Effects. I placed those onto 

the transparent glass by using Image texture node of blender. I used the alpha channel to 

remove the black background of “ATM System” texture. The glow part of the machine was 

applied using “Emission Shader” node. 

 

Figure 4.3.31: ATM Machine Video and Image Textures 
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Figure 4.3.32: Recycle Bin Model 

Recycle bin model, I took a mesh cylinder for this. In the edit mode I applied some extrude, 

inset, bevel, loopcuts to created it from cylinder mesh. I also applied “Shade Smooth” to 

remove the sharp edges. I also made a recycle bin logo which I placed in front of the 

dustbin.  

 

Figure 4.3.33: Recycle Bin Shading 

For texturing the recycle bin I used procedural texture node. Recycle bin logo, “Emission” 

shader node was used, color #19A319 and Strength 6.0. 



©Daffodil International University   86 

 

Figure 4.3.34: Holo Earth Model 

Modeling the Holo-Earth globe was kind of complex. At first I took a UV Sphere mesh 

and I started applying procedural texture node to make it looks like a Holo-Earth. Mix 

Shader, Transparent BSDF, ColorRamp, Dot Product, Bevel, Geometry, Emission, Math 

node, Image Texture node, Separate XYZ node and Noise Texture node was used here. 

 

Figure 4.3.35: Holo Earth Projector Model 

I created Holo Earth projector model from the UV sphere mesh. I applied “Subdivision 

Surface” modifier to give more vertex on it. After that in the edit mode I converted the UV 

sphere into a Holo projector. Finally, I applied procedural and emission shader to make it 
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more realistic looking holo projector. The light beam that is projecting from the holo 

projector is actually spot light. Spot light, color #33CCFD, power 1043.75W, Radius 

0.05m, Max bounces 1024, spot size 65°, Blend 0.8, strength 8.0. 

 

Figure 4.3.36: Earth Map Projector 

Earth map was created using the Blenders very complex geometry node. This map actually 

was a vector. From Illustrator I saved it as a “.SVG” file. Then I imported the “.SVG” file 

into Blender. At first I converted the “.SVG” file to mesh. So it became 3D earth map. 

After that, in the geometry node panel I setup the nodes to make it looks like this. Join 

Geometry, Set Material, Instance on Points, Ico Sphere, Curve to Mesh, Curve Circle, Set 

Position, Realize Instances, Endpoint Selection, Object Info, Mesh to Points, Curve Line, 

Less Than, Geometry Proximity, Grid and Mesh Line, these were used for this Earth map 

projector. I setup one by one node to gain this result. 

 

Figure 4.3.37: Earth Map Geometry Node 
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Figure 4.3.38: Station CC Camera Model 

I Modeled CC camera as a props of the station. By modifying plane, cube, cylinder meshes 

and line curve I made the CC camera.  

 

Figure 4.3.39: Station CC Camera Texture 

Texturing the CC camera, I used procedural texture of blender. For camera lens texture, 

Principled BSDF, Glossy BSDF, Mix Shader was used. Principled BSDF, Metallic 0.0, 

Transmission 1.0, Roughness 0.0, IOR 1.5. Glossy BSDF, Roughness 0.0. Mix Shader, Fec 

0.243. 
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Figure 4.3.40: Station Ground model 

For the station ground, I took mesh plane and applied PBR material texture onto it to make 

it more realistic. In the shader editor mode, by pressing ctrl+shift+T, I choose all the PBR 

texture. I adjusted the XY mapping to fit it with the plane. Bump and displacement map 

also added with it. 

 

Figure 4.3.41: Station Ground PBR Texture 
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Subway station without wall is not possible, for making the wall around the station I used 

here mesh plane, cube and cylinder. For texturing the walls, I used PBR texture and 

procedural texture nodes. 

 

Figure 4.3.42: Station Wall Model 

 

Figure 4.3.43: Station Wall PBR Texture 

After modeling and texturing the station I switched to the Daffodil Space Research 

Association to modeling and texturing the necessary objects and props for this scene. I 

started modeling with the main gate. 
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Figure 4.3.44: Gate Model 

To make this Sci-Fi looking gate at first I did some study, observed some related 3D model. 

Finally, I got an idea to make it. Using the cube mesh and modifying it in the edit mode I 

made this 3D Sci-Fi looking gate. 

 

Figure 4.3.45: Gate Metallic Grills 

Most interesting part is gate metallic grills. At first I modeled one part of it. By using the 

“Array” modifier I multiply this 17 times. And next I duplicated and mirrored it for the 

opposite side. When I will animate it, each grill will open individually. 

 

Figure 4.3.46: Gate Shading 
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For texturing the gate, here procedural texture node was used. I changed the color to make 

a variation in between the objects. cwDirtyUp001 - Amount 1.0, Scale 0.4, Dirt Height 

0.15, Bump - Strength 0.02, Distance 19.5, Noise Texture - Roughness 0.5, Detail 50.0, 

Scale 5.0. 

 

Figure 4.3.47: Gate Shader Node 

 

Figure 4.3.48: Gate Warning Textures 

On the gate side I added two warning message textures, one is “Restricted area” and another 

is “No smoking zone”. At first I took two plane meshes and by using the image texture 

node I placed the warning textures on the planes meshes. And I placed the planes side by 

side on the gate wall. 
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Figure 4.3.49: Area Barrier Model and Texture 

I modeled this area barrier to cover the research station area. Here “Wireframe” modifier 

was applied to made the barrier net. Upper pillar and lower pillar was modeled using the 

cube mesh. To make a very smooth shape I also used “Sub-division surface” modifier. I 

joined all the separate objects pressing “ctrl+J” and applied “Array” modifier to make 

multiple copies of it. And for texturing procedural texture node combination was used here. 

 

Figure 4.3.50: Kiosk 3D Model 
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Kiosk 3D model was modeled by from a reference kiosk model. I followed that model to 

create the body and the kiosk monitor. Later I animated the monitor with rotation 

animation.  

 

Figure 4.3.51: Kiosk Reference Model 

 

Figure 4.3.52: UI Animated Texture for Kiosk Display 

According to the necessity, I animated this futuristic UI for the kiosk display. I used Adobe 

Illustrator and After Effects for this. Next I imported this texture using the Image texture 

node of Blender. I UV unwrapped the monitor screen and placed this animated texture 

properly onto it. 
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Figure 4.3.53: Kiosk Shading 

Kiosk lower part was textured using the procedural texture node and for screen Principled 

BSDF node with transmission 1.0, Roughness .3. Also a laser light scanner was added here 

to scan the human character. Principled BSDF, ColorRamp, Scale Vector, Math node, 

Noise Texture, Mapping and Texture Coordinate node was used for making a laser beam. 

 

Figure 4.3.54: Research Station Ground Base Model 
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Ground base model of research station was modeled just using the cube mesh. In the edit 

mode I extruded and inset to side. And near the middle of the model I designed some cutting 

shape by using the knife tool. Finally, I applied “Array” modifier to make similar copies 

of it and I placed those so close to each other, so that is looks like a single base model. I 

used PBR metallic dot texture at the top side and also procedural texture node around the 

base cube. 

 

Figure 4.3.55: Research Station Ground Base PBR Texture 

 

Figure 4.3.56: Entrance Billboard Model and Shading 
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This Entrance billboard was really simple modeling. Here at first I took cube meshes, I 

resized those to make it look like a pillar and placed those at the position. Next I modeled 

the upper and lower billboard. I connected the billboards with the pillar using cylinder 

mesh. Actually I bended the cylinder according the necessity. After I finished modeling I 

applied procedural textures onto the pillar and billboard, and also transparent glass texture 

onto the billboard. Upper billboard texture was “Daffodil Space Research Association” 

name plate which I made using the Adobe Illustrator. And lower billboard texture was 

“Gate 3” name plate. 

 

Figure 4.3.57: Ground and Cliff Modeling 

I modeled the ground and cliff for the scene. For the ground at first I took a plane mesh. I 

added sub-divide few times in the edit mode to add much more vertex. Then in the modifier 

properties I applied “Displace” modifier with strength 0.05 & midlevel 0.5. In the displace 

property I added normal map of the PBR texture. Next I took another “Displace” modifier. 

In the “Displace” modifier property I applied a cloud texture. 

 

Figure 4.3.58: Ground and Cliff Shading 
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For Modeling the cliff, I took a plane mesh. In the edit mode I made the plane to look like 

a simple cliff. Next in the modifier properties I applied “Sub-division Surface” modifier. 

“Sub-division” modifier properties, Catmull-Clark > Levels Viewport 3 & Render 3. Then 

I switched to the sculpting mode. I sculpt the cliff plane to give it more detailed look of 

actual cliff. I Added “Array” modifier for both ground and the cliff to make 2 or 3 copies. 

 

Figure 4.3.59: Ground PBR Texture 

 

Figure 4.3.60: Cliff PBR Texture 

For texturing the ground and cliff model I applied PBR textures. In the shader editor at first 

I took a new material. Next by selecting the Principled BSDF node I pressed ctrl+shift+T 

on the keyboard and applied all the selected PBR textures on the ground model. In the same 

way, I applied another rocky PBR texture on the cliff model. 
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Figure 4.3.61: Research Station CC Camera Modeling & Texturing 

I modeled this CC camera by following a reference image. After I finished my modeling I 

started texturing it. I actually used procedural texture node for texturing it. In the modeling 

process I actually used cylinder, cube and place meshes. For the camera cable, curve line 

was used here. It helped to animate the cable next time when I animated the CC camera. 

 

Figure 4.3.62: Research Station CC Camera Reference Image 
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Figure 4.3.63: Cube Block Modeling and Texturing 

I modeled this cube block as a barrier of the space research station. From some cube 

meshes, in the edit mode by extruding, inset, bevel, adding loopcuts this model was mode. 

Then I applied texture on it. Procedural texture node was used for that. To make multiple 

copies of it at first I joined all te separate meshes by selecting those all, then pressing ctrl+J. 

After that I applied “Array” modifier to make three copies of it. I placed these three copies 

one by one top to bottom. Next step, without duplicating one by one I used Blenders 

“Collection Instance” option, that made copy meshes far easier. 

 

Figure 4.3.64: Cube Block Collection Instances 
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Figure 4.3.65: Space Viewer Monitor Modeling and Texturing 

At first I modeled one monitor. Then I duplicated it three times. I placed animated video 

textures of planets, galaxies and stars on the monitor. All the animated planes and galaxy 

was animated using After Effects. Using the image texture node, I applied those textures 

on the transparent monitor screens. Monitor outer body and stands was textured by using 

the procedural texture node of Blender. 

 

Figure 4.3.66: Space Viewer Monitors Animated Textures 
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Figure 4.3.67: Big Dome Model and Shading 

I created the big dome model. Here I used cylinder and cube mesh. In edit mode extrude, 

inset, bevel, loopcuts was used to modify the dome. I added two stand under the dome as 

a holder. A big concrete wall was placed behind the dome. I added round area barrier and 

a lamp to the top of the dome. And I also added area barrier two sides to the big concrete 

wall. I used PBR texture for the dome, stand and the big concrete wall. Red emission shader 

node was used as top lamp. 

 

Figure 4.3.68: Big Dome All PBR Textures 
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Figure 4.3.69: Big Grill Model and Shading 

From the cube mesh, in the edit mode at first I resized the cube. Next I inset two side faces 

and I bridge the face to remove inner face. I added another cube mesh. By extruding four 

side I joined four corner with the cube ring. Next I added a plane mesh, sub-divide it few 

times and applied a “Wireframe” modifier to make a net inside. I applied PBR texture on 

this big grill to make it more realistic.  

 

Figure 4.3.70: Big Grill PBR Texture 

In the modifier properties, I applied “Array” modifier on the big grill to make multiple 

copies of it. It’s an easy way to make copies of an object. Then I placed all the copies of 

the big grill two sides of the Daffodil Space Research Association. 
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Figure 4.3.71: Top Base Modeling and Shading 

Top base of the space research association, I modeled this base and placed it on the top of 

the cliff model. I also added some stand as holder of the base. In front of the model an 

elevator stand was placed which was made using the cube mesh. I placed metallic floor 

tiles on the top of the base. Railing model added at the side corner. 

 

Figure 4.3.72: Top Base Metallic Tiles 
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By using the “Array” Modifier I spread all the metallic tiles around the top base. Top base 

holder was just some cube meshes with PBR textures. I created one holder and the I used 

“Array” modifier to make it multiple copies and then I placed those at the bottom of the 

top base. So that, it looks like the stands holding the top base. 

 

Figure 4.3.73: Top Base All PBR Textures 

For texturing the top base, stand, railing and elevator stand I used PBR textures and 

procedural texture node. After modeling one by one I applied textures to the models by 

using the Principled BSDF and Image texture node. I applied procedural textures on some 

faces of the top base model. 

 

Environment Creation and Light Setup: After creating all the necessary model and 

texturing those I started creating 3D environment using those models. First of all, I started 

with the “Scene 1”, that means the subway train station. I also collected some 3D models 

and props as necessity. 

The Subway Train Station Environment: At first I placed the base platform in the middle 

of the station and I placed the ground model bottom of it that I created. Around the Platform 

I added wall models. Left and right side there were two space to place the escalators and 

the elevator. I placed those there. Next I put the railway tracks two sides of the platform. 
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Then after resizing the train engine and the train carriage, I placed those one side onto the 

railway track, later I animated the train. 

 

Figure 4.3.74: Train Station Environment 

I placed the Holo Globe 3D model in the middle of the platform and the earth maps was 

placed left and right side of the Holo Globe near the railway track wall. Then I placed the 

chair models two side of the platform. On the left side, top of the station chairs, I placed 

the name billboard model with its pillar. 

 

Figure 4.3.75: Train Station Environment Props 



©Daffodil International University   107 

Globes left and right side, I placed the side monitors, those are hanging with the pillars. 

Cables and electric pipes are placed top left and right side with the walls and roof. 

Transparent glass monitors were placed two sides of the escalator which are on the left and 

right side of the station. Another two transparent glass monitors were placed on the top of 

the railway track wall where train actually passes through. I placed four ATM machines 

four side near the escalators. To making the station environment look more natural I 

collected some junk props (like cans, papers, trash, packet etc.) from the internet and placed 

those corner side and near the pillars. I also added some news-paper on the ground of the 

platform. 

The Subway Train Station Light Setup: Before light setup, I added environmental fog on 

the station to give more realism to the scene. At first I took a cube mesh. I resized it around 

the station and applied a material node. Next I took Principled Volume Shade node and 

connected it with the material output volume. 

Principles Volume shader info: 

Color #C8E4FF, Density 0.025, Emission Strength 0.0, Temperature 1000.0 

 

 

Figure 4.3.76: Train Station Environmental Fog 

For light setup, at first I modeled two types of light. Then I duplicated first one few times 

and placed those serially on the roof side of the station. Second type light model was round, 

I also duplicated those and placed those near the elevator and escalator roof area. I applied 
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emission shader texture to the light meshes to make it glow and interact like a light. 

Emission Strength 15.0 and emission Color #6AB4FF for both types of light mesh. Next I 

added Blenders area light with each of the light mesh. 

Station area light info: 

Color #C8E4FF, Power - 20W, 

Shape - Square, Size - 1m, 

Max Bounces - 1024, 

Cast Shadow and Multiple Importance - checked, Spread - 140° 

 

Figure 4.3.77: Train Station Light Setup 1 

 

Figure 4.3.78: Train Station Light Setup 2 
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Daffodil Space Research Association Environment: After the train station environment, I 

started working on the Daffodil Space Research Association environment. I started placing 

all the models one by one at its position to create the second scene.  

At first I placed the metallic base model at the middle position. By using the “Array” 

modifier I created same copies of the metallic base and placed those side by side. Then I 

duplicated it one time and in the edit mode by selecting and moving the corner vertex I 

made it bigger. And then I put that model on the opposite side of the first one. I placed a 

bridge model to made a communication in between these base model. On the first base 

model I placed the metallic gate and the barriers that I created. I placed the CC camera on 

the top of the gate wall. By using collection instance I duplicated the CC camera and placed 

it on the other sides wall of the gate. 

 

Figure 4.3.79: DSRA Environment 1 

Next I placed the kiosk 3D model that I created as a scanner near the main gate, on the 

right side. I placed the name billboard model near the gate but back side of the barrier. I 

placed the space monitors serially in front of the gate barrier. I also modeled I parking spot 

near the main gate. The 3D blocks that I modeled, was placed along the Y axis near the 

gate, at the end of the space station and two sides of the top base. The ground model was 

placed at the ground of all metallic base model. And I placed the cliff model at the end of 

the second metallic base along X axis. I placed the dome model close to the cliff model. 

By using the collection instance, I duplicated the dome model entirely and placed it 
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opposite side of the first dome model, close to the cliff. The big grill model, at first I made 

multiple copied of it using the “Array” modifier. I duplicated is into two. First one I placed 

left side along to the ground and second one I placed right side along the ground. 

 

Figure 4.3.80: DSRA Environment 2 

I collected some 3D models to fill up the environment. I tried to make the entire 

environment look like very futuristic. At first I collected a space shuttle 3D model. I 

changed the outer texture of the space shuttle and replace it with our Bangladeshi flag tag 

and Daffodil logo. Then I placed the entire space shuttle 3D model on a 3D base model to 

the left corner of the scene. 

 

Figure 4.3.81: Space Shuttle 3D Model with BD Flag and Daffodil Logo 



©Daffodil International University   111 

I collected a tower and I applied metallic material on it. Then I duplicated it three times 

and place those four tower models around the space shuttle model. The top base that I 

modeled, I placed it on the top of the cliff model. Top base is the main point of the entire 

scene. I collected three construction block models and placed those on the back side of the 

top base model. And some of the construction block models were placed two sides of the 

lower base. I modeled some railing and placed those at corner sides of the metallic base 

and the top base sides. 

 

Figure 4.3.82: Construction Block Model 

 

Figure 4.3.83: DSRA Environment 3 
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Finally, I collected a group of 3D model with research station LAB, space ship, sci-fi watch 

tower and some sci-fi props. Two big research station LAB were placed at the lower base 

near the space shuttle model. Other LABs I placed on the top base model. I designed the 

scene as necessity for the animation. Some sci-fi props (generators, sci-fi track, robot 

model, drone model, power house etc.) were placed to decorate the scene properly. 

Daffodil Space Research Association Light Setup: I took a cube mesh and resized it 

according to the entire DSRA scene. In the shader editor mode, I applied Principled 

Volume node to created environmental fog to the scene. 

Principles Volume shader info: 

Color #95B7BF, 

Density 0.002,  

Emission Strength 0.0,  

Temperature 1000.0 

 

Figure 4.3.84: DSRA Environmental Fog 

I added a HDR environment texture with the world shader to create environmental light to 

the scene. 

World shader info: 

World Output > Mix Shader > Light Path (Is Camera Ray) to Fac, Background Strength 

0.2 and Color to Environment Texture (cinema_lobby_2k.hdr) to Shader 1, Background 

Strength 0.2 and Color # F3139 to Shader 2. 
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Figure 4.3.85: DSRA World Shader Node Setup 

 

Figure 4.3.86: DSRA World HDR Map 

 

For light setup, I used some 3D models of stand lamps and light projectors. At first I 

modeled a stand lamp and a light projector. I also collected two light stand and light 

projector. I applied procedural texture node for texturing the light models and some texture 

was baked before. 

Stand light 1 info: 

Light type - Area, 

Color - #86C6E7, 

Power - 1000W, 

Shape - Disk, 

Size - 1m, 

Spread - 25°, 

Light Bulb Emission Strength - 30.0. 
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Stand light 2 info: 

Light type - Area, 

Color - #86C6E7, 

Power - 1000W, 

Shape - Rectangle, 

Size - X (0.66m) & Y (0.42m), 

Spread - 40°, 

Light Bulb Emission Strength - 12.0. 

 

Spot light projector 1 info: 

Light type - Area, 

Color - #86C6E7, 

Power - 5000W, 

Shape - Rectangle, 

Size - X (0.9m) & Y (0.69m), 

Spread - 120°, 

Light Bulb Emission Strength - 150.0. 

 

Spot light projector 2 info: 

Light type - Area, 

Color - #86C6E7, 

Power - 5000W, 

Shape - Rectangle, 

Size - X (1.15m) & Y (1m), 

Spread - 150°, 

Light Bulb Emission Strength - 150.0. 

I duplicated the stand light and the spot light projector, and placed those around the area. 

Spot lights were placed two sides of the cliff stand and around the big domes. Two spot 

light was projected two sides of the space shuttle. Stand lights were placed along the 

ground, on the metallic base model and on the top base model. Some area lights were placed 

around the four side of the entire scene to create environment glow of light. 
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Environment glow light info: 

Light type - Area, 

Color - #86C6E7, 

Power - 350000W, 

Shape - Rectangle, 

Size - X (8m) & Y (33.4m), 

Spread - 140°, 

 

Figure 4.3.87: DSRA Stand Lights and Spot Lights 

I modeled some cube lights and placed those inside the watch tower and the research LABs. 

I applied “Array” modifier to make one copy to multiple copies so that I could cover the 

entire LAB rooms with those lights. I used emission shader node to make those glow. 

Cube lights info: 

Shader node - Emission shader, 

Color - #70E77D & #3FB4E7, 

Strength - 12.0 
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Figure 4.3.88: DSRA LAB Rooms Emission Lights 

 

Rigging and Character Animation: Rigging and character animation was done by using 

Blender “Rigify” addon and mixamo character animation.  

At first I added two characters and they are sitting on the station chair. They have some 

motion animation. Here I collected those character armatures and the character meshes 

with sitting animation from the mixamo website. I imported these characters into the scene 

and fixed the texture properly. 

 

Figure 4.3.89: Sitting Characters 1 
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Next I collected another character and two animated armatures. One animation in stand to 

sit, another sitting idle animation. I imported them all into the scene. At first I fixed the 

distorted texture. Here I have to merge two armature animation. By placing these two 

armature side by side I switched to the non-linear animation tab. First I renamed these two 

armatures. 

Then, select two armatures > press “push down action” to save script > by selecting the 

first armature “add > add action script” > select the second script. 

Next, press N. On the strip tab, set Blending mode to combine and check Auto Blend in/out. 

 

Figure 4.3.90: Sitting Character 2 

Next, I collected an animated walking character from mixamo. I imported it onto the 

scene and at first I fixed the texture of it. I moved the baked key-frames position where I 

needed. I positioned the character on the platform as he is walking. 

 

Figure 4.3.91: Station Walking Character 
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The main character, the main character of the story is a construction worker. I collected the 

worker model from mixamo. I used “Rigify” add-on and mixamo animation to rig and 

animate the main character. 

At first I attached a futuristic watch model with the character’s hand. It moves along with 

the character. To do this job I followed few steps. First of all, I took a single bone. I 

positioned the bone and the watch model around the hand by using rotation and position 

along the XYZ axis. Next, I selected the watch first and then the bone by pressing shift 

key. Next, I pressed ctrl+p > with empty groups. And then, by selecting the bone in the 

object constraint properties select “Child of” constraint. 

Next, Target = worker’s armature, Bone = mixamorig1_LeftForeArm, click “Set Inverse” 

button. 

The watch was ready to move along with the hand. 

 

Figure 4.3.92: Rigging the Watch Model with the Character 

Next step of main character animation was character getting down from the train. For that 

I collected three animation model of pose from mixamo. I adjust the bone animation with 

the “Rigify” add-on. Three animation model of pose were standing idle, start walking and 

stop walking. Next, I placed those bone animation model side by side. I switched to the 

non-linear animation tab. First I renamed these three armature animation model. 

Then, select three armatures > press “push down action” to save script > by selecting the 

first armature “add > add action script” > select the second script > “add > add action 

script” > select the third script 
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Next, press N. On the strip tab, set Blending mode to combine and check Auto Blend in/out. 

I adjusted character’s hip position by key-framing it in the non-linear animation tabs edit 

mode. 

 

Figure 4.3.93: Rigging and Animating the Main Character Model 

Next main character animation step was character’s hand animation where character 

looking at the watch face on his hand. To animate the character hand here I used “Rigify” 

add-on. 

 

Figure 4.3.94: Rigging and Animating Character’s Hand 

I rigged and animated the Alien character. That character has three animated steps, standing 

idle, screaming and direct attack. At first I rigged the alien character with “Rigify” add-on. 

I collected three animation poses from mixamo standing idle, screaming and attack. In the 

next steps I combined all the animation poses of the alien character. 
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I switched to the non-linear animation tab. First I renamed these three animation poses. 

Then, select three animation poses > press “push down action” to save script > by selecting 

the first armature “add > add action script” > select the second script > “add > add action 

script” > select the third script 

In this method all three animation poses have combined together with the alien character. 

 

Figure 4.3.95: Alien Character Rigging and Animation 

 

In the main story main character (worker) will fall down and die. Here the main character 

is worker and we are presenting it as FPV. So, when the alien attacks the main character 

actually the FPV falls down which is a camera. So, in the final shot of the animation, I 

rigged the camera with an animated armature which will fall down when the alien attacks. 

Here I used some simple method to do this. 

At first I collected the animated armature from mixamo that will fall down die. I imported 

it into Blender. When the alien starts attacking at that key frame I took a single bone. Next, 

I selected the FPV camera first and then the bone by pressing shift key. Next, I pressed 

ctrl+p > with empty groups. And then, by selecting the bone in the object constraint 

properties select “Child of” constraint. 

Next, Target = Fall down armature, Bone = mixamorig1_HeadTop_End, click “Set 

Inverse” button. And the FPV camera will rigged with the Fall down armature animation. 
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Figure 4.3.96: FPV Fall Down Rigging and Animation 

 

Simulation: I used simulation technic to give some motion to the station newspapers. I 

tried to make the paper moving and flying when the wind comes. I used here dynamic 

simulation technic. 

 

Figure 4.3.97: Newspaper Flying Simulation 

At first I placed some newspapers on the platform. By selecting them all I applied “Soft 

Body” physics from the physics properties. Then by pressing ctrl+A on the keyboard, I 

took Force Field > Wind & Force Field > Turbulence. 
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Newspaper soft body info: 

Object Friction - 0.5, 

Object Mass - 1kg, 

Simulation Speed - 1.0, 

Goal - unchecked, 

Edges - checked (Pull 0.5, Push 0.5, Damp 0.5), 

Self-Collision - checked (Ball Size 0.49m, Stiffness 1.0, Dampening 0.5). 

 

Force Fields - Wind info: 

Shape - Plane, 

Strength - 5.0, 

Flow - 2.0, 

Affects - checked (Location, Rotation), 

Noise Amount - 0.0, 

Seed - 56, 

Falloff, Shape (Sphere) & Z Direction (Both z). 

 

Force Fields - Turbulence info: 

Shape - Point, 

Strength - 5.0, 

Size - 0.0, 

Flow - 0.0, 

Affects - checked (Location, Rotation), 

Noise Amount - 0.0, 

Seed - 68, 

Falloff, Shape (Sphere) & Z Direction (Both z). 

After all the settings, I applied key-frames on the wind & turbulence properties. Next, I 

started baking all the data of the selected newspapers. And finally the simulation is done. 

 

Object and Camera Animation: Here I’m going to explain about camera animation first. 

Most of the camera animation was created using location-rotation key-frame.  
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Train Station Camera Animation: At first I took different shots of the train station from 

different angle. I took seven camera shots to the train station. By key-framing the location-

rotation of the cameras, I animated the cameras. 

Camera setting info for the shots: 

Lens Type - Perspective, 

Focal Length - 27 mm, 

Lens Unit - Millimeters, 

Clip Start - 0.1 m, 

Clip End - 1000 m, 

Camera Size - 36 mm, 

Camera Sensor Fit - Auto. 

 

Figure 4.3.98: Train Station Cameras 

Long shot of the station, pan shot around the globe, tilt up shot of the escalator, zoom out 

and focusing shot of the billboard, close-up shot of the ATM machine, focusing shot of the 

digital clock and finally the upper angle shot of the trans display monitor were taken. Here 

on the on the billboard and on the clock shot camera wasn’t focus directly. It was actually 

focus on the background. After few second the background become blur and the billboard 

and the clock became on focus. I’m going to explain this animation. 

 

Billboard camera animation info: 

Lens Type - Perspective, 
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Focal Length - 25 mm, 

Lens Unit - Millimeters, 

Clip Start - 0.1 m, 

Clip End - 1000 m, 

Camera Size - 36 mm, 

Camera Sensor Fit - Auto. 

I took an empty object backside of the billboard. From 392 frame I positioned the empty 

to 416 frame by key-framing it. Next, I checked the “Depth of Field” of the billboard 

camera and in the “Focus Object” I selected the empty object. In that way I made the 

billboard shot from defocus to focus. I also zoom out the camera by key-framing it from 

frame 361 to 540. 

Billboard camera Depth of Field info: 

Aperture, 

F-stop - 0.2, 

Ratio - 1.0, 

Rotation - 0°, 

Blades - 0. 

 

Figure 4.3.99: Station Billboard Camera Focus 

Clock camera animation info: 

Lens Type - Perspective, 

Focal Length - 50 mm, 
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Lens Unit - Millimeters, 

Clip Start - 0.1 m, 

Clip End - 1000m, 

Camera Size - 36 mm, 

Camera Sensor Fit - Auto. 

Similar like the billboard camera, I took an empty object backside of the clock and near 

the transparent display. From 344 frame I positioned the empty to 361 frame by key-

framing it. Next, I checked the “Depth of Field” of the clock camera and in the “Focus 

Object” I selected the empty object. In that way I made the clock shot from defocus to 

focus. I also pan the camera left to right by key-framing it from frame 279 to 986. 

Clock camera Depth of Field info: 

Aperture, 

F-stop - 1.2, 

Ratio - 1.0, 

Rotation - 0°, 

Blades - 0. 

 

Figure 4.3.100: Station Digital Clock Camera Focus 

There is a scene where three cameras are switching in between. When the main character 

(worker) of the story getting down from the train, at that point I added three cameras to 

take a long shot, mid shot and a close up shot. To switching in between cameras, I used 
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here Blenders bind technic. At first I placed cameras at its position. Then by selecting the 

first camera at frame 840 go to the “Timeline” tab, Marker > Bind Camera to Markers. 

Frames of the first camera was here from 840 to 933. Second camera frames were 934 to 

1044. At frame 934 select the second camera, Timeline tab > Marker > Bind Camera to 

Markers. At frame 1045 select the third camera, Timeline tab > Marker > Bind Camera to 

Markers. Third camera frames were from 1045 to 1120. 

 

Figure 4.3.101: Station Cameras Switching 

Next camera animation was FPV camera. A camera used here as a First-person view 

camera. FPV is what actually a person sees with his/her eyes. By selecting the camera, I 

pressed “Numpad 0” on the key board for the camera view. From frame 1070 to 1105 

camera was its position and I added key-frames on the location-rotation XYZ axis. X 

rotation was 84.6°. From 1105 to 1165 frame camera rotates X axis 42.1° to see the hand-
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watch. From 1165 to 1200 frame camera stays at X axis 42.1° and I key-framed it. From 

1200 to 1240 frame camera rotate back to 84.6° and I applied a key-frame at X axis. From 

1240 to 1550 frame camera moves forward at Y axis. I also applied “Noise” modifier on 

the “X Euler Rotation” to give a natural feeling that the FPV camera is actually walking. 

Station FPV camera (The Worker) “Noise” modifier info: 

Blend Type - Replace, 

Scale - 50.0, 

Strength - 0.1, 

Phase - 1.0 

 

Figure 4.3.102: Station FPV Camera (The Worker) 

Daffodil Space Research Association Camera Animation: Only four cameras were used to 

capture this scene. Two cameras were used for taking the environment shot of DSRA. One 

camera for taking the long shot of the research LABs and Final camera was FPV (as main 

character: Worker). 

Lower base environment shot, by positioning and rotating the camera from left to right this 

shot was taken. Total key-frames for this shot was 1 to 265. Top base environment shot, 

total key-frames for this shot was 1 to 120. Long shot for research LAB, total key-frames 

121 to 550. These three cameras were animated by key-framing the location and rotation. 

DSRA camera animation info: 

Lens Type - Perspective, 

Focal Length - 50 mm, 



©Daffodil International University   128 

Lens Unit - Millimeters, 

Clip Start - 0.1 m, 

Clip End - 1000 m, 

Camera Size - 36 mm, 

Camera Sensor Fit - Auto. 

 

Figure 4.3.103: DSRA Environment Camera 1 

 

Figure 4.3.104: DSRA Long Shot & Environment Shot Camera 2 
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Finally, the FPV camera, this camera took 95% shot of the entire scene. This camera 

worked here as a person (main character: worker). We can see most of the scene of the 

story through his eyes. By key-framing on the location-rotation many times of the camera 

I animated it. Key-frames starts from 15 to 2984 frame. I also used here an add-on, name 

“Camera Shakify”. “Camera Shakify” add-on provides a movement to the camera that 

gives a realistic feel of a person’s movement. 

Final FPV camera animation info: 

Lens Type - Perspective, 

Focal Length - 40 mm, 

Lens Unit - Millimeters, 

Clip Start - 0.1 m, 

Clip End - 10000 m, 

Camera Size - 50 mm, 

Camera Sensor Fit - Auto. 

Camera Shakefy add-on info: 

Here I used two presets of it, Walk to The Store & Out Car Window. “Walk to The Store” 

preset provides the actual feeling of walking just like a person. I keep the Influence from 

0.5 to 0.06 by key-framing it. Scale (1.0), Speed (0.7). “Walk to The Store” key-frames 

took place from 54 to 2842. 

“Out Car Window” preset provides a jerky motion to the camera. I used this preset to give 

a jerky feel, when the character sees the alien. I keep the Influence from 0 to 0.5 and then 

0.02 by key-framing it. Scale (1.0), Speed (1.0). 

 

Train Station Objects Animation: In the train station scene, at first I animated the escalator. 

Two escalator, one is going up and another is going down. For going up escalator, I key-

framed the Y & Z axis location. At frame 1 (Y 0.315 m) & (Z -0.24 m). At frame 18 (Y 0 

m) & (Z 0 m). Next, for Y & Z location I applied “Cycles” modifier to make a continuous 

loop. 

For going down escalator, I key-framed Y & Z axis location. At frame 1 (Y 0 m) & (Z 0 

m). At frame 18 (Y 0.315 m) & (Z -0.24 m). It’s the opposite of going up escalator. Next, 

I applied “Cycles” modifier on the Y & Z location to make a continuous loop animation. 
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Figure 4.3.105: Train Station Escalator Animation 

 

Globe animation, for globe animation I just applied rotation animation key-frame. At first 

I linked the holo globe sphere and the spot light beam with the projector model. Then, I 

animated the projector. At frame 240 I key-framed Z rotation 360°. And then on the Z axis 

rotation I applied “Cycles” modifier to make a continuous loop animation. 

Another animation I did here is projector tilt up and tilt down animation. At first I selected 

the holo projector. At frame 1 I applied a key-frame on Z location. Next, at frame 60 I 

move the Z location little up. Next, at frame 120 I copied the frame 1 key-frame and paste 

it here. To make it continuous loop I added a “Cycles” modifier on Z location. In this way 

I did the holo globe animation. 

 

Figure 4.3.106: Train Station Globe Animation 
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Train animation, for animating the train at first I took an empty cube. I linked the train 

engine and all the train carriages with the empty cube. I placed the train properly on the 

railway track but outside of the station. At frame 500 I key-framed the empty cube at Y 

location. At frame 820 I moved the train on the Y axis inside the station and placed a key-

frame. In this way I animated the train. 

 

Figure 4.3.107: Train Station Train and Train Door Animation 

Train door opening animating was an important part. Because after the train door opens 

the main character of the story will come out. At frame 860 I applied XYZ Location. At 

frame 881 I moved the train door a little at X axis and applied a key-frame. At frame 886 

all the position was same and I applied XYZ location key-frames. At frame 955 I moved 

the door at Y location to open it and applied key-frame there. 

 

DSRA Objects Animation: In the second scene, at first I animated the spaceship model and 

its booster. I took a spaceship model into a new blender scene. I setup lights in front of the 

spaceship as headlights.  
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Spaceship headlight info: 

Light type - Area, 

Color - #E0FFFC, 

Power - 200 W, 

Shape - Rectangle, 

Size - (X 0.28 m) & (Y 0.22 m), (X 0.34 m) & (Y 0.09 m), 

Spread - 50° & 30° 

After light setup, I started modeling and animating the spaceship booster. I took a cylinder 

mesh and resized it according to needs. I applied a “Displace” modifier and in the texture 

properties I choose clouds (size 0.25, Depth 2 & Nabla 0.03). I applied another modifier 

“Wave”. Wave Modifier (Motion Y, Height 0.5 m, Width 0.5 m, Narrowness 1.5 m). In 

the wave vertex group, I choose the vertex group that I applied in the edit mode. Now in 

the shader mode, I applied a new shader. Here I used Mix Shader, Math node, Emission, 

Transparent BSDF, ColorRamp, Noise Texture, Gradient Texture, Fresnel, Mapping and 

Texture Coordinate. I connected each node properly. By key-framing the Mapping node I 

animated the spaceship booster. 

 

Figure 4.3.108: Spaceship and Booster Animation 

After the booster animation I took an empty cube. I linked all the parts of spaceship and 

the boosters with the empty cube. Next I imported spaceship into the main DSRA scene. I 

placed the spaceship on the top. By selecting the empty cube, I added key-frame on the Y 
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axis. I moved the cube few frames forward at Y axis and applied key-frame. In this way I 

animated the spaceship. 

 

Next I started animating the drone model. At first I started animating the propeller. I 

selected one propeller first then at frame 1 I applied a key-frame on the Z rotation 0° value. 

At frame 10 I choose 1080° value and key-framed it. To make is continuous loop animation 

I added “Cycles” modifier on the Z rotation. 

Drone propeller “Cycles” modifier info: 

Before Mode - Repeat Motion, 

After Mode - Repeat with Offset. 

I did the same settings for the other three propellers. 

 

Figure 4.3.109: Drone Animation 

To animate the drone movements, I used here “Follow Path” constraint. At first I took an 

empty cube. I linked all the drone model parts with it. Then by pressing Ctrl+A > Curve > 

Path. I edited the path to make a path way around the DSRA environment. Next, I 

positioned the empty cube at the start point of the path. Next, I selected the empty cube and 

by pressing the “Shift” key I selected the path. By pressing Ctrl+A > Follow Path. I rotated 

the drone as I needed. In this way I animated the drone. 

 

Next animation was animating the main gate of DSRA. This was really satisfying 

animation. Each of the gate handle will open individually here. At first I moved the origin 
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point in where the object will rotate. At frame 725 I applied a key-frame on the Z rotation 

with 0° value. Next, at frame 760 I rotated it 90° and applied key-frame on Z axis. There 

was a “Array” modifier on the gate and I Applied it. In the edit mode I separated all the 18 

handles to make those individual. I selected each of the handles and moved the key-frames 

two frame backward from the previous handles key-frames. In this way the left part of the 

gate was animated. To animate the right part of the gate I took an empty object first. I 

duplicated all the left gate handles and linked it with the empty object. I applied mirror at 

X axis global to make the right side gate animation. 

 

Figure 4.3.110: DSRA Gate Opening Animation 

 

Figure 4.3.111: DSRA Gate 3 
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I also animated the CC camera of the research association. CC camera will continuously 

rotate left to right and right to left. Here I key-framed Z rotation and applied “Cycles” 

modifier to make continuous loop animation. On the backside of the camera there is a cable 

which I modeled using the Bezier curve. I made this cable to move along with the CC 

camera. To make this happen, I selected the camera first then the cable model. Next, I 

pressed tab to switch the edit mode. I pressed Ctrl+H > Hook to Selected Object. So, the 

curve/cable model hooked with the CC camera and now when the camera rotates the cable 

moves with the camera as well. Using the collection instance I made a copy of the CC 

camera and all the animation of it. Then I placed the camera opposite side of the gate. 

 

Figure 4.3.112: DSRA CC Camera Animation 

 

Rendering:  

Scene 1 (Subway train station) render setup: 

Render Engine - Cycles, 

Device - GPU Compute, 

Noise Threshold - checked (0.008), 

Max Samples - 512, 

Min Samples - 250, 

Time Limit - 2 min, 

Denoise - checked, 
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Denoiser - OptiX, 

Passes - Albedo and Normal, 

Resolution X - 3840 px, 

Resolution Y - 1740 px. 

Frame Rate - 30 fps. 

 

Scene 2 (Daffodil Space Research Association) render setup: 

Render Engine - Cycles, 

Device - GPU Compute, 

Noise Threshold - checked (0.012), 

Max Samples - 310, 

Min Samples - 170, 

Time Limit - 1.1 min, 

Denoise - checked, 

Denoiser - OptiX, 

Passes - Albedo and Normal, 

Resolution X - 1920 px, 

Resolution Y - 870 px. 

Frame Rate - 30 fps. 

 

Post-production: 

In the post-production stage, I did text and title animation, intro animation, sound design, 

compositing and editing. 

Sound Design: At first I created some scene voices using the text to voice converter from 

a website name voicemaker. From here I created three voices from text which are, 

- Attention! Train arrived in Ashulia station. Please get down carefully. 

- This is Daffodils restricted area. Stand still for a verification. 

- Access granted. You’re seven minutes late for work. 

In that website I applied a voice artist voice, name Salli. It’s a female voice. After creating 

all the voice, I downloaded those as mp3 format. Then I used a sound maker software to 

make sci-fi type voice. That software name is “Audacity”.  

https://voicemaker.in/
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Here I’m going to explain how I made simple voice to sci-fi voice. 

At first I opened the voice audio file into the Audacity software. By selecting the audio I 

pressed Ctrl+C. Next, from the “Tracks > Add New > Stereo Track”. Then press Ctrl+V 

on the new track. Then select the new track. Go to “Effects > Delay and Reverb > Echo” 

Echo settings: 

Delay time (seconds): 0.04, 

Decay factor: 0.6. 

Then apply. Next, “Effects > Pitch and Tempo > Change Pitch”. 

 

Pitch settings: 

Pitch: from 3 to 3, 

Semitones (half-steps): -1.82, 

Frequency: from 208.696 to 187.826 Hz, 

Percent Change: -10.00 

Then apply. 

 

Figure 4.3.113: Audacity Voice Sound Editing 

After the voice sound creation, I started collecting the other sound effects and back ground 

music. Sound effects like alien creature sound effects, footsteps, heartbeat, breathing 

sound, screaming sound, scanning SFX, login SFX, calling bell and back ground music 

like horror back ground music, sci-fi background music I collected for my animation. 
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Intro, Title and Text Animation: At first I did the “Racy Blue Animation” intro using 

After Effects. To make this intro to look like sci-fi I used here glitch effects. Adding one 

by one effects on the logo and animating those as needed I completed this intro animation. 

Intro animation effects info: 

Displacement Map, Invert, Transform, CC Scale Wipe, Mirror, Glow and 4-Color-

Gradient. 

 

Figure 4.3.114: Racy Blue Intro Animation 

Then I export this file as 1920x1080p, Frame Rate - 30fps, Pixel Aspect Ratio: Square 

Pixels. 

The main title animation of the short animated movie was made using After Effects. By 

using textures and too many effects on the scene and animating those I finally able to get 

the title animation of the short animated film. The title name is “Alien: First Kill”. For the 

title I used two fonts, Conthrax and Nasa. For the final edit of the title I duplicated the 

comp layer two times and added an effects name “Shift Channels”. 

Shift Channel effects info: 

1st layer: 

Take Alpha From - Alpha, 

Take Red From - Full off, 

Take Green From - Green, 
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Take Blue From - Full off. 

2nd layer: 

Take Alpha From - Alpha, 

Take Red From - Full off, 

Take Green From - Full off, 

Take Blue From - Blue. 

3rd layer: 

Take Alpha From - Alpha, 

Take Red From - Red, 

Take Green From - Full off, 

Take Blue From - Full off. 

This effect I used here to give a chromatic aberrations feel to the title. And finally I took 

an Adjustment layer and I applied “Bad TV 2 - old” effects on it. 

 

Figure 4.3.115: Main Title Animation 

Bad TV 2 - old effects info: 

Wave Warp - off, 

Box Blur - (Blur Radius 4.0, Iterations 1, Blur Dimensions - Horizontal), 

Color Balance - Saturation 33, 

Noise - off, 

Venetian Blinds - (Transition Completion 15%, Direction +90°, Width 5, Feather 1.0). 

Then I export this file as 1920x1080p, Frame Rate - 30fps, Pixel Aspect Ratio: Square 

Pixels. 
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Next text animation was “Alien. They exist or not…”. At first I took a fresh After Effects 

scene, 1920x1080p, Frame Rate - 30fps. I typed that text on the scene by using text tool. I 

used here a font name “Conthrax”. In the layer drop down menu, in the animation 

properties > Opacity. Fill Opacity - 0%, Smoothness - 0%, Based On - Characters. In the 

Range Selector 1 animate (Start 0% to 100%) after few frames and End will be 100%. 

After animating the text, I duplicated the text layer two times. And I applied “Shift 

Channels” effects on those layers to make a chromatic aberrations feel. I also added “Bad 

TV 2 - old” effects on it. 

 

Figure 4.3.116: Message Text Animation 

For the name card text animation, I used an After Effects preset called “Unique” text 

animation. I took different text layers and typed text to those text layers and placed those 

one after one. Then I applied “Unique” text preset on those to make the text animations. I 

used “Conthrax” font, “Shift Channels” and “Bad TV 2 - old” effects on those. 

 

Figure 4.3.117: Name Card Text Animation 
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For the lower third text animations and the “They Just Arrived” text animation I collected 

some sci-fi glitch text animation template from the internet. After that, I customized them 

with my text and I applied some effects like “Shift Channels” and “Bad TV 2 - old” on 

those text. For the font I used here “Conthrax” font which is a very cool looking font. 

 

Figure 4.3.118: Lower Third Text Animations 

 

Compositing, Editing and Color Correction: For Compositing, at first I started adding 

the sequence rendered images to the After Effects project panel. The scene 1 (Train Station 

Scene) was 4k resolution. So, I took a 1920x1080 comp with 30fps and placed all the 

sequence images one after one to the scene and scale those down 50% to fit it with the 

comp size. Next, the scene 2 (DSRA Scene) sequence images I place after the scene 1 

accordingly. I merged each sequence layer by key-framing and animating the opacity. Next 

step was adding the SFX, BG music and voice to the scene. I started editing the sounds by 
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synchronizing with the sequence layers. Next step, I took another comp and placed this 

sequence comp inside the new comp. After duplicating the sequence layer two times I 

applied “Shift Channels” effects on those layers for a chromatic aberrations feel. 

Sequence comp Shift Channels effects info: 

1st layer: 

Take Alpha From - Alpha, 

Take Red From - Red, 

Take Green From - Full off, 

Take Blue From - Full off. 

2nd layer: 

Take Alpha From - Alpha, 

Take Red From - Full off, 

Take Green From - Green, 

Take Blue From - Full off. 

3rd layer: 

Take Alpha From - Alpha, 

Take Red From - Full off, 

Take Green From - Full off, 

Take Blue From - Blue. 

Next, I took an adjustment layer on the top of all layers to apply some sci-fi and cinematic 

effects and color correction. I applied “Bad TV 2 - old” effects on that adjustment layer. 

Bad TV 2 - old effects info: 

Wave Warp - off, 

Box Blur - (Blur Radius 2.0, Iterations 1, Blur Dimensions - Horizontal), 

Color Balance - Saturation 5, 

Noise - (Amount of Noise 2.0%, Noise Type - Use Color Noise, Clipping - Clip Result 

Values), 

Venetian Blinds - (Transition Completion 10%, Direction +90°, Width 4, Feather 0.5). 

 

I also added a letter box to the entire composition to give a cinematic look and its resolution 

was 1920x870. The letter box was just a solid layer and I inverted its mask to create it.  
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Figure 4.3.119: Editing and Compositing The Scenes 

Next step was adding scan effects on the screen. There is a scene where the scanner 

scanning the main character. At that point, I created a layer mask using the pen tool to 

make that effect. Here, 

Mask Path - Shape, 

Mask Feather - 48 pixels, 

Mask Opacity - 100%, 

Mask Expansion - (-10 pixels). 

By animating the position of the mask with the main scanner I created this scanner effect 

on the scene. 

 

Figure 4.3.120: Scanning Effect 
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Final Output: Finally, I took a new comp with 1920x1080 and 30fps. I started placing all 

the intros, Alien message animation, scene comps, title animation and name card text 

animation one after one. Then I finally rendered the sci-fi short animated film. 

Render Setting: 

Render Resolution – (Width 1920px & Height 1080px), 

Pixel Aspect Ration – Square Pixels, 

Frame Rate – 30 Frames per Second, 

Resolution – Full, 

Duration – 0:05:00:00 Minutes, 

Format – AVI/MP4, 

Video Output Channels – RGB. 
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CHAPTER 5 

Result 

 

5.1 3D Product Modeling (Bubble Tea Shop) Final Result 

Bubble Tea: Cranberry, Passion Fruit, Kiwi, Original, Taro, Yin Yang final render result. 

I combined these six render output into one image. 

 

Figure 5.1.1: Bubble Tea Final Render Image 1 
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Bubble Tea: Last eight bubble tea models final render result. 

 

Figure 5.1.2: Bubble Tea Final Render Image 2 

 

5.2 3D Visualization (Sato V Trap Installation Process) Final Result 

It’s a single render image of Sato V Trap. Main file is actually an animated video file. 

 

Figure 5.2: A single Render Image of Sato V Trap Animation 
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5.3 Story Based 3D Animation (Story Based Short CG Animation) Final Result 

Alien - First Kill: Two render images from the animation video. One is from scene 1 and 

another is from scene 2. 

 

Figure 5.3.1: Subway Train Station Render Image (Scene 1) 

 

Figure 5.3.2: Daffodil Space Research Association Render Image (Scene 2) 
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CHAPTER 6 

Conclusion 

 

The field of 3D modeling, visualization and animation has seen tremendous growth in 

recent years and it continues to expand and evolve at an incredible pace. These techniques 

have dramatically altered the way in which designers, artists and engineers bring their ideas 

to life and communicate their concepts. From product design and architecture to gaming 

and film, the applications for 3D modeling, visualization and animation are incredibly 

diverse and continue to expand. 

It is clear that the future of 3D modeling, visualization and animation is very promising. 

With the ongoing advancements in technology, the potential for these techniques is endless. 

We can expect to see continued growth and development in this field, leading to new and 

innovative applications and even more advanced and sophisticated techniques. Whether 

you are a designer, artist, or engineer, it is an exciting time to be involved in 3D modeling, 

visualization and animation, and it will be fascinating to see how this field continues to 

grow and evolve in the years to come. 
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Description AAVA 3D is not just 3D animation training and research center, it further provides
proper guidelines and mentorship [9]. Nowadays AAVA3D is the top choice for a creative
mind to build their career. AAVA 3D also works for different companies and do their visual
works. Here in AAVA 3D, I am doing my internship in three different topics. Those are 3D
product modeling, visualization and story based 3D animation. 3D Modeling and
Visualization: 3D modeling is actually shapes of many things that we see in our everyday
lives. From the video games to architectural works, we've all benefited from 3D modeling 
technology. So, what is exactly 3D modelling? What is it used for? How does it work? We are
going to start with the definition of 3D modelling. 3D modelling is a process of creating 3- 
dimensional statements of objects or the surface. 3D models are made within computer
based 3D software. In the time of 3D modelling process, you can determine size of object’s,
shapes and textures. This process works with points, lines and polygons to create 3D shapes
in a 3D software. A 3D model is basically made with vertices, which come together to form
a mesh. It's act as the core of a 3D model. Every point on the model is possible to 
manipulated to change the shape. By using the coordinate data, the 3D software identifies
location of every vertical and horizontal point. A 3D model is basically made with vertices,
which come together to form a mesh. It's act as the core of a 3D model. Every point on the
model is possible to manipulated to change the shape. By using the coordinate data, the 3D
software identifies location of every vertical and horizontal point. Most common technique to
making a3D model is to start with a basic shape like cube, cylinder, sphere, plane or
whatever best suited. From your starter shape, you can start refining and molding it into
what you wish. 3Dvisualization gives digital 3D representation of the real life objects. It
basically refers to the process graphical content by using 3D software. The purpose is to
provide a digital presentation of how the object may look like. The term of 3D visualization
is used synonymously with graphics, rendering and computer generated imagery (CGI). It’s
a technology that has become mainstream over the last few decades and has made very
much popularity and evolved into one of the most necessary methods to producing next
level digital content. Many industries ranging from engineering, architecture, games, films,
medical, manufacturer are taking advantages of this technology. 3D Animation: From our
favorite Disney movies to our favorite video games, 3D animation is now present in most of
the things we watch. Technology continues to improve and animation is getting livelier,
sharper and cooler. So, what is actually 3D animation? 3D animation is a graphic technique
that utilizes motion in order to bring objects, characters, props and more to life, that take
place in a digital environment. Although 3D animation has primarily been used in video
games, films, and TV shows. Now it's usages have grown alongside its popularity. Now, 3D
animation is used to create visual of materials for companies that can help them market
their products and services. The process of giving movement and life to the objects is
divided into three main parts, which are modeling, layout and animation and rendering.
Modeling is a stage in where the objects or characters are generated. This can be done
either by using a 3D modeling tools or by scanning real objects into computer. Both
techniques are incredibly useful and offer different advantages. Creating a model completely
of your own, you have much more control over the entire look. Scanning real world objects
into your computer saves a lot of time. No matter which method is used for modeling, 
textures must be added to the object or character before moving onto the next step. 
Textures allow a more realistic look, and give the model some personality. After the models
are completed, they are moved into the layout and animation stage. There, they are placed 
and animated into a particular scene. At first, a layout must be determined by creating a set
and adding the objects into it. Then the objects and characters must be animated by
assigning animation into it. Rigging is a technique to make characters and objects
animatable. Another method, which become increasingly popular is motion capture
technique. A live actor’s motions and movements are recorded by using markers and videos.
Then the motions and movements directly applied to the model. The final stage is rendering,
where the scene is generated into final image. This usually done using specific render
engine, as the process of rendering is not something a typical computer could handle. A
scene can be rendered with more realistic results, which is called photorealistic rendering
and another is non-photorealistic rendering, which can be rendered to apply a particular art
style. This two types of render depends on the project requirements. Photorealistic render
requires more powerful hardware and it consumes much more time than the non-
photorealistic render. Each of these steps of the process requires a lot of planning and work.
3D artists spend a lot of time on the entire process, ensuring that each model is tailored to
their client’s expectations. 1.2 Beginning of 3D Although 2D animation has been around
since the 1800s, 3D graphics developed with the move toward fully computerized graphics in
the middle of the 20th century. [7] In the 1970’s that there was the first movement towards
true 3D animation, when the film, name FUTUREWORLD used 3D wire-framing to create a
hand and face. By the end of the 1970’s wireframe rendering and wireframe model graphics
had been used in some major Hollywood blockbuster movies including Star Wars for the
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Millennium Falcon and in Alien movie to create the alien. [6] 3D Software continued to be
refined throughout the 1980s, and 3D animation became the medium in the early 1990s.
Veggie Tales was the first fully 3D animated series in 1993, and Hollywood blockbusters
Terminator 2 in 1991 and Jurassic Park in 1993 both used the style extensively. In 1995, 3D
animation took the biggest challenge ever. A full-length feature film was released that year,
name Toy Story by Pixar studios, and the movie claimed the title of the first-ever completely
computer animated film. [7] 1.3 Target Audience In the beginning as much as 3D graphics 
was developed for the arts and it was also being used for research and science. But today it
doesn’t just stop there. Popularity of 3D graphics and animation is continuing to growing.
Let’s take a look at the audience of 3D graphics and 3D animation. ? ? Gaming: 3D modeling
and 3D animation is central of this booming industry. TV and Movies: Creating special
effects (VFX) in live action movies and television shows or to create entirely animated
programs, 3D graphics and animation is everywhere in TV and movies in the 21st century. ?
Commercial and Advertising: Nowadays 3D visualization and animation are widely using in 
advertisements, not just commercials, but also onlinesuch as social media platform and in-
app advertisements. It highly attracts the audience and increases the selling rate. ? 
Marketing: 3D graphics can punch up any marketing campaign a lot, and help to reach more
customers. ? Design and Architecture: 3D visual provides advantages to create a building
design. An architect can create and analyses whole buildings model before it builds. 3D
visual and animation provides the experience of being able to walk through a space that
does not yet exist. An engineer can create model of machines, different engines and
automobile by using 3D graphics. ? Prototyping: Important particularly to the manufacturing
industry, prototyping allows to an object to be virtually created, tested and explored prior to
manufacturing. This can further use to create machinery products. 3D animation allows to
do the progress at much lower overhead costs. ? Medical Science: In medical science 3D
helps to create visuals of different organs of human body. 3D animation also helps to
understand how different organs works, explain about DNA, enzymes, microcellular and even
submicroscopic processes. With the help of 3D animation, demonstrates medical
equipment’s, its uses and features. It could be also used as a training info for its customers
and healthcare professionals. It is an excellent way to show how a medical device works and
how to operate that. So, target audience of 3D modeling, visualization and animation is
almost every sector. 1.4 Project Timeline (Gantt Chart) Project 1: 3D Modeling and
Visualization (Bubble Tea Shop Modeling and Sato V Trap Installation Process) Gantt Chart 1
Table 1.1: Project 1 Timeline Project 2: 3D Animation (Story Based Short CG Animation)
Gantt Chart 2 Table 1.2: Project 2 Timeline CHAPTER 2 Background Study This paper is
based on three different projects given from AAVA 3D, in which I'm currently doing my
internship. So, background study will be different from each other. I’m going to explain those
differently. 2.1 History of 3D Modeling Surprisingly, history of 3D modeling began before the
first PC invented. It all started with mathematical ideas that are behind visualization of 3D. 
Some of the basic ideas came from Euclid, sometimes referred to as the “founder of
geometry”, who lived in the third century BC. Then, Rene Descartes in the 1600s gave the
world analytic geometry, it also known as co-ordinate geometry, which allowed to accurately
track distances and also the locations. Figure 2.1: Euclid's Elements of Geometry In the mid-
18th century, English mathematician, name James Joseph Sylvester invented matrix
mathematics, which is now work for every computer generated image where one can see
reflections and light distortion. In the 1950's, computer was developed and put to many
mathematical uses, only for scientific and military. First advancements in the history of 3D
modeling came when the first commercially available Computer Aided Design systems (CAD)
started coming out in 1960's. The biggest breakthrough came from Ivan Sutherland who
introduced Sketchpad in 1963 with its revolutionary interface. It also known as Robot
Draftsman. Sketchpad can be used not only for engineering or repetitive drafting but
interactively by designers and potentially artists. At the end of the decade, Ivan Sutherland
and David Evans founded the first 3D graphics company, name “Evans & Sutherland”. They
started the company to produce hardware that can run the systems, but weresoon also for 
software development. Their appearance and success inspired others to start up their own
companies and work on developing the technology. ADAM is aCAD system released in 1971.
It was developed to work on as many machines as possible. MAGI was a company, they 
introduced solid 3D modeling, and creating new demand for CAD, universities were working 
hard to advance the history of 3D modeling and discover new and more useful technologies
to visualize 3D model. Year 1981, the first IBM PC was introduced, caused an extensive use
of CAD in not just automotive and aerospace industries but also in the commercial
engineering businesses. Solid 3D modeling then became the mainstream with the
development of software such as Unigraphics UniSolids CAD. In year 1983, 2D system of 
AutoCAD was released and it was the first significant CAD program in the history of 3D
modeling for the IBM PC. In 1990's, because of IBM PC, CAD software was widely spread 
and being tested to its limits. It became cheaper and easier to access, and professional
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programs and hardware allowing for any company, freelancer and hobbyist to create 3D
models. The software was then constantly developing and changing, was allowing for faster
access and a more user- friendly experience. [12] 2.2 Background Study As this report is
about 3D product modeling and visualization, so I studied on some related documents to get
more information. 3D Product model has transformed the way of product development
works. Today it is used by several industries and has been heavily impacting their
businesses. Do you know that 3D product modeling was originated in year 1960? it’s evolved
in the most captivating ways ever since. 3D Product modeling is a composition of geometry,
science, design and mathematics. It is defined as the method of creating a mathematical
depiction of a 3D structure using specialized 3D software. This is a representation of a
formation called 3D model, which is the best way to visualize a real product. - 3D artists are
able to make product modeling prototypes on their digital screens. - The influx of new
functional and technological applications has improved the way 3D modeling works. - The
new developments in product modeling have helped to remove all the limitations of outdated
processes. - It increased the functionality and productivity across design teams. 3D product
modeling can influence your business. Showcasing 3D Product models can simplify the
magnificent representation of your innovative product designs. - Product modeling can offer
your potential clients an impressive experience giving them a very detailed view of what the
actual product will look like. - Marketing team can use 3D product models for campaigns
purpose. 3D product models can showcase all the features and capabilities of the products. -
You can interact with the 3D product model through various functionalities like rotating,
disassembling and reassembling. - It is possible to show 3D products in virtual reality
through VR headset which gives more experience. Figure 2.2: 3D product modeling and
visualization 3D product visualization provides visuals that showcase products in a much
more impressive way than a simple text-based product description. These can be anything
like 360-degree video, showing the products from different angles and an interactive view
which shows a product’s internal components. Imagine you’re shopping online for a new bag
from your home. With a 3D visualization, you can filter and choose between multiple
variations of the same bag, and narrow your selection by size, color, and materials. This
allows you to gather information and easily determine which bag will fit your needs. 3D
product visualization enables brands to offer the highly engaging experiences what today’s
customers look for. Potential customers can inspect in detail a product before buying it and 
allowing them to better understand what they are purchasing. Customers are able see
products from every angle, and switch between various colors and models with a simple click
. 3D product visualization is an alternative of product photography. However, photography
has its place and can artfully exhibit a completed project, where 3D visualization offers a
few advantages over traditional product photography. - Youcan showcase every angle your
product at once that provides a better user experience. - You can be designing a 3D model
of a product while the product is still being developed and can show it to the consumer. In 
that way, you can launch your marketing campaigns just as the product is ready. - 3D
visualization offers more flexibility of a product and modifications are very easy, if you
change an element of their designyour products don’t have to be reshot, and you can
quickly create so many product variations. 3D product visualization and photography both 
can clearly and efficiently highlight a product’s selling points. CHAPTER 3 Details of Software
Used 3.1 Software Used To complete the entire projects, I had to use software. Because
these whole projects were done by using software. To make 3D modeling, visualization and
3D animation, from the beginning to the final output different software were used in different
stages. Software: - Autodesk 3ds Max - Blender 3.0 - Nextlimit Real Flow - Adobe After
Effects - Adobe Media Encoder - Adobe Photoshop - Adobe Illustrator - Audacity Figure 3.1:
Software Logo 3.2 Software Details Autodesk 3ds Max: 3ds Max, earlier known as 3D Studio
Max or just 3D Studio. It was developed by Yost Group, a company started by the renowned
filmmaker and software designer named Gary Yost, and was first published by Autodesk Inc.
in 1996. 3ds Max is a 3D professional modeling, animation, and rendering application which
was developed for making 3D models, animations, interactive games, visual effects for the
entertainment industry and, 3D models and visuals for the engineers. It can bring characters
to life by using a special feature called the inverse kinematics. It plays a huge role in
designing 2D cross section shape of 3D models. It is capable of architectural modeling and
visualization, and it serves as a tool in product design and manufacturing. It is a massive 3D
software that is in used of almost every industry for different purposes. Understanding this
software is little hard for a beginner. [14] 3ds Max has an amazing set of tools, commands 
and it supports unique features that make it a user-friendly 3D software. It has various
unique built-in primitive shapes such as plains, cubes, cylinders, teapots, cones, pyramids
that are used as a foundation for modeling. 3D graphics programs, that using geometric
data to create objects is called 3D models. There are four main methods of 3D modeling
which are polygon, primitive, non-uniform rational basis spline (NURBS) and rational basis
spline. 3ds Max basically uses the polygon modeling method. Polygon modeling gives a user

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


specific control over the individual meshes through X, Y and Z coordinates, which appear as
a group of vertices, edges and faces. This program is also used in the simulation of
mechanical parts as it supports the NURBS features. NURBS allows smooth modeling by
using mathematical formulas. Character modeling is also made simpler in 3ds Max as it 
includes simulations for skin, hair, fur and cloth. These inbuilt tools reduce the time taken for
modeling and enhance the detailing of an object or character. [15] Besides, 3D Studio Max 
supports 3D rendering characteristics. One of the interesting abilities of the program is that
users can view the rendering results without rendering the scene. This feature can be turn
on by starting the “Active Shade Mode” in the program itself. Figure 3.2.1: 3ds Max 2020
Interface 3ds Max offers a multipurpose interface that sets itself different from competing
products such as Blender and Maya. The interface of 3ds Max is clear and very user-friendly.
Users can also customize their own user interface in different ways. For example, command
panels and toolbars can be moved around for a more convenient workflow. New toolbars
and buttons, and custom recording scripts and keyboard shortcuts can take the interface
even further. Plugins can be used with great ease and without any lagging with render
programs like V-ray, Corona, Redshift and others. Some of the major advantages: - It
supports huge numbers of tool that are easily available for modeling. - It’s very user-
friendly, especially in modeling. - It supports the "Material Editor" that allows the user to
create and edit materials and maps in the objects. - It supports multiple tools for animation
and it supports plugins. - It works and blends with other Autodesk products perfectly. - It
has strong rendering abilities and advanced usage with industry-standard products. Blender:
Blender is a free and open source 3D creation software that supports almost every aspect of
3D development. With a strong foundation of modeling capabilities, texturing and shading, 
rigging, animation, lighting, and a host of so many tools for complete 3D creation. Whether
you want to deal static models or get into the world of animation, this software will bring
your imagination to visual. Blender is also a great tool to deal with 2D graphics. Many
professionals who work as modelers, texturing and skinning, skeleton, rendering, rigging
and animation, simulation, motion graphics, videogame, and movie VFX artists can use this
application for the project pipeline. Blender become very popular among the video game
developers and animators because of its user-friendly interface, which has both 3D editing
mode and scripts-based editing for effective and best-quality data output. This application 
has all sets and presets to work along with the most suitable plugging as required. Blender
can be compared with other similar software like Cinema 4D, MAYA, 3Ds Max and more.
Though Blender is free, it is accessible and valuable for a wide range of users, from the
beginner to the professional animator. Even NASA uses Blender for many of its public models
. [16] A Dutch animation studio NeoGeo started to develop Blender as an in-house
application, andJanuary 2, 1994 is considered to be Blender's birthday. Blender Version 1.0 
was released in January 1995, with the primary writer being company co-owner and
software developer Ton Roosendaal. The name Blender was inspired by a song by the Swiss
electronic band Yello, album name "Baby", which NeoGeo used in its showreel. Some design
choices and experiences for Blender were carried over from an earlier application, called
Traces. This application Roosendaal developed for NeoGeo on the Commodore Amiga
platform during the 1987–1991 period. In 1998, January 1 Blender was released publicly
online as SGI (Silicon Graphics, Inc.) freeware. [19] As you may have known, one of the
best things about Blender is it’s completely free to use. Blender has been released under
GNU (General Public License), which allows people to: ? Use Blender for any intention. ? 
Distribute Blender. ? Study how Blender works and change it. ? Distribute changed versions
of Blender. Figure 3.2.2: Interface of Blender 3.0.1 Main Features of Blender: - For
development of 3D contents blender provides a wide range of essential tools that includes
modelling and sculpting, shading and texturing, animation & rigging, rendering, video
editing, VFX, compositing, and so many simulation forms. - It has high quality of 3D
architecture tools that enables fast and efficient creation of workflow. - Blender has so many
built-in addons which make its user to work fluently and it supports many external addons
that developed by the creators. - Blender application is a cross-platform tool which is
developed in collaboration with a uniform OpenGL GUI on all major platforms and besides it
allows to customize with Python scripts. - - It has active community support, those who
assist in solving problems of community members, blender.org/community. Blender allows a
wide variety of tasks, and when first attempting to understand the fundamentals, it can
seem Irresistible. However, after practicing few hours, it is possible to familiarize yourself
with Blender with the help of right learning content. A user canuse blender for multiple
reasons based on the project pipeline as described below: - Animated films and VFX scenes
can be developed as imagined and by adding and adjusting all technical attribution of
lighting and using camera angles to achieve the resulted output to entertain the audience. -
Engineering presentations and details of mechanical design can be added to the model.
Performance of engine, pressure, material and other engineering calculation can be
explained through demo. - Game concepts andmodels can be developed, and regulation can

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


be added by python scripting and experiencing them by its own game engine to check
visually compatible for all mobile system and other electronic device. - Students can learn
and study about animation of movie-making and gaming concepts and technical aspects.
Nextlimit Real Flow: RealFlow is an industry standard, out of the box fluid and dynamics
simulation software mostly used by 3D and visual effects industry, which was developed by
Next Limit Technologies in Madrid, Spain. RealFlow is compatible with ALL major 3D
application to simulate fluids, water surfaces, soft bodies, rigid bodies, and meshes, and can
simulate anything from a single drop of liquid to a massive tsunami. For large-scale
simulations like floods or oceans with breaking waves, RealFlow's cutting-edge HyFLIP solver
, Hybrido, provides you with endless possibilities. Dyverso is a multiphysics solver that can
be used to simulate a wide range of different type of materials, rigid, granular, elastic, liquid,
etc. All of them interacting with each other and using the modern GPUs to calculate
simulation data. RealWave is a very powerful simulation tool of realflow, ideal for simulating
small to massive ocean surfaces quickly and effectively. Caronte is RealFlow’s built-in rigid
and soft body dynamics solver. [20] [21] RealFlow was first released in 1998 by Next Limit
Technologies. In year 2008, Next Limit Technologies was awardedby the Academy of Motion
Picture Arts and Sciences for their development of the RealFlow software. In 2015, Next
Limit Technologies released the RealFlow Core for Cinema 4D. [20] RealFlow technology
uses particle based simulation system. These particles can be influenced in various ways by
point-based nodes, which can do several tasks such as simulate gravity or recreate the
vortex like motion of a tornado. RealFlow can also simulate soft body and rigid body
collisions and interactions. The inclusion of Python scripting and C++ plug-ins allows users to
program their own tools to improve RealFlow capabilities, adding more control to the aspects
of the RealFlow workflow including batch runs, events, daemons, fluids and waves.
RFConnect is a plugin of RealFlow that supports following DCC applications: 3ds Max, Maya,
Cinema 4D and Houdini. In 2015 RealFlow was released to the public. Features of this major
release are: - New DYVERSO solvers with GPU acceleration. - Maxwell Render facility. -
Enhanced quality of simulations. - Improved user interface. - Rapid OpenVDB meshing and
DYVERSO solvers speed up the simulation times by 10x. - More controllability splines nodes,
text tools, daemons falloff and crown daemon. Figure 3.2.3: Interface of RealFlow 10 Adobe
After Effects: Adobe After Effects is a motion graphics, visual effects and compositing
application which was developed by Adobe Systems and it used in the post-production
process, commercial and television production. Among other things, After Effects can be
used for keying, tracking, compositing, social media content and 2D animation making. For
scientific and technical achievement Adobe After Effects won an Academy Award in 2019.
[22] After Effects was originally created by David Simons, David Herbstman, David M.
Cotter, Daniel Wilk and Russell Belfer at the Company of Science and Art in Providence,
Rhode Island, where the first two versions of the software, 1.0 in January 1993 and 1.1,
were released by the company, CoSA. After Effects was then acquired by Aldus Corporation
in July 1993, which was acquired by Adobe in 1994. Version 3.0 was Adobe's first new
release After Effects. [22] After Effects helps graphic designers and motion graphics artists
to give animation to logos, cartoons, and objects with the help of a key framing process. The
application is specially designed in such a way that created files do not get destroyed. It also
hence the program supports in a non-linear editor. it has so many editing tools, features,
effects and presets that make Adobe After Effects an important and immensely attractive
software. There is a feature in after effects which is Camera Tracking that helps the user to
track and edit the original video and modify and add any text, objects or video in between
the original video clip. There is another special feature in After Effects called Expression that
helps the user speed up the animation process by controlling the animation sequences using
codes. With the help of tools and features After Effects is generally used to create
compositions. With the help of the 360-composition editor users can compose and edit 
videos for VR. This application also features a visual keyboard shortcut editor, user can 
create keyboard shortcuts of their own, which helps them to modify and animate the videos
more easily and speedily. This application farther helps the user to create Null object and
create Masks, Shapes, and Brush lines. Roto Brush Tool that helps to change background of a
scene. Before, it was difficult for the users to edit the background that has motion in it, but
now with the help of the Roto Brush tool, the users can easily edit the background with a
single stroke of a brush. [23] Functional of After Effects can be extended through a different
of third-party integrations, which are: plug-ins, scripts and extensions. Plug-ins are mainly 
written in C or C++, which extend the functionality of this application, allowing for more
advanced features such as particle systems, 3D effects and reduce the gap between After
Effects and another application. Figure 3.2.4: Interface of Adobe After Effects CC 2020 
Adobe Photoshop: Photoshop is a photo editing and raster graphic design application that 
allows users to create, edit and manipulate various graphics as well as digital art. it offers its
users the ability to create, enhance and edit images, artwork, and illustrations, changing
backgrounds, simulating a real-life painting or creating an alternative view of the universe. It
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makes use of layering to allow depth and flexibility in design and editing process. It is the
most widely used software for photo editing and image manipulation, creating image
compositions, website mockups, adding affects and retouching for numerous image and
video file. Photoshop makes possible to edit individual images as well as large batches of
photos. Photoshop CC, Photoshop Elements, Photoshop Lightroom and Photoshop Express
are some different types of Photoshop. Adobe Photoshop was originally developed by two
brother Thomas and John Knoll in 1987, and later in 1988 Adobe Systems Inc. bought the
license to distribute. Thomas Knoll, a Ph.D student at the University of Michigan, wrote a
program on his Macintosh Plus that basically displayed images on a screen and called it
“Display”. His brother John, who worked at industrial Light & Magic convinced him to make a
full program of it. Thomas choose a name for this program, which is ImagePro, but the name
was already taken by another company. Thomas then renamed his program Photoshop. 
They made a short-term deal with Barneyscan. It's a scanner manufacturer. They distribute
copies of the program with a slide scanner they were selling. Around 200 copies of
Photoshop were shipped this way. John traveled to Silicon Valley and gave a demonstration
of the program to the engineers of Apple Computer and art director of Adobe, Russell
Brown. Adobe purchased the license to distribute it. February 19, 1990, Photoshop version
1.0 was released for the Macintosh exclusively. Price of Photoshop 1.0 for Macintosh was
$895 in 1990. [24] Figure 3.2.5: Interface of Adobe Photoshop CC 2020 Photoshop is
specifically designed to create and edit raster images in multiple layers. These layers can
support transparency and also can act as masks that can alter underlying images in the
layers below them. Shadows and several effects such as alpha compositing can be applied in
Photoshop. It is also possible of apply several color models to these layers like RGB, CMYK, 
Spot Color and Duotone and Lap color space. Photoshop Document (.PSD) is the default file
extension for Photoshop. PSD file has maximum of 30,000 pixels for width and height and a 
file length limit of 2GB. Photoshop Big (.PSB) is the largest file format of Photoshop with
maximum 300,000 pixels for width and height and also extends the length limit to around 4
Exabytes. There are many advantages of this best drawing software: - Resizing images to a
desired pixel height and width can be very easily done by using Photoshop. - Photoshopgives
the ability to customize images, graphics and more that fit your brand’s specific needs. 
Photoshop supports numerous file types and invites collaboration and ensure accessibility to
every designer on your team. - Photoshop is also widely used for designing graphics and
layouts for websites and it offers a wide variety of patterns and features to make an
impressive website design with a website layout. - You can restore old and damage photos in
Photoshop with the help of special tools and filters. - PSD is the master file type and these
are some other file formats Photoshop can work with and export: JPEG, TIFF, PNG, GIF, MOV,
DPX, MPEG4, PDF etc. - Basic imageediting such as red-eye removal, skin tone
adjustments, adding or removing blur, teeth whitening, background adjustments are just a
click away, which can be done by Photoshop and save a lot of time. - There are lots library 
of digital painting brushes for Photoshop that can help you to make artworks. - Highly
customizable keyboard shortcuts for a smooth and time saving workflow. - Photoshop can be
installed on Windows, macOS, iOS, iPad OS, Android. Adobe Illustrator: Adobe Illustrator is
a design based software for creating vector graphics, logos, drawings, banner, posters,
typefaces, presentations and other artworks. It's a vector-based software which is made
specially for graphic designers. Adobe Illustrator can be defined as the only software which
was previously made for graphic designers. Adobe Illustrator provides a perfect user friendly
interface. If you are working in a team, then it makes your job easier to train new
employees. Adobe Systems was founded in 1982 by two American mathematicians John
Warnock and Chuck Geschke and Illustrator was the first software application from Adobe
Systems and it was released in 1987 for the Apple Macintosh. The most significant feature is
its pen tool, which allow the user to draw smooth curves and create high-resolution shapes
and images. In 1989, Adobe released Illustrator for Microsoft Windows PC. In 2003, Adobe
released Illustrator CS version 11, CS means Creative Suite, which bundled together
Illustrator, Photoshop, InDesign and Acrobat. Illustrator CS6 was the last version of
Illustrator CS that was released in 2012. It has already developed a lot of new features that
we see in new illustrator versions today. After Version CS6, Adobe introduced new Illustrator
version which is CC (Creative Cloud), in 2013. So, future versions of Illustrator and its other
software would be available only through an Internet subscription service called Adobe
Creative Cloud. Through the years, Illustrator continued to expand, adding support for
TrueType, more-complex drawing tools, an ever-increasing number of drawing “Layers” and
support for 3D figures. Working with Adobe Illustrator makes more comfortable as it has
enough advantages: - You can make a banner or poster of any size start from a small dot to
large flex. - It has some readymade tools from which you can make variety of shapes. -
Importing, editing and modifying of images can be done with just one platform. - This is very
easy to use with other Adobe products. Graphic designers mostly use Illustrator for creating
logos, banners and posters, illustrations and artwork, typeface, infographics etc, mostly
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vector-based graphics. You can resize any vector graphics without losing the quality of it. For
logo design Adobe Illustrator is the best and it's an industry standard design software.
Another reason why most of the graphics designers love Illustrator is the flexibility. You can
really do a lot with it, from changing colors, modifying shapes and fonts, and so much more,
huge tools and presets are available in it. The default file format for projects created in
Illustrator is AI format, but it can also save files as EPS (encapsulated postscript), PDF, SVG,
AIT. It can export graphics as JPEG, PNG, BMP, DWG and other graphics formats. Figure
3.2.6: Interface of Adobe Illustrator CC 2020 Audacity: Audacity is a free, open-source
digital audio editing software that allows users to record, edit, and manipulate sound files. It
is available for Windows, macOS, and Linux operating systems, and offers a wide range of
features such as multi-track editing, effects, noise reduction, and support for various audio
file formats. Audacity is popular among podcasters, musicians, and sound engineers due to
its versatility and ease of use. It allows users to create professional-quality audio recordings
and edit them with precision. With its wide range of features and intuitive interface, Audacity
is a powerful tool for anyone looking to create, edit, or manipulate audio files. Figure 3.2.7:
Interface of Audacity Software CHAPTER 4 Workflow Three different project given from AAVA
3D. But, here I’m going to explain my workflow step by step in three different point. 1. 3D
Product Modeling (Bubble Tea Shop) 2. 3D Visualization (Sato V Trap Installation Process) 3.
Story Based 3D Animation (Story Based Short CG Animation “Alien: First Kill”) 4.1 3D
Product Modeling (Bubble Tea Shop) “Bubble Tea Shop”, It’s a drinkable food item. I created
model of it and render that out as 3D product modeling. This task was from AAVA 3D. 3ds
Max, RealFlow, Blender, Illustrator and Photoshop was used for this project. Modeling: Most
of the time modeling starts with a reference image. I got reference image from AAVA 3D to
start the product modeling. I had to model exact same model like the reference image. There
are several applications available for 3D modeling. Different application provides different
technique for modeling. But I choose 3ds Max, because there is some easy technique to
model a tea glass like the reference image. Figure 4.1.1: Reference Image for Tea Glass
Modeling Here I used spline to draw the basic 2D shape of the glass. After that I applied a
modifier called “Lathe”. Lath modifier is a modifier, that has the ability to convert spline
shapes into 3D. It’s a fast modeling technique that modelers widely use to make 3D shapes
in where it’s little hard to make model manually. Figure 4.1.2: Glass Modeling After that I
converted the glass model into Editable poly. Without converting the model it’s not possible
to apply texture or render out the model properly. Then I applied another modifier called
“Shell”. Shell is a modifier that gives a depth to the plane model. Shell: Inner Amount:
0.0cm Outer Amount: 0.483cm Segments: 1 Figure 4.1.3: Shell Modifier Before I head to the
next step I exported the model as .OBJ file with Triangle Faces. Because RealFlow software
can’t work with Quad Faces. Figure 4.1.4: .OBJ Export Fluid Simulation: To Fill the glass with
fluid I used one of the best software for fluid simulation “RealFlow”. It’s really needed to fill
the glass with fluid, because the fluid will visual as tea. After importing the glass model onto
the Realflow software, there was several particles system to fill it. Here I used Dyverso
Circle. I resized the Circle according to the needs. Then I add Gravity Daemon, so that
particles can flow towards ground. Adjustment of the parameters: Dyverso Domain: Particle 
Type: Liquid-PBD Resolution: 5.0 Density: 1000.0 Internal Pressure: 1.0 External Pressure
Scale: 0.1 Surface Tension: 0.0 Tensile Strength: 0.1 Dyverso Emitter: Volume: 0.0 Speed:
2.0-0.0 Simulation Type: Active Gravity Daemon: Affect: Force Strength: 9.8 Object: Volume
Cell Size: 0.035 Volume Mode: Shell Figure 4.1.5: Relationship Editor (Dyverso Parameter)
Particle & Daemon tools, object, Particle Mesh should be connected through Hub in
relationship editor. We can connect it by Pressing “CTRL>Drag L Mouse Button”. Object,
Gravity Daemon, Dyverso Domain should be directly connected to the Hub and Dyverso
Emitter with the Dyverso Domain. 200 frames were good enough to complete the simulation
and fill the glass. After selecting the frames, I started the simulation with 1000 density and
speed limit 2.0. At frame 148 I added a keyframe on the speed limit and at Frame 150 I
added another keyframe and set the speed limit to 0.0, so that the particles don’t get over
flow. After the simulation complete, I converted the particles into mesh by using Particle
Mesh VDB. There is problem here, which is only a single frame convert into mesh. So, I again
simulated all the frames. The next step was stitch the files to make it just one file. Alembic
(.abc) file is what RealFlow create for simulation. To stitch the Alembic sequence files there is
a tool in RealFlow called “Stitch alembic files”. I used that tool to stitch all that Alembic files
together to make it single. Figure 4.1.6: Filling The Glass Adding Condensation or Water
Droplets: Condensation is water droplets around the object. In the “Bubble Tea Shop”
reference images, the glasses have water droplets added. Water droplets condensed around
an object when that object is cold. Bubble tea is a cold drink item, so there must be water
droplets around it. I imported the fluid simulation .abc file and the glass model in the Blender
for the final works. Here I added water droplets around the glass. Figure 4.1.7: Water
Droplets There are several ways to add water droplets in an object. But I used Blenders’
Geometry Nodes for this process, because it is the most efficient way. At first I created a
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single water droplet model. Then, by using the Geometry Nodes I spread water droplets
around the glass. Process of adding water droplets using Geometry Nodes: - Group Input -
Group Output - Distribute Points on Faces - Object Info - Random Value - Instance on Points
- Join Geometry Figure 4.1.8: Geometry Nodes for Water Droplets - Group Input < Distribute
Points on Faces < Instance on Points < Join Geometry < Group Output - - Object Info <
Instance on Points< Join Geometry < Group Output Random Value < Instance on Points
Here, Distribute Points on Faces node adds points on the surface of the input geometry
object. Object Info node allows to which object will appear on faces. Random Value node
controls the location/rotation, minimum or maximum amount. Instance on Points node are a
fast way to add same geometry to a scene many times without duplicating it. Join Geometry
node join the data together. Figure 4.1.9: Water Droplets Material For water droplets material
I used Principled BSDF: Roughness 0.0 Transmission 1.0 IOR 1.33 Adding Ice-cubes and
foam: Ice cubes are just cubes with subdivide many times. I sculpted those to look different
from each other. Then I added displace modifier and on the texture properties I used cloud
texture to displace the cubes to look more realistic ice cube. Figure 4.1.10: Ice Cube Material
For the ice cubes material, I used Noise Texture, Bump node, Color Ramp node and Principle
BSDF node. Principle BSDF (Transmission 1.0 and IOR 1.33), Bump node (Strength 0.483),
Noise Texture (Scale 3.9, Detail 2.9 and Roughness 0.558). Figure 4.1.11: Ice Cube Rigid
Body To place the cubes inside the glass, here I used Rigid Body Dynamics. This process
helps to simulate and place the cubes perfectly inside the glass. Inside the glass I places a
collision object. So, that the cubes could not pass through the glass. 150 frames were good
enough for this Rigid Body simulation. For the foam, I selected the glass model first. In the
edit mode I selected the top faces. By separating the faces (Shift D for duplicate > P for
separate selection), I fill the upper and low portion (By pressing F key). Then I subdivide it
few times. After that I switched to sculpting mode to sculpted the model to look like it’s
foam. I used “Draw” and “Inflate” tool for sculpting. Figure 4.1.12: Bubble Tea Foam For
texturing the foam model, here I used Texture Coordinate node, Mapping node, Voronoi
Texture (Scale 6.0 and Randomness 1.0), Bump node (Strength 0.358) and Principled BSDF
(Emission Strength 0.4 and Emission Color #7F8080). Figure 4.1.13: Foam Shader Node
Adding Bubble Tea Shop Logo: Adding “Bubble Tea Shop” logo in front of the glass was little
difficult for me. Because I used completely new method here which I never used before. But
the method was very efficient. Figure 4.1.14: Bubble Tea Shop Logo At first I added text logo
to the scene. In the text properties, geometry section I extruded the text (0.01m). Then I
added “Remesh” modifier, then Sharp (Octree Depth 8, Scale 0.9 and Sharpness 1.0). After
that I added “Shrinkwrap” modifier. Shrinkwrap modifier helps to place object onto the
surface. Snap Mode - On Surface, Axis - Z, Negative - checked, Positive - checked, Face Cull
- Off, Target Object - Cup, Offset - 0.01m Shading & Texturing: Total fourteen different
bubble tea drinks I had to texture like the reference images. It was quite complicated to
make exact same, because those have to look more realistic like the reference images.
Figure 4.1.15: Reference Image of Bubble Tea Drinks First of all, the glass material, it should
be transparent kind of water color material. There is a shader node called “Glass BSDF”. For
the glass I used Glass BSDF material (Beckmann, Color #FFFFFF, Roughness 0.2, IOR 1.45).
Figure 4.1.16: Glass Material Next step is to texture the drinks which is bubble tea. Total
fourteen different bubble tea drinks. 1) Cranberry: Cranberry is a red tea drink. To get that
specific effect, I used Texture Coordinate node, Mapping node, Separate XYZ node,
ColorRamp node (Color #FF7A47 and #EE2B2B) and a Glass BSDF (Roughness 0.0). Figure
4.1.17: Cranberry Texture 2) Passion Fruit: It has the same Glass BSDF material, But
Roughness 0.285 and IOR 2.0 and Color #D69721. Figure 4.1.18: Passion Fruit Texture 3)
Kiwi: Texture used here, Texture Coordinate node, Mapping node, Separate XYZ node,
ColorRamp node (Color #FAFF9F, #D8D148 and #C3C38F) and a Glass BSDF (Roughness
0.592 and IOR 1.650). Figure 4.1.19: Kiwi Texture 4) Taro: Glass BSDF material, Roughness
1.0 and IOR 166.6 and Color #CABDE6. Figure 4.1.20: Taro Texture 5) Bubble Tea Original:
Glass BSDF material, Roughness 1.0 and IOR 166.6 and Color #E6B296. Figure 4.1.21:
Bubble Tea Original Texture 6) Yin Yang: Texture Coordinate node, Mapping node, Gradient
Texture node, ColorRamp node (Color #D18F57 and #FFC77C) and a Glass BSDF (Roughness
1.0 and IOR 166.6). Figure 4.1.22: Yin Yang Texture 7) And rest of the tea textures are
almost similar with various Glass BSDF roughness and IOR, various ColorRamps color and
Gradient Texture node. By adjusting nodes parameters several times, I got the exact result
for those bubble tea drinks. Figure 4.1.23: Other flavors Texture Lighting & Camera Setup:
For the light setup, I used two planes and then I applied two different emission shader.
Emission shader usually use for glow up an object and lighting the environment. Two
different planes, one is on the top and another as back light. Top emission shader: Strength
12 and Color #FFE6CE. Back emission Shader: Strength 5 and Color #FFE6CE. For the
environment, no HDRI was used, just white color with 1.0 strength. Figure 4.1.24: Bubble
Tea Camera For the camera setup, Focal length: 50mm Sensor size: 36mm Resolution: X
1920px and Y 2700px Render Setup: Render Engine: Cycles Device: GPU Compute Render
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Sampling, Samples: 2048 Time Limit: 0 sec Denoise: checked Denoiser: Optix Passes:
Albedo and Normal Final Output: Figure 4.1.25: Bubble Tea Shop Final Output 1 Figure
4.1.26: Bubble Tea Shop Final Output 2 4.2 3D Visualization (Sato V Trap Installation
Process) Sato V Trap, slogan “A Better Life. Every Day”, is a toilet pan which uses a
mechanical and water seals to close off pit latrines form open air. It’s a sanitary product. I
got a task from AAVA3D to make a 3D visualization for Sato V Trap installation process and it
was their client's project. For modeling and texturing, animation, simulation, lighting and
rendering I used Blender Software. And for the final edit I used Adobe After Effects and
Adobe Illustrator. Modeling and Texturing: 5 different Sato pan 3D models were provided by
the client to work on: - Upper Housing - Lower Housing - Diversion Bucket - Flap Door - Sato
Pan Figure 4.2.1: Sato V Trap All Models For texturing those models, I used several shader
node. As the actual Sato pan is made of plastic, so I adjust the shader node parameter to
make is look like real plastic. Upper housing, Sato pan and flap door, material for these three
are same and here is the material that was used, Diffuse BSDF (Color #293EA6, Roughness
0.0), Glossy BSDF (Color #293EA6, Roughness 0.192), Mix Shader (Fac 0.5). Diffuse BSDF
and Glossy BSDF was mixed by using Mix Shader. Than a glossy plastic look appeared. Figure
4.2.2: Sato V Trap Materials Lower housing and Diversion Bucket, material for these two are
same and black plastic material was used here. Diffuse BSDF (Color #1D1D1D, Roughness
0.0), Glossy BSDF (Color #3F3F3F, Roughness 0.292), Mix Shader (Fac 0.5). For modeling
the toilet, at first I model the pan holder and the base. I used cube mesh for the base model.
Then I added another cube as the pan holder. I modified and made a hole inside the cube as
same shape as the pan, so that I can fit the pan inside the cube. To make the hole similar to
the pan I used a modifier called “Boolean”. Boolean modifier > Select Difference > Operand
Type - (Object) > Object - (Select “Pan model”) > Solver Type - (Exact) Finally, I applied the
modifier and the exact hole like the pan model was created. Then the pillar model, pillar
models are just the cube mesh with some modification. I UV unwrapped the model and
applied cement texture onto it. I placed all 6 pillar models around the four corner of the base
model. Figure 4.2.3: Toilet Pillars Next step is the fence model. Plane mesh was used to
model the tin fence. In the edit model I added few loop cuts, then I move the edges a little
bit. CTRL+A select all edges, then CTRL+B to bevel the edges. For texturing, I used
Principled BSDF as it’s a metal object I set metallic all the way to full (1.0), roughness 0.4,
and SATO logo Texture. Finally, I placed all the tin shade around the pillar. And one is on the
top of the toile. Figure 4.2.4: Sato V Trap Toilet Model For the pit house, I modified the
cylinder mesh, selecting the top round face in edit mode, then Press “I” to inset face and “E”
to extrude face inside. Another cylinder mesh was added as the lid of the pit house. Here I
used smart UV unwrapped technique which is a built in function in Blender. Then I used same
cement texture which I used before for pillar. I used Node Wrangler add-on to create this
material. Node Wrangler add-on can add all the nodes together at once. Figure 4.2.5: Pit
House For the ground modeling and texturing, I used cube mesh, subdivide it few times in
edit mode. After UV unwrapping I started texturing the model and by using the Node
Wrangler add-on it got easier to add texture properly on the ground. Figure 4.2.6: Ground
Texture Finally, for the ground, I added grass model and spread it all over the ground. It is
not easy to spread grasses one by one on the ground. I used here “Blender Particle System”.
It’s so powerful tool, It’s mainly use to create particle in a scene. Particle System properties
> Hair > Render > Collection > Instance Collection “Grass”. Particle System properties, Hair:
Advanced - checked Emission Number: 5000 Hair Length: 5m Segments: 5 Source Emit
from: Faces Distribution: Jittered Rotation: Global Y Render Scale: 0.250 Figure 4.2.7:
Ground Grass I have removed grass particles in front of the toilet model by using “Weight
Paint” tool. Weight Paint tool helps to increase or decrease density of particles in a specific
area. Particle System properties > Hair > Vertex Group > Density - group collection. For tub
and cement mixer modeling, I used cylinder and plane mesh. In edit mode, I modified the
meshes to create the actual shape of the model. Figure 4.2.8: Tub and Cement Mixer Model I
created a box model for packaging the “SATO V Trap”. A box texture was provided from the
client. I followed the measurement of the texture and created the box model. Then I unwrap
the box and place the texture onto it. Figure 4.2.9: SATO Box Texture Figure 4.2.10: SATO
Box Model Figure 4.2.11: SATO Box Model with Texture Environment Design: For
environment design, I used some pre made tree models and placed those randomly behind
the main toilet model. Figure 4.2.12: Random Tree Model Adding sky and the cloud in the
environment scene was quite complicated. In the world shader editor I used very complex
shader nodes to create the sky and the cloud. By using mapping node of that shader nodes,
it’s possible to animate the cloud randomly. I animated the cloud using “X” rotation of the
mapping node. Figure 4.2.13: Dynamic Sky and Cloud Shader Node Animation: First part of
animation was to mixing the cement and water in the tub. I took a mesh circle and resided it
so that is fit inside the tub model. Then I added a subdivision modifier, then displace modifier
with the texture of cloud and finally vertex weight proximity modifier. Displace modifier
created a displacement to the mesh object. In weight paint mode I created a vertex group.
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Then in displace modifier > vertex group > select group. vertex weight proximity modifier >
vertex group > select group. As influencer a sphere was used. In vertex weight proximity
modifier > target object (select that sphere). And finally a curve circle to animate the sphere
around the tub, which is path animation using the Follow Path constraint. Here the sphere
worked an influencer to simulated the cement and the mesh circle was used as a cement.
Sphere move around the tub and the circle mesh displace randomly, and it looks like cement
mixing animation. Figure 4.2.14: Cement Mixing For the handle (cement mixer) animation I
used another curve circle. Then I applied Follow Path constraint on the handle. And as the
target object that curve circle. Here I applied path animation technique. Figure 4.2.15:
Follow Path Constraint Most of the animation was camera animation and object
location/rotation animation using the key frames. Here I used 6 different cameras to
visualize the product from different. In front of the cameras object was moving and rotating,
I used key frames to make those object animated. The entire animation was 1760 frames
with 30 fps. Figure 4.2.16: Sato V Trap and Camera Animation The toiler tin fence and pillar
animation. Here the pillars and fences was moving toward “Z” axis and placing exact same
position it should be. The toilet door opened at the last scene. It was rotation animation. The
6th camera was moving following the direction of the object. The Camera was in zoom in
position, then it zooms out the scene. Figure 4.2.17: Toilet and Background Box opening
animation, at first I rigged the box. I took a single bone armature. In edit mode I duplicated
the bone three times and placed it four different side. After that I parent the box with the
bone (Armature Deform > with Empty Groups). Next by selecting the box in the edit mode I
created four vertex group and assign the four bones with it. Now it’s ready for animation.
Figure 4.2.18: Box Cover Rigging For animating the cover of the box, in the pose mode I
used rotation and added key frame each bone separately. The objects inside the box was
animated by adding key frame on the location properties and camera animation was added
from different angles by using location, rotation. Simulation: In the entire process of the
project there are two simulation part, water falling in the tub and pit filling. Here I am going
to explain about the water falling first. Water Falling Simulation- At first I created a sphere
near the jug mouth. Sphere dimension was around 0.01425 meter XYZ. I rename it water
flow. By selecting the sphere, in the physics properties I choose “Fluid” option as it is a water
simulation. Next I created a cube as domain object. Without domain fluid simulation will not
work. For the cube I again choose “Fluid” option in the physics properties. As an “Effector” I
use the tub model as all the water will take place inside it. By selecting the tub, I again
choose the “Fluid” option. Sphere settings, Fluid Type > Flow Flow Type > Liquid Flow
Behavior > Inflow Flow Source > Mesh Initial Velocity Y Axis = 0.1 m/s Cube/Domain 
settings, Fluid Type > Domain Domain Type > Liquid Resolution Division = 64 Mesh Upres
Factor = 2 Mesh Particle Radius 2.0 In the Cache option, Start - End frame 1 -175 Type > All
Tub/Effector settings, Fluid Type > Effector Effector Type > Collision Surface Thickness = 2.5
Use Effector = Checked Figure 4.2.19: Tub Water Flow At the frame 54 “Use Flow” option, I
unchecked and added a key frame on it. So that water can’t start flowing till frame 54. At
frame 56, I checked and added a key frame on “Use Flow” option. So that water start
flowing. I applied location and rotation key frame on the jug at frame 15 to 55. So that, it
looks like water is falling from the jug. At 160 frame “Use Flow” option was checked and at
frame 164 I unchecked the “Use Flow” option and added a key frame so that water stops
flowing. I baked all the simulation and created a cache file of it from frame 1 to 175. Pit
Filling Simulation - About the pit filling simulation, it is almost similar like the previous one. I
created a sphere at the end of the drainage pipe, dimension 0.044941 m at XYZ axis. Then I
created a cube as the domain of the fluid and concrete pit as the effector. From the physics
properties I choose “Fluid” option for these three different object as before. For the sphere
option is “Flow”. For the cube option is “Domain” and for the pit cylinder option is “Effector”. I
adjust few more settings before the final simulation. Figure 4.2.20: Pit Filling Simulation This
simulation starts from frame 660 and ended at frame 850. I checked and unchecked few
times and added key frames on the “Use Flow” option so that fluid drops randomly inside the
pit cylinder. I baked all the simulation and created a cache file of it from frame 660 to 850.
Sphere settings, Fluid Type > Flow Flow Type > Liquid Flow Behavior > Inflow Flow Source >
Mesh Initial Velocity XYZ Axis = 0.0 m/s Cube/Domain settings, Fluid Type > Domain Domain
Type > Liquid Resolution Division = 64 Mesh Upres Factor = 2 Mesh Particle Radius 2.0 In
the Cache option, Start - End frame 660 - 850 Type > All Tub/Effector settings, Fluid Type >
Effector Effector Type > Collision Surface Thickness = 1.0 Sampling Substeps = 2 Use
Effector = Checked Lighting and Rendering: The dynamic shader node already has sky light
and I added a sun light to make the scene look more natural and realistic. Sun Color: White
Strength: 2.0 Angle: 0.526 degree Max Bounces: 1024 Cast Shadow: checked Render
Engine: Cycles Device: GPU Compute Render Sampling, Noise Threshold: .009 Max Samples:
4096 Time Limit: 2.4 min Denoise: checked Denoiser: Optix Passes: Albedo and Normal
Render Resolution: 1920px X 1080px Frame Rate: 30 fps Frame Range: 1 to 1760 frames
Render Output: PNG image sequence Figure 4.2.21: Sato V Trap Render Image 1 Figure
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4.2.22: Sato V Trap Render Image 2 Figure 4.2.23: Sato V Trap Render Image 3 Editing and
Final Output: I render out the scene as image sequence and after that there were some
requirement of adding some text and information, logo animation on the “Sato V Trap
installation process”. After Effects is the best software for post processing, compositing and
motion graphics work. At first I animated the “SATO LOGO” with simple keyframe animation.
I mask the logo layer with “Ellipse Tool”. Mask feather was 409 to look the mask very soft. I
animated the logo with mask. Two different color was required for the text, #000C68 and
#387EE0. I added “Drop Shadow” effects of every text and logo. “Sofia Pro Regular” font
was used for the text. Drop Shadow effects, Shadow color: #000000 Opacity: 30% Distance:
5.0 Softness: 15 Figure 4.2.24: SATO Logo Figure 4.2.25: Sato 324 Universal V Trap Logo
Motion tracking was used to display two information of the product. As the camera is moving
around the Sato V Trap, I used After Effects build-in motion tracking system to track a
particular part of the model. Here motion tracking was “X and Y” location on a null layer, and
text information layer was parented with the null layer. Two different text information was
tracked with Sato V Trap, “Efficient Grip” and “Farm Lock System”. “Sofia Pro Regular” font
was used for the text. Figure 4.2.26: Text Motion Track 1 Figure 4.2.27: Text Motion Track 2 I
animated the “SATO” icon by using the “Stroke” effects. This particular effect helps to
animate lines and it looks like some kind of drawing. Figure 4.2.28: Sato Icon A background
with specific pattern was use for the entire video. Background color was #F7F6ED. Figure
4.2.29: Pattern Figure 4.2.30: Background with Pattern Other text animation was added key-
framing position and opacity several times. Sometimes layer mask added on the text layer
for the purpose of position animation. “Specialty of Sato V Trap”, there were some point
explained in this part. To animate those point, I applied “3D Fly Down and Unfold” effect, so
that those points visible on the screen one by one. Figure 4.2.31: Point Text Animation An
appropriate background music was added to the final scene. A perfect background music can
subtly set the mood and maintain attention. Composition setting, Width - 1920 px Height -
1080 px Frame Rate - 30 fps Final render was exported as a video footage, “SATO V-trap
Installation Process”. 4.3 Story Based 3D Animation (Story Based Short CG Animation “Alien:
First Kill”) Science think, an alien refers to a hypothetical or extraterrestrial life form that
may exist outside of our own planet, Earth. This can include any form of life, such as a
single-celled organism, a complex animal, or even an intelligent being like human. The
popularization of the idea of aliens took off in the 20th century, with the advent of science
fiction and the rise of the space age. The first-ever UFO sighting was reported in 1947, and
since then the topic has become a staple of popular culture, with countless books, movies,
and TV shows depicting aliens and extraterrestrial life. A film name "Alien" was released in
1979, it's a science fiction horror film directed by Ridley Scott and starring Sigourney Weaver
, Tom Skerritt, John Hurt, and Ian Holm. The film is set in the future and follows the crew of
the commercial spaceship Nostromo as they respond to a distress call from an alien planet.
Upon landing on the planet, they encounter a mysterious and hostile alien creature that
begins to stalk and kill the crew one by one. The film is known for its suspenseful
atmosphere, groundbreaking special effects, and iconic alien design. I created a story based
animated Sci-Fi, horror CG short film, name “Alien: First Kill”. This short animated film is
totally fictional and it's based on a scientific concept. As it is a 3D film, I used 3D software to
complete the project. Blender was mostly used for this project, besides I use 3ds Max for
some modeling, for compositing and editing I used After Effects. Every video or film
production has three major stages, which are, ? Pre-production ? Production ? Post-
production I followed these steps to finish my entire short animated film which took around
four months. Figure 4.3.1: Sci-Fi Animated Short Film Production Pipeline Pre-production:
Story Idea: At pre-production stage at first I had to think about the animation story. Because
without story it’s not possible to make a CG short film. So, after brainstorming I got a story
idea, which I shared with my mentor of internship, name Shibli Zaman Annan. Then we
discussed about the story in detailed. We fixed the story and wrote down it. The Title of this
short animated film is Alien: First Kill. Story Writing: Year 2071. Bangladesh has become
advanced in technology, smarter than ever. It’s future and everything is futuristic. Now we
have space administration like NASA, which is Daffodil Space Research Association.
Numerous spaceships go outer space and different planet from here for the purpose of
research and innovation. 23 January around 11:25 pm, place Ashulia subway station, Dhaka.
it's almost a quiet place, because it's almost mid-night. three or four people are waiting for
train to arrive. Time is running, tik tik. 11:30 pm, a train arrived in the station. A night time
construction worker then gets down from the train, he actually works on Daffodil Space
Research Association construction site. He is already late for his work. So, he starts walking
faster. Then he reached his destination Daffodil Space Research Association. The name of the
worker guy is Jahid Ali. He then looked at the sky, a spaceship was flying over his head and
some drones was flying around. It’s a restricted area. So, for verification he reached near the
Gate no. 3. After scanning he entered through the gate. He was seven minutes late for work.
Other workers were doing their job. Everything was perfect just like the other days. He was
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walking and looking around. Then he reached near an elevator. By using the elevator, he
reached at the top level. But when the elevator stopped at its position, he noticed something
wrong going on this place. Everything was quiet. He starts walking forward slowly. Suddenly,
he thinks he saw something little far. So, he stopped there and turned right. Nothing was
there, but he heard some unusual sound. So, he again looked his right side. He saw two
workers was running far away. Then he quickly turned left and got shocked. He started
Breathing fast and lost his ability to move from there. An alien creature was looking at him
and it starts terrible screams. Then it attacked. Before he knowing anything, he fell down
and died. Through this killing, aliens began to spread on earth. This is the story of Alien:
First Kill. Scripting: Scripting is a crucial aspect of a film production. Scripting refers to the
process of writing a screenplay or script for the film. The script outlines the story, characters,
and dialogue for the film, and serves as a blueprint for the production team to follow during
filming. To complete my whole animation process, I followed a script for creating scenes. In
the story I have two scenes with various shots. 1) Scene 1: A train station, which is Ashulia
Subway Train Station. First, some camera shots will take place from different angles of the
station. First shot, a camera is moving forward through the platform. Second camera shot,
sci-fi globe hologram is rotating, Moon and Mars video is displaying in the side monitor of the
platform. Third camera shot, escalator is moving upward and downward, light flickering.
Fourth camera shot, station billboard where station name is written. Fifth camera shot, ATM
machine’s close shot. Sixth camera shot, two top monitors showing a lava planet and sun,
then camera focus on top digital clock of the station where time is changing from 11:25 pm
to 11:26 pm. Seventh camera shot, camera is panning left to right where two top monitors
and escalator is in focus. Eighth camera shot, two men is waiting and another man began to
sit on the station chair, then a train entered the station. Ninth camera shot, this shot will be
the front part of the train in where the train stops at the station. Tenth camera shot, side
view of the train and door is opening, a worker starts to coming out from the train. Eleventh
and twelfth camera shots, where camera switches in between, front and side view of
construction worker where he is coming out from the train. Thirteenth camera shot, here
camera will work as First-person view (FPV). First person view is what a person see. It's an
electronic reproduction of the visual information captured by a camera. So, here the camera
starts walking as a person toward the escalator and train starts leaving the station. This is
the last shot of “Scene 1”. 2) Scene 2: Camera shot one, camera will pan left to right and will
capture the lower environment of “Daffodil Space Research Association”. Camera shot two
and three, second camera will capture the upper environment of “DSRA” and third camera
will capture the upper research houses closely. Fourth and final camera, fourth camera will
work as First-person view, it will act like a person. So, at first the camera person will look up
from the outside of the DSRA gate-3 and a spaceship will fly over his head and some drones
will fly around. Then the camera or the person (worker) will start walking toward the DSRA
gate-3. A scanner machine will scan him with a laser light. Then the gate will open. Every
single mechanical iron part of the gate will rotate to open the gate. After that he will pass
through the gate. A worker will pass through. After some steps he will look top left side, a
space shuttle will be there and then he will walk through the passing bridge and he will look
top right side. There two astronauts will be gossiping. Then he will walk faster toward the
elevator and in this time he will look around. Near the elevator another worker will pass
through him. Next he will ride the elevator and will start to go up. After a few seconds he will
reach at the top and elevator will stop there. Then he will start walking and at that moment
First-person view camera will look up a little. After some steps he will stop, because he will
feel he saw something. Then the camera will rotate right, there will be nothing. Next the
camera will rotate more right, there two workers will be running faster. Then he will quickly
turn left and he will see an alien creature. That alien creature will scream very loudly and will
attack the worker that means the FPV camera and he will fall down and die. This will be the
last shot of “Scene 2”. For the entire screenplay, first of all we will show a simple note where
written, “Please use headphones for better sound experience”. After that our DIU and MCT
intro will show. Next “AAVA 3D” and “Racy Blue Animation” logo intro. After that a message
will show on the screen, “Alien. They exist or not we don’t know that yet clearly. But if they
exist, they could be terrible for mankind”. Then the main story scene 1 and scene 2 will play.
After that another message will display, “They just arrived”. And at last the title animation of
the short film “Alien: First Kill” and name text will display. Production: Modeling and
Texturing: At the production stage at first I start modeling the necessary 3D models and
props for the train station. I start modeling base of the platform. Every modeling should start
with a reference image. I followed two reference images to design the train station. Figure
4.3.2: Train Station Reference Image 1 Figure 4.3.3: Train Station Reference Image 2 I
started modeling the station base following the reference image 1. I added a cube and scaled
and modified it. So that it looks like a base of the platform. Then I added a loop-cut in the
middle and deleted half of its side and applied a “Mirror” modifier. “Mirror” modifier helps to
create same geometry at the opposite side. So that if you work on side of the geometry it
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will affect the other one. Step by step I developed the platform base. Next I took another
cube and resize it. I applied “Wireframe” and “Array” modifier. I placed this grill model at the
corner side of the platform. I duplicate it and place the second one another side. For the
platform railing, I took a cylinder mesh and made it look like a pipe, applied “Simple Deform”
modifier and choose “Bend” option to make the pipe bend. To make multiple copy of it I used
“Array” modifier. Then I placed the railing two side of the platform. Figure 4.3.4: Platform
Base model For texturing the platform, I used mixed texture material. In the middle part I
use Blender brick texture and Marble texture from third-party. Figure 4.3.5: Platform Marble
Texture At the corner side of the platform, I used yellow metallic dot texture. Figure 4.3.6:
Platform Yellow Metallic Dot Texture Figure 4.3.7: Final Shading of the Platform ©Daffodil
International University This is the final shading of the platform. I used metallic yellow color
for the railing and black metallic color for the ground grill. Figure 4.3.8: Station Chair Model I
modeled the station chair corner area in 3ds Max using spline. It’s kind of easy process in
3ds Max to create curves. The inner mesh is plane, and I applied “Wireframe” modifier to
make it look like a net. Stands that is holding the chairs, was made using the cubes. Figure
4.3.9: Station Chair Shading For shading the chair and chair stand model I used procedural
texture node of blender. Here I used Principled BSDF, Bump node, Noise Texture, Mapping
and Texture Coordinate, Mix and Layer Weight node. In Mix node color was Black and White.
Metallic percentage 1.0, Roughness 0.3, Clearcoat 1.0, Clearcoat Roughness 0.5. Figure
4.3.10: Station Billboard and Monitors Model For modeling the station billboard and the
monitors I used cube mesh. I resized those in the edit mode. I used inset, bevel, extrude
and loopcuts to make the model perfect as needed. Figure 4.3.11: Station Billboard and
Monitors Textures For monitors display I used some image and video textures. Image texture
was created by using Adobe Illustrator and video texture was created by using After Effects.
Planet animation was made by using “Earth Orb” plugin in After Effects. Billboard animation
was made by using texts and shapes. Figure 4.3.12: Station Billboard and Monitors Final
Shading Monitors outer area and stands textures were made by using procedural texture
nodes, which are Principled BSDF, Bump node, Noise Texture, Displacement, Mapping and
Texture Coordinate, Mix and Layer Weight node. Figure 4.3.13: Rail Line Model Rail line
model and its lower base was made using the cube mesh. I modified it in the edit mode of
the blender using the extrude, inset, bevel and loopcuts. Then I created a single lower base
of the rail line and applied “Array” modifier to make multiple copies of it. Line holder was
created by using the plane and cylinder mesh, and “Array” modifier also applied on it to
make multiple copies. Figure 4.3.14: Rail Line Shading Figure 4.3.15: Rail Line Wood Texture
For texturing the rail line base, I used PBR wood texture. I UV unwrapped the base model
and applied the texture properly onto the model. Figure 4.3.16: Rail Line Texture For shading
the rail line, I used here procedural texture node, which are Principled BSDF, Bump node,
Noise Texture, Mapping and Texture Coordinate, Mix and Layer Weight node. Mix node color
was #1C1100 and #000000. Layer Weight blend was 0.5. Figure 4.3.17: Escalator Stair
Model At first I modeled the escalator stairs using the cube mesh. I resized it and in the edit
mode, by selecting lower edge I applied bevel and loopcuts. Next in the middle area I applied
around 32 loopcuts and then I selected one after one faces by pressing “Shift” and “Alt” key.
Then I extrude the faces. In the next steps I applied “Array” modifier to make 17 copies.
Array > Fixed Count > check Constant Offset > Direction Y = 0.315 m & Direction Z = -0.24
m. Figure 4.3.18: Escalator Model For the lower base of the escalator, I used plane mesh and
resized it in the edit mode according to the stair size. Then I applied “Solidify” modifier. I
deleted the inner part where the moving stairs placed. For the handrail, I used circle mesh
and removed half of it. By duplication it I placed one in the top side of the escalator and
another in the bottom side. I connected those to by pressing “F” key in the edit mode. Next I
applied “Solidify” modifier. After extruding, inset few more times I made the glass and the
handle parts of the handrail. I detached the handle from the glass part. By duplicating those
I placed those on the opposite side of the escalator. This is how I modeled the escalator.
Figure 4.3.19: Escalator Shading Figure 4.3.20: Escalator Handrail Shading To make the
handrail look like glossy rubber, I used here procedural shader node. Mix Shader, Fresnel,
Glossy BSDF, Principled BSDF, Bump, Noise Texture, Mapping and Texture Coordinate was
used to make the glossy rubber texture. Figure 4.3.21: Escalator Stair Shading For shading
the escalator stairs, I used here, Principled BSDF, Mix, Bump, Noise Texture, Mapping,
Texture Coordinate. Mix color1 #000000 & color2 #987D23, Metallic 1.0, Roughness 0.605,
Clearcoat 1.0 & Clearcoat Roughness 0.5. Figure 4.3.22: Escalator Glass Shading For shading
the side glass of handrail, here I used Principled BSDF node, where Metallic 0.0, Roughness
0.15, Transmission up to 1.0. One thing to mention here, for the light that is glowing side of
the handrail, I used Emission shader node for that, where Strength is 7.0 and color #49C0FF.
Figure 4.3.23: Elevator Modeling For modeling the elevator, I used a reference image from
the web. At first I took cube mesh and by observing the reference I made the elevator
model. Figure 4.3.24: Elevator Reference Image Figure 4.3.25: Elevator Shading For
texturing the elevator, procedural texture node Principled BSDF, Mix and Layer Weight,
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Bump, Noise Texture, Mapping and Texture Coordinate was used. Mix color1 #9B9B9B &
color2 #AEAEAE, Bump Strength 0.01 & Distance 19.5, Noise Scale 20.0 & Detail 50.0,
Mapping Scale XYZ 15.0, Layer Weight blend 0.5. Figure 4.3.26: Station Pipe and Cable
Models I modeled the cables and pipes from cylinder mesh in the edit mode. I also added
cube as cable holders. Procedural texture node was used for texturing the pipes and cables.
Figure 4.3.27: Transparent Monitors ©Daffodil International University For decorating the
station, I created some transparent display. I used video and image textures on the
transparent glass material. Earth, Sun, Saturn and Lava planet animation was created by
using After Effects “Orb” plug-in. In the image texture node, I added the video files so that
the videos appear on the transparent glass monitor. On the other side Ashulia Subway
Station texture was created by using Illustrator. Figure 4.3.28: ATM Machine Model For
modeling the ATM machine I took a reference image. The monitor was designed following the
reference image. At first I took a mesh plane. In the edit mode I extrude, scaled, inset it as I
needed. I applied a “Solidify” modifier on it. When the monitor model it ready I UV
unwrapped it. Second part was modeling the lower box of the ATM machine. I used mesh
cube for that. I added some detail on the model to give it more futuristic look. Figure 4.3.29:
ATM Machine Monitor Reference Figure 4.3.30: ATM Machine Final Render I used animated
video and image textures for the ATM monitor. Futuristic animated data analysis video was
created using Adobe Illustrator and After Effects. I placed those onto the transparent glass
by using Image texture node of blender. I used the alpha channel to remove the black
background of “ATM System” texture. The glow part of the machine was applied using
“Emission Shader” node. Figure 4.3.31: ATM Machine Video and Image Textures Figure
4.3.32: Recycle Bin Model Recycle bin model, I took a mesh cylinder for this. In the edit
mode I applied some extrude, inset, bevel, loopcuts to created it from cylinder mesh. I also
applied “Shade Smooth” to remove the sharp edges. I also made a recycle bin logo which I
placed in front of the dustbin. Figure 4.3.33: Recycle Bin Shading For texturing the recycle
bin I used procedural texture node. Recycle bin logo, “Emission” shader node was used, color
#19A319 and Strength 6.0. Figure 4.3.34: Holo Earth Model Modeling the Holo-Earth globe
was kind of complex. At first I took a UV Sphere mesh and I started applying procedural
texture node to make it looks like a Holo-Earth. Mix Shader, Transparent BSDF, ColorRamp,
Dot Product, Bevel, Geometry, Emission, Math node, Image Texture node, Separate XYZ
node and Noise Texture node was used here. Figure 4.3.35: Holo Earth Projector Model I
created Holo Earth projector model from the UV sphere mesh. I applied “Subdivision
Surface” modifier to give more vertex on it. After that in the edit mode I converted the UV
sphere into a Holo projector. Finally, I applied procedural and emission shader to make it
more realistic looking holo projector. The light beam that is projecting from the holo
projector is actually spot light. Spot light, color #33CCFD, power 1043.75W, Radius 0.05m,
Max bounces 1024, spot size 65°, Blend 0.8, strength 8.0. Figure 4.3.36: Earth Map
Projector Earth map was created using the Blenders very complex geometry node. This map
actually was a vector. From Illustrator I saved it as a “.SVG” file. Then I imported the “.SVG”
file into Blender. At first I converted the “.SVG” file to mesh. So it became 3D earth map.
After that, in the geometry node panel I setup the nodes to make it looks like this. Join
Geometry, Set Material, Instance on Points, Ico Sphere, Curve to Mesh, Curve Circle, Set
Position, Realize Instances, Endpoint Selection, Object Info, Mesh to Points, Curve Line, Less
Than, Geometry Proximity, Grid and Mesh Line, these were used for this Earth map projector.
I setup one by one node to gain this result. Figure 4.3.37: Earth Map Geometry Node Figure
4.3.38: Station CC Camera Model I Modeled CC camera as a props of the station. By
modifying plane, cube, cylinder meshes and line curve I made the CC camera. Figure 4.3.39:
Station CC Camera Texture Texturing the CC camera, I used procedural texture of blender.
For camera lens texture, Principled BSDF, Glossy BSDF, Mix Shader was used. Principled
BSDF, Metallic 0.0, Transmission 1.0, Roughness 0.0, IOR 1.5. Glossy BSDF, Roughness 0.0.
Mix Shader, Fec 0.243. Figure 4.3.40: Station Ground model For the station ground, I took
mesh plane and applied PBR material texture onto it to make it more realistic. In the shader
editor mode, by pressing ctrl+shift+T, I choose all the PBR texture. I adjusted the XY
mapping to fit it with the plane. Bump and displacement map also added with it. Figure
4.3.41: Station Ground PBR Texture Subway station without wall is not possible, for making
the wall around the station I used here mesh plane, cube and cylinder. For texturing the
walls, I used PBR texture and procedural texture nodes. Figure 4.3.42: Station Wall Model
Figure 4.3.43: Station Wall PBR Texture After modeling and texturing the station I switched
to the Daffodil Space Research Association to modeling and texturing the necessary objects
and props for this scene. I started modeling with the main gate. Figure 4.3.44: Gate Model
To make this Sci-Fi looking gate at first I did some study, observed some related 3D model.
Finally, I got an idea to make it. Using the cube mesh and modifying it in the edit mode I
made this 3D Sci-Fi looking gate. Figure 4.3.45: Gate Metallic Grills Most interesting part is
gate metallic grills. At first I modeled one part of it. By using the “Array” modifier I multiply
this 17 times. And next I duplicated and mirrored it for the opposite side. When I will



animate it, each grill will open individually. Figure 4.3.46: Gate Shading For texturing the
gate, here procedural texture node was used. I changed the color to make a variation in
between the objects. cwDirtyUp001 - Amount 1.0, Scale 0.4, Dirt Height 0.15, Bump -
Strength 0.02, Distance 19.5, Noise Texture - Roughness 0.5, Detail 50.0, Scale 5.0. Figure
4.3.47: Gate Shader Node Figure 4.3.48: Gate Warning Textures On the gate side I added
two warning message textures, one is “Restricted area” and another is “No smoking zone”. At
first I took two plane meshes and by using the image texture node I placed the warning
textures on the planes meshes. And I placed the planes side by side on the gate wall. Figure
4.3.49: Area Barrier Model and Texture I modeled this area barrier to cover the research
station area. Here “Wireframe” modifier was applied to made the barrier net. Upper pillar and
lower pillar was modeled using the cube mesh. To make a very smooth shape I also used
“Sub-division surface” modifier. I joined all the separate objects pressing “ctrl+J” and applied
“Array” modifier to make multiple copies of it. And for texturing procedural texture node
combination was used here. Figure 4.3.50: Kiosk 3D Model Kiosk 3D model was modeled by
from a reference kiosk model. I followed that model to create the body and the kiosk
monitor. Later I animated the monitor with rotation animation. Figure 4.3.51: Kiosk
Reference Model Figure 4.3.52: UI Animated Texture for Kiosk Display According to the
necessity, I animated this futuristic UI for the kiosk display. I used Adobe Illustrator and
After Effects for this. Next I imported this texture using the Image texture node of Blender. I
UV unwrapped the monitor screen and placed this animated texture properly onto it. Figure
4.3.53: Kiosk Shading Kiosk lower part was textured using the procedural texture node and
for screen Principled BSDF node with transmission 1.0, Roughness .3. Also a laser light
scanner was added here to scan the human character. Principled BSDF, ColorRamp, Scale
Vector, Math node, Noise Texture, Mapping and Texture Coordinate node was used for making
a laser beam. Figure 4.3.54: Research Station Ground Base Model Ground base model of
research station was modeled just using the cube mesh. In the edit mode I extruded and
inset to side. And near the middle of the model I designed some cutting shape by using the
knife tool. Finally, I applied “Array” modifier to make similar copies of it and I placed those so
close to each other, so that is looks like a single base model. I used PBR metallic dot texture
at the top side and also procedural texture node around the base cube. Figure 4.3.55:
Research Station Ground Base PBR Texture Figure 4.3.56: Entrance Billboard Model and
Shading ©Daffodil International University This Entrance billboard was really simple
modeling. Here at first I took cube meshes, I resized those to make it look like a pillar and
placed those at the position. Next I modeled the upper and lower billboard. I connected the
billboards with the pillar using cylinder mesh. Actually I bended the cylinder according the
necessity. After I finished modeling I applied procedural textures onto the pillar and
billboard, and also transparent glass texture onto the billboard. Upper billboard texture was
“Daffodil Space Research Association” name plate which I made using the Adobe Illustrator.
And lower billboard texture was “Gate 3” name plate. Figure 4.3.57: Ground and Cliff
Modeling I modeled the ground and cliff for the scene. For the ground at first I took a plane
mesh. I added sub-divide few times in the edit mode to add much more vertex. Then in the
modifier properties I applied “Displace” modifier with strength 0.05 & midlevel 0.5. In the
displace property I added normal map of the PBR texture. Next I took another “Displace”
modifier. In the “Displace” modifier property I applied a cloud texture. Figure 4.3.58: Ground
and Cliff Shading For Modeling the cliff, I took a plane mesh. In the edit mode I made the
plane to look like a simple cliff. Next in the modifier properties I applied “Sub-division
Surface” modifier. “Sub-division” modifier properties, Catmull-Clark > Levels Viewport 3 &
Render 3. Then I switched to the sculpting mode. I sculpt the cliff plane to give it more
detailed look of actual cliff. I Added “Array” modifier for both ground and the cliff to make 2
or 3 copies. Figure 4.3.59: Ground PBR Texture Figure 4.3.60: Cliff PBR Texture For texturing
the ground and cliff model I applied PBR textures. In the shader editor at first I took a new
material. Next by selecting the Principled BSDF node I pressed ctrl+shift+T on the keyboard
and applied all the selected PBR textures on the ground model. In the same way, I applied
another rocky PBR texture on the cliff model. Figure 4.3.61: Research Station CC Camera
Modeling & Texturing I modeled this CC camera by following a reference image. After I
finished my modeling I started texturing it. I actually used procedural texture node for
texturing it. In the modeling process I actually used cylinder, cube and place meshes. For the
camera cable, curve line was used here. It helped to animate the cable next time when I
animated the CC camera. Figure 4.3.62: Research Station CC Camera Reference Image
Figure 4.3.63: Cube Block Modeling and Texturing I modeled this cube block as a barrier of
the space research station. From some cube meshes, in the edit mode by extruding, inset,
bevel, adding loopcuts this model was mode. Then I applied texture on it. Procedural texture
node was used for that. To make multiple copies of it at first I joined all te separate meshes
by selecting those all, then pressing ctrl+J. After that I applied “Array” modifier to make
three copies of it. I placed these three copies one by one top to bottom. Next step, without
duplicating one by one I used Blenders “Collection Instance” option, that made copy meshes



far easier. Figure 4.3.64: Cube Block Collection Instances Figure 4.3.65: Space Viewer
Monitor Modeling and Texturing At first I modeled one monitor. Then I duplicated it three
times. I placed animated video textures of planets, galaxies and stars on the monitor. All the
animated planes and galaxy was animated using After Effects. Using the image texture node,
I applied those textures on the transparent monitor screens. Monitor outer body and stands
was textured by using the procedural texture node of Blender. Figure 4.3.66: Space Viewer
Monitors Animated Textures Figure 4.3.67: Big Dome Model and Shading I created the big
dome model. Here I used cylinder and cube mesh. In edit mode extrude, inset, bevel,
loopcuts was used to modify the dome. I added two stand under the dome as a holder. A big
concrete wall was placed behind the dome. I added round area barrier and a lamp to the top
of the dome. And I also added area barrier two sides to the big concrete wall. I used PBR
texture for the dome, stand and the big concrete wall. Red emission shader node was used
as top lamp. Figure 4.3.68: Big Dome All PBR Textures Figure 4.3.69: Big Grill Model and
Shading From the cube mesh, in the edit mode at first I resized the cube. Next I inset two
side faces and I bridge the face to remove inner face. I added another cube mesh. By
extruding four side I joined four corner with the cube ring. Next I added a plane mesh, sub-
divide it few times and applied a “Wireframe” modifier to make a net inside. I applied PBR
texture on this big grill to make it more realistic. Figure 4.3.70: Big Grill PBR Texture In the
modifier properties, I applied “Array” modifier on the big grill to make multiple copies of it.
It’s an easy way to make copies of an object. Then I placed all the copies of the big grill two
sides of the Daffodil Space Research Association. Figure 4.3.71: Top Base Modeling and
Shading Top base of the space research association, I modeled this base and placed it on the
top of the cliff model. I also added some stand as holder of the base. In front of the model
an elevator stand was placed which was made using the cube mesh. I placed metallic floor
tiles on the top of the base. Railing model added at the side corner. Figure 4.3.72: Top Base
Metallic Tiles By using the “Array” Modifier I spread all the metallic tiles around the top base.
Top base holder was just some cube meshes with PBR textures. I created one holder and the
I used “Array” modifier to make it multiple copies and then I placed those at the bottom of
the top base. So that, it looks like the stands holding the top base. Figure 4.3.73: Top Base
All PBR Textures For texturing the top base, stand, railing and elevator stand I used PBR
textures and procedural texture node. After modeling one by one I applied textures to the
models by using the Principled BSDF and Image texture node. I applied procedural textures
on some faces of the top base model. Environment Creation and Light Setup: After creating
all the necessary model and texturing those I started creating 3D environment using those
models. First of all, I started with the “Scene 1”, that means the subway train station. I also
collected some 3D models and props as necessity. The Subway Train Station Environment: At
first I placed the base platform in the middle of the station and I placed the ground model
bottom of it that I created. Around the Platform I added wall models. Left and right side
there were two space to place the escalators and the elevator. I placed those there. Next I
put the railway tracks two sides of the platform. Then after resizing the train engine and the
train carriage, I placed those one side onto the railway track, later I animated the train.
Figure 4.3.74: Train Station Environment I placed the Holo Globe 3D model in the middle of
the platform and the earth maps was placed left and right side of the Holo Globe near the
railway track wall. Then I placed the chair models two side of the platform. On the left side,
top of the station chairs, I placed the name billboard model with its pillar. Figure 4.3.75:
Train Station Environment Props Globes left and right side, I placed the side monitors, those
are hanging with the pillars. Cables and electric pipes are placed top left and right side with
the walls and roof. Transparent glass monitors were placed two sides of the escalator which
are on the left and right side of the station. Another two transparent glass monitors were
placed on the top of the railway track wall where train actually passes through. I placed four
ATM machines four side near the escalators. To making the station environment look more
natural I collected some junk props (like cans, papers, trash, packet etc.) from the internet
and placed those corner side and near the pillars. I also added some news-paper on the
ground of the platform. The Subway Train Station Light Setup: Before light setup, I added
environmental fog on the station to give more realism to the scene. At first I took a cube
mesh. I resized it around the station and applied a material node. Next I took Principled
Volume Shade node and connected it with the material output volume. Principles Volume
shader info: Color #C8E4FF, Density 0.025, Emission Strength 0.0, Temperature 1000.0
Figure 4.3.76: Train Station Environmental Fog For light setup, at first I modeled two types
of light. Then I duplicated first one few times and placed those serially on the roof side of the
station. Second type light model was round, I also duplicated those and placed those near
the elevator and escalator roof area. I applied emission shader texture to the light meshes to
make it glow and interact like a light. Emission Strength 15.0 and emission Color #6AB4FF
for both types of light mesh. Next I added Blenders area light with each of the light mesh.
Station area light info: Color #C8E4FF, Power - 20W, Shape - Square, Size - 1m, Max
Bounces - 1024, Cast Shadow and Multiple Importance - checked, Spread - 140° Figure



4.3.77: Train Station Light Setup 1 Figure 4.3.78: Train Station Light Setup 2 Daffodil Space
Research Association Environment: After the train station environment, I started working on
the Daffodil Space Research Association environment. I started placing all the models one by
one at its position to create the second scene. At first I placed the metallic base model at the
middle position. By using the “Array” modifier I created same copies of the metallic base and
placed those side by side. Then I duplicated it one time and in the edit mode by selecting
and moving the corner vertex I made it bigger. And then I put that model on the opposite
side of the first one. I placed a bridge model to made a communication in between these
base model. On the first base model I placed the metallic gate and the barriers that I
created. I placed the CC camera on the top of the gate wall. By using collection instance I
duplicated the CC camera and placed it on the other sides wall of the gate. Figure 4.3.79:
DSRA Environment 1 Next I placed the kiosk 3D model that I created as a scanner near the
main gate, on the right side. I placed the name billboard model near the gate but back side
of the barrier. I placed the space monitors serially in front of the gate barrier. I also modeled
I parking spot near the main gate. The 3D blocks that I modeled, was placed along the Y axis
near the gate, at the end of the space station and two sides of the top base. The ground
model was placed at the ground of all metallic base model. And I placed the cliff model at the
end of the second metallic base along X axis. I placed the dome model close to the cliff
model. By using the collection instance, I duplicated the dome model entirely and placed it
opposite side of the first dome model, close to the cliff. The big grill model, at first I made
multiple copied of it using the “Array” modifier. I duplicated is into two. First one I placed left
side along to the ground and second one I placed right side along the ground. Figure 4.3.80:
DSRA Environment 2 I collected some 3D models to fill up the environment. I tried to make
the entire environment look like very futuristic. At first I collected a space shuttle 3D model.
I changed the outer texture of the space shuttle and replace it with our Bangladeshi flag tag
and Daffodil logo. Then I placed the entire space shuttle 3D model on a 3D base model to
the left corner of the scene. Figure 4.3.81: Space Shuttle 3D Model with BD Flag and Daffodil
Logo I collected a tower and I applied metallic material on it. Then I duplicated it three times
and place those four tower models around the space shuttle model. The top base that I
modeled, I placed it on the top of the cliff model. Top base is the main point of the entire
scene. I collected three construction block models and placed those on the back side of the
top base model. And some of the construction block models were placed two sides of the
lower base. I modeled some railing and placed those at corner sides of the metallic base and
the top base sides. Figure 4.3.82: Construction Block Model Figure 4.3.83: DSRA
Environment 3 Finally, I collected a group of 3D model with research station LAB, space ship,
sci-fi watch tower and some sci-fi props. Two big research station LAB were placed at the
lower base near the space shuttle model. Other LABs I placed on the top base model. I
designed the scene as necessity for the animation. Some sci-fi props (generators, sci-fi track,
robot model, drone model, power house etc.) were placed to decorate the scene properly.
Daffodil Space Research Association Light Setup: I took a cube mesh and resized it according
to the entire DSRA scene. In the shader editor mode, I applied Principled Volume node to
created environmental fog to the scene. Principles Volume shader info: Color #95B7BF,
Density 0.002, Emission Strength 0.0, Temperature 1000.0 Figure 4.3.84: DSRA
Environmental Fog I added a HDR environment texture with the world shader to create
environmental light to the scene. World shader info: World Output > Mix Shader > Light Path
(Is Camera Ray) to Fac, Background Strength 0.2 and Color to Environment Texture
(cinema_lobby_2k.hdr) to Shader 1, Background Strength 0.2 and Color # F3139 to Shader
2. Figure 4.3.85: DSRA World Shader Node Setup Figure 4.3.86: DSRA World HDR Map For
light setup, I used some 3D models of stand lamps and light projectors. At first I modeled a
stand lamp and a light projector. I also collected two light stand and light projector. I applied
procedural texture node for texturing the light models and some texture was baked before.
Stand light 1 info: Light type - Area, Color - #86C6E7, Power - 1000W, Shape - Disk, Size -
1m, Spread - 25°, Light Bulb Emission Strength - 30.0. Stand light 2 info: Light type - Area,
Color - #86C6E7, Power - 1000W, Shape - Rectangle, Size - X (0.66m) & Y (0.42m), Spread
- 40°, Light Bulb Emission Strength - 12.0. Spot light projector 1 info: Light type - Area,
Color - #86C6E7, Power - 5000W, Shape - Rectangle, Size - X (0.9m) & Y (0.69m), Spread -
120°, Light Bulb Emission Strength - 150.0. Spot light projector 2 info: Light type - Area,
Color - #86C6E7, Power - 5000W, Shape - Rectangle, Size - X (1.15m) & Y (1m), Spread -
150°, Light Bulb Emission Strength - 150.0. I duplicated the stand light and the spot light
projector, and placed those around the area. Spot lights were placed two sides of the cliff
stand and around the big domes. Two spot light was projected two sides of the space shuttle.
Stand lights were placed along the ground, on the metallic base model and on the top base
model. Some area lights were placed around the four side of the entire scene to create
environment glow of light. Environment glow light info: Light type - Area, Color - #86C6E7,
Power - 350000W, Shape - Rectangle, Size - X (8m) & Y (33.4m), Spread - 140°, Figure
4.3.87: DSRA Stand Lights and Spot Lights I modeled some cube lights and placed those



inside the watch tower and the research LABs. I applied “Array” modifier to make one copy to
multiple copies so that I could cover the entire LAB rooms with those lights. I used emission
shader node to make those glow. Cube lights info: Shader node - Emission shader, Color -
#70E77D & #3FB4E7, Strength - 12.0 Figure 4.3.88: DSRA LAB Rooms Emission Lights
Rigging and Character Animation: Rigging and character animation was done by using
Blender “Rigify” addon and mixamo character animation. At first I added two characters and
they are sitting on the station chair. They have some motion animation. Here I collected
those character armatures and the character meshes with sitting animation from the mixamo
website. I imported these characters into the scene and fixed the texture properly. Figure
4.3.89: Sitting Characters 1 Next I collected another character and two animated armatures.
One animation in stand to sit, another sitting idle animation. I imported them all into the
scene. At first I fixed the distorted texture. Here I have to merge two armature animation.
By placing these two armature side by side I switched to the non-linear animation tab. First I
renamed these two armatures. Then, select two armatures > press “push down action” to
save script > by selecting the first armature “add > add action script” > select the second
script. Next, press N. On the strip tab, set Blending mode to combine and check Auto Blend
in/out. Figure 4.3.90: Sitting Character 2 Next, I collected an animated walking character
from mixamo. I imported it onto the scene and at first I fixed the texture of it. I moved the
baked key-frames position where I needed. I positioned the character on the platform as he
is walking. Figure 4.3.91: Station Walking Character The main character, the main character
of the story is a construction worker. I collected the worker model from mixamo. I used
“Rigify” add-on and mixamo animation to rig and animate the main character. At first I
attached a futuristic watch model with the character’s hand. It moves along with the
character. To do this job I followed few steps. First of all, I took a single bone. I positioned
the bone and the watch model around the hand by using rotation and position along the XYZ
axis. Next, I selected the watch first and then the bone by pressing shift key. Next, I pressed
ctrl+p > with empty groups. And then, by selecting the bone in the object constraint
properties select “Child of” constraint. Next, Target = worker’s armature, Bone =
mixamorig1_LeftForeArm, click “Set Inverse” button. The watch was ready to move along
with the hand. Figure 4.3.92: Rigging the Watch Model with the Character Next step of main
character animation was character getting down from the train. For that I collected three
animation model of pose from mixamo. I adjust the bone animation with the “Rigify” add-on.
Three animation model of pose were standing idle, start walking and stop walking. Next, I
placed those bone animation model side by side. I switched to the non-linear animation tab.
First I renamed these three armature animation model. Then, select three armatures > press
“push down action” to save script > by selecting the first armature “add > add action script”
> select the second script > “add > add action script” > select the third script Next, press N.
On the strip tab, set Blending mode to combine and check Auto Blend in/out. I adjusted
character’s hip position by key-framing it in the non-linear animation tabs edit mode. Figure
4.3.93: Rigging and Animating the Main Character Model Next main character animation step
was character’s hand animation where character looking at the watch face on his hand. To
animate the character hand here I used “Rigify” add-on. Figure 4.3.94: Rigging and
Animating Character’s Hand I rigged and animated the Alien character. That character has
three animated steps, standing idle, screaming and direct attack. At first I rigged the alien
character with “Rigify” add-on. I collected three animation poses from mixamo standing idle,
screaming and attack. In the next steps I combined all the animation poses of the alien
character. I switched to the non-linear animation tab. First I renamed these three animation
poses. Then, select three animation poses > press “push down action” to save script > by
selecting the first armature “add > add action script” > select the second script > “add >
add action script” > select the third script In this method all three animation poses have
combined together with the alien character. Figure 4.3.95: Alien Character Rigging and
Animation In the main story main character (worker) will fall down and die. Here the main
character is worker and we are presenting it as FPV. So, when the alien attacks the main
character actually the FPV falls down which is a camera. So, in the final shot of the
animation, I rigged the camera with an animated armature which will fall down when the
alien attacks. Here I used some simple method to do this. At first I collected the animated
armature from mixamo that will fall down die. I imported it into Blender. When the alien
starts attacking at that key frame I took a single bone. Next, I selected the FPV camera first
and then the bone by pressing shift key. Next, I pressed ctrl+p > with empty groups. And
then, by selecting the bone in the object constraint properties select “Child of” constraint.
Next, Target = Fall down armature, Bone = mixamorig1_HeadTop_End, click “Set Inverse”
button. And the FPV camera will rigged with the Fall down armature animation. Figure
4.3.96: FPV Fall Down Rigging and Animation Simulation: I used simulation technic to give
some motion to the station newspapers. I tried to make the paper moving and flying when
the wind comes. I used here dynamic simulation technic. Figure 4.3.97: Newspaper Flying
Simulation At first I placed some newspapers on the platform. By selecting them all I applied



“Soft Body” physics from the physics properties. Then by pressing ctrl+A on the keyboard, I
took Force Field > Wind & Force Field > Turbulence. Newspaper soft body info: Object
Friction - 0.5, Object Mass - 1kg, Simulation Speed - 1.0, Goal - unchecked, Edges - checked
(Pull 0.5, Push 0.5, Damp 0.5), Self-Collision - checked (Ball Size 0.49m, Stiffness 1.0,
Dampening 0.5). Force Fields - Wind info: Shape - Plane, Strength - 5.0, Flow - 2.0, Affects -
checked (Location, Rotation), Noise Amount - 0.0, Seed - 56, Falloff, Shape (Sphere) & Z
Direction (Both z). Force Fields - Turbulence info: Shape - Point, Strength - 5.0, Size - 0.0,
Flow - 0.0, Affects - checked (Location, Rotation), Noise Amount - 0.0, Seed - 68, Falloff,
Shape (Sphere) & Z Direction (Both z). After all the settings, I applied key-frames on the
wind & turbulence properties. Next, I started baking all the data of the selected newspapers.
And finally the simulation is done. Object and Camera Animation: Here I’m going to explain
about camera animation first. Most of the camera animation was created using location-
rotation key-frame. Train Station Camera Animation: At first I took different shots of the
train station from different angle. I took seven camera shots to the train station. By key-
framing the location- rotation of the cameras, I animated the cameras. Camera setting info
for the shots: Lens Type - Perspective, Focal Length - 27 mm, Lens Unit - Millimeters, Clip
Start - 0.1 m, Clip End - 1000 m, Camera Size - 36 mm, Camera Sensor Fit - Auto. Figure
4.3.98: Train Station Cameras Long shot of the station, pan shot around the globe, tilt up
shot of the escalator, zoom out and focusing shot of the billboard, close-up shot of the ATM
machine, focusing shot of the digital clock and finally the upper angle shot of the trans
display monitor were taken. Here on the on the billboard and on the clock shot camera
wasn’t focus directly. It was actually focus on the background. After few second the
background become blur and the billboard and the clock became on focus. I’m going to
explain this animation. Billboard camera animation info: Lens Type - Perspective, Focal
Length - 25 mm, Lens Unit - Millimeters, Clip Start - 0.1 m, Clip End - 1000 m, Camera Size
- 36 mm, Camera Sensor Fit - Auto. I took an empty object backside of the billboard. From
392 frame I positioned the empty to 416 frame by key-framing it. Next, I checked the
“Depth of Field” of the billboard camera and in the “Focus Object” I selected the empty
object. In that way I made the billboard shot from defocus to focus. I also zoom out the
camera by key-framing it from frame 361 to 540. Billboard camera Depth of Field info:
Aperture, F-stop - 0.2, Ratio - 1.0, Rotation - 0°, Blades - 0. Figure 4.3.99: Station Billboard
Camera Focus Clock camera animation info: Lens Type - Perspective, Focal Length - 50 mm,
©Daffodil International University Lens Unit - Millimeters, Clip Start - 0.1 m, Clip End -
1000m, Camera Size - 36 mm, Camera Sensor Fit - Auto. Similar like the billboard camera, I
took an empty object backside of the clock and near the transparent display. From 344 frame
I positioned the empty to 361 frame by key- framing it. Next, I checked the “Depth of Field”
of the clock camera and in the “Focus Object” I selected the empty object. In that way I
made the clock shot from defocus to focus. I also pan the camera left to right by key-framing
it from frame 279 to 986. Clock camera Depth of Field info: Aperture, F-stop - 1.2, Ratio -
1.0, Rotation - 0°, Blades - 0. Figure 4.3.100: Station Digital Clock Camera Focus There is a
scene where three cameras are switching in between. When the main character (worker) of
the story getting down from the train, at that point I added three cameras to take a long
shot, mid shot and a close up shot. To switching in between cameras, I used here Blenders
bind technic. At first I placed cameras at its position. Then by selecting the first camera at
frame 840 go to the “Timeline” tab, Marker > Bind Camera to Markers. Frames of the first
camera was here from 840 to 933. Second camera frames were 934 to 1044. At frame 934
select the second camera, Timeline tab > Marker > Bind Camera to Markers. At frame 1045
select the third camera, Timeline tab > Marker > Bind Camera to Markers. Third camera
frames were from 1045 to 1120. Figure 4.3.101: Station Cameras Switching Next camera
animation was FPV camera. A camera used here as a First-person view camera. FPV is what
actually a person sees with his/her eyes. By selecting the camera, I pressed “Numpad 0” on
the key board for the camera view. From frame 1070 to 1105 camera was its position and I
added key-frames on the location-rotation XYZ axis. X rotation was 84.6°. From 1105 to
1165 frame camera rotates X axis 42.1° to see the hand- watch. From 1165 to 1200 frame
camera stays at X axis 42.1° and I key-framed it. From 1200 to 1240 frame camera rotate
back to 84.6° and I applied a key-frame at X axis. From 1240 to 1550 frame camera moves
forward at Y axis. I also applied “Noise” modifier on the “X Euler Rotation” to give a natural
feeling that the FPV camera is actually walking. Station FPV camera (The Worker) “Noise”
modifier info: Blend Type - Replace, Scale - 50.0, Strength - 0.1, Phase - 1.0 Figure 4.3.102:
Station FPV Camera (The Worker) Daffodil Space Research Association Camera Animation:
Only four cameras were used to capture this scene. Two cameras were used for taking the
environment shot of DSRA. One camera for taking the long shot of the research LABs and
Final camera was FPV (as main character: Worker). Lower base environment shot, by
positioning and rotating the camera from left to right this shot was taken. Total key-frames
for this shot was 1 to 265. Top base environment shot, total key-frames for this shot was 1
to 120. Long shot for research LAB, total key-frames 121 to 550. These three cameras were



animated by key-framing the location and rotation. DSRA camera animation info: Lens Type -
Perspective, Focal Length - 50 mm, Lens Unit - Millimeters, Clip Start - 0.1 m, Clip End -
1000 m, Camera Size - 36 mm, Camera Sensor Fit - Auto. Figure 4.3.103: DSRA
Environment Camera 1 Figure 4.3.104: DSRA Long Shot & Environment Shot Camera 2
©Daffodil International University Finally, the FPV camera, this camera took 95% shot of the
entire scene. This camera worked here as a person (main character: worker). We can see
most of the scene of the story through his eyes. By key-framing on the location-rotation
many times of the camera I animated it. Key-frames starts from 15 to 2984 frame. I also
used here an add-on, name “Camera Shakify”. “Camera Shakify” add-on provides a
movement to the camera that gives a realistic feel of a person’s movement. Final FPV camera
animation info: Lens Type - Perspective, Focal Length - 40 mm, Lens Unit - Millimeters, Clip
Start - 0.1 m, Clip End - 10000 m, Camera Size - 50 mm, Camera Sensor Fit - Auto. Camera
Shakefy add-on info: Here I used two presets of it, Walk to The Store & Out Car Window.
“Walk to The Store” preset provides the actual feeling of walking just like a person. I keep
the Influence from 0.5 to 0.06 by key-framing it. Scale (1.0), Speed (0.7). “Walk to The
Store” key-frames took place from 54 to 2842. “Out Car Window” preset provides a jerky
motion to the camera. I used this preset to give a jerky feel, when the character sees the
alien. I keep the Influence from 0 to 0.5 and then 0.02 by key-framing it. Scale (1.0), Speed
(1.0). Train Station Objects Animation: In the train station scene, at first I animated the
escalator. Two escalator, one is going up and another is going down. For going up escalator, I
key- framed the Y & Z axis location. At frame 1 (Y 0.315 m) & (Z -0.24 m). At frame 18 (Y
0 m) & (Z 0 m). Next, for Y & Z location I applied “Cycles” modifier to make a continuous
loop. For going down escalator, I key-framed Y & Z axis location. At frame 1 (Y 0 m) & (Z 0
m). At frame 18 (Y 0.315 m) & (Z -0.24 m). It’s the opposite of going up escalator. Next, I
applied “Cycles” modifier on the Y & Z location to make a continuous loop animation. Figure
4.3.105: Train Station Escalator Animation Globe animation, for globe animation I just
applied rotation animation key-frame. At first I linked the holo globe sphere and the spot
light beam with the projector model. Then, I animated the projector. At frame 240 I key-
framed Z rotation 360°. And then on the Z axis rotation I applied “Cycles” modifier to make
a continuous loop animation. Another animation I did here is projector tilt up and tilt down
animation. At first I selected the holo projector. At frame 1 I applied a key-frame on Z
location. Next, at frame 60 I move the Z location little up. Next, at frame 120 I copied the
frame 1 key-frame and paste it here. To make it continuous loop I added a “Cycles” modifier
on Z location. In this way I did the holo globe animation. Figure 4.3.106: Train Station Globe
Animation Train animation, for animating the train at first I took an empty cube. I linked the
train engine and all the train carriages with the empty cube. I placed the train properly on
the railway track but outside of the station. At frame 500 I key-framed the empty cube at Y
location. At frame 820 I moved the train on the Y axis inside the station and placed a key-
frame. In this way I animated the train. Figure 4.3.107: Train Station Train and Train Door
Animation Train door opening animating was an important part. Because after the train door
opens the main character of the story will come out. At frame 860 I applied XYZ Location. At
frame 881 I moved the train door a little at X axis and applied a key-frame. At frame 886 all
the position was same and I applied XYZ location key-frames. At frame 955 I moved the door
at Y location to open it and applied key-frame there. DSRA Objects Animation: In the second
scene, at first I animated the spaceship model and its booster. I took a spaceship model into
a new blender scene. I setup lights in front of the spaceship as headlights. Spaceship
headlight info: Light type - Area, Color - #E0FFFC, Power - 200 W, Shape - Rectangle, Size -
(X 0.28 m) & (Y 0.22 m), (X 0.34 m) & (Y 0.09 m), Spread - 50° & 30° After light setup, I
started modeling and animating the spaceship booster. I took a cylinder mesh and resized it
according to needs. I applied a “Displace” modifier and in the texture properties I choose
clouds (size 0.25, Depth 2 & Nabla 0.03). I applied another modifier “Wave”. Wave Modifier
(Motion Y, Height 0.5 m, Width 0.5 m, Narrowness 1.5 m). In the wave vertex group, I
choose the vertex group that I applied in the edit mode. Now in the shader mode, I applied a
new shader. Here I used Mix Shader, Math node, Emission, Transparent BSDF, ColorRamp,
Noise Texture, Gradient Texture, Fresnel, Mapping and Texture Coordinate. I connected each
node properly. By key-framing the Mapping node I animated the spaceship booster. Figure
4.3.108: Spaceship and Booster Animation After the booster animation I took an empty
cube. I linked all the parts of spaceship and the boosters with the empty cube. Next I
imported spaceship into the main DSRA scene. I placed the spaceship on the top. By
selecting the empty cube, I added key-frame on the Y axis. I moved the cube few frames
forward at Y axis and applied key-frame. In this way I animated the spaceship. Next I started
animating the drone model. At first I started animating the propeller. I selected one propeller
first then at frame 1 I applied a key-frame on the Z rotation 0° value. At frame 10 I choose
1080° value and key-framed it. To make is continuous loop animation I added “Cycles”
modifier on the Z rotation. Drone propeller “Cycles” modifier info: Before Mode - Repeat
Motion, After Mode - Repeat with Offset. I did the same settings for the other three
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propellers. Figure 4.3.109: Drone Animation To animate the drone movements, I used here
“Follow Path” constraint. At first I took an empty cube. I linked all the drone model parts with
it. Then by pressing Ctrl+A > Curve > Path. I edited the path to make a path way around the
DSRA environment. Next, I positioned the empty cube at the start point of the path. Next, I
selected the empty cube and by pressing the “Shift” key I selected the path. By pressing
Ctrl+A > Follow Path. I rotated the drone as I needed. In this way I animated the drone.
Next animation was animating the main gate of DSRA. This was really satisfying animation.
Each of the gate handle will open individually here. At first I moved the origin point in where
the object will rotate. At frame 725 I applied a key-frame on the Z rotation with 0° value.
Next, at frame 760 I rotated it 90° and applied key-frame on Z axis. There was a “Array”
modifier on the gate and I Applied it. In the edit mode I separated all the 18 handles to
make those individual. I selected each of the handles and moved the key-frames two frame
backward from the previous handles key-frames. In this way the left part of the gate was
animated. To animate the right part of the gate I took an empty object first. I duplicated all
the left gate handles and linked it with the empty object. I applied mirror at X axis global to
make the right side gate animation. Figure 4.3.110: DSRA Gate Opening Animation Figure
4.3.111: DSRA Gate 3 I also animated the CC camera of the research association. CC camera
will continuously rotate left to right and right to left. Here I key-framed Z rotation and
applied “Cycles” modifier to make continuous loop animation. On the backside of the camera
there is a cable which I modeled using the Bezier curve. I made this cable to move along
with the CC camera. To make this happen, I selected the camera first then the cable model.
Next, I pressed tab to switch the edit mode. I pressed Ctrl+H > Hook to Selected Object. So,
the curve/cable model hooked with the CC camera and now when the camera rotates the
cable moves with the camera as well. Using the collection instance I made a copy of the CC
camera and all the animation of it. Then I placed the camera opposite side of the gate.
Figure 4.3.112: DSRA CC Camera Animation Rendering: Scene 1 (Subway train station)
render setup: Render Engine - Cycles, Device - GPU Compute, Noise Threshold - checked
(0.008), Max Samples - 512, Min Samples - 250, Time Limit - 2 min, Denoise - checked,
©Daffodil International University Denoiser - OptiX, Passes - Albedo and Normal, Resolution
X - 3840 px, Resolution Y - 1740 px. Frame Rate - 30 fps. Scene 2 (Daffodil Space Research
Association) render setup: Render Engine - Cycles, Device - GPU Compute, Noise Threshold -
checked (0.012), Max Samples - 310, Min Samples - 170, Time Limit - 1.1 min, Denoise -
checked, Denoiser - OptiX, Passes - Albedo and Normal, Resolution X - 1920 px, Resolution Y
- 870 px. Frame Rate - 30 fps. Post-production: In the post-production stage, I did text and
title animation, intro animation, sound design, compositing and editing. Sound Design: At
first I created some scene voices using the text to voice converter from a website name
voicemaker. From here I created three voices from text which are, - Attention! Train arrived
in Ashulia station. Please get down carefully. - This is Daffodils restricted area. Stand still for
a verification. - Access granted. You’re seven minutes late for work. In that website I applied
a voice artist voice, name Salli. It’s a female voice. After creating all the voice, I downloaded
those as mp3 format. Then I used a sound maker software to make sci-fi type voice. That
software name is “Audacity”. Here I’m going to explain how I made simple voice to sci-fi
voice. At first I opened the voice audio file into the Audacity software. By selecting the audio
I pressed Ctrl+C. Next, from the “Tracks > Add New > Stereo Track”. Then press Ctrl+V on
the new track. Then select the new track. Go to “Effects > Delay and Reverb > Echo” Echo
settings: Delay time (seconds): 0.04, Decay factor: 0.6. Then apply. Next, “Effects > Pitch
and Tempo > Change Pitch”. Pitch settings: Pitch: from 3 to 3, Semitones (half-steps): -1.82,
Frequency: from 208.696 to 187.826 Hz, Percent Change: -10.00 Then apply. Figure
4.3.113: Audacity Voice Sound Editing After the voice sound creation, I started collecting the
other sound effects and back ground music. Sound effects like alien creature sound effects,
footsteps, heartbeat, breathing sound, screaming sound, scanning SFX, login SFX, calling bell
and back ground music like horror back ground music, sci-fi background music I collected for
my animation. Intro, Title and Text Animation: At first I did the “Racy Blue Animation” intro
using After Effects. To make this intro to look like sci-fi I used here glitch effects. Adding one
by one effects on the logo and animating those as needed I completed this intro animation.
Intro animation effects info: Displacement Map, Invert, Transform, CC Scale Wipe, Mirror,
Glow and 4-Color- Gradient. Figure 4.3.114: Racy Blue Intro Animation Then I export this file
as 1920x1080p, Frame Rate - 30fps, Pixel Aspect Ratio: Square Pixels. The main title
animation of the short animated movie was made using After Effects. By using textures and
too many effects on the scene and animating those I finally able to get the title animation of
the short animated film. The title name is “Alien: First Kill”. For the title I used two fonts,
Conthrax and Nasa. For the final edit of the title I duplicated the comp layer two times and
added an effects name “Shift Channels”. Shift Channel effects info: 1st layer: Take Alpha
From - Alpha, Take Red From - Full off, Take Green From - Green, Take Blue From - Full off.
2nd layer: Take Alpha From - Alpha, Take Red From - Full off, Take Green From - Full off,
Take Blue From - Blue. 3rd layer: Take Alpha From - Alpha, Take Red From - Red, Take Green



From - Full off, Take Blue From - Full off. This effect I used here to give a chromatic
aberrations feel to the title. And finally I took an Adjustment layer and I applied “Bad TV 2 -
old” effects on it. Figure 4.3.115: Main Title Animation Bad TV 2 - old effects info: Wave
Warp - off, Box Blur - (Blur Radius 4.0, Iterations 1, Blur Dimensions - Horizontal), Color
Balance - Saturation 33, Noise - off, Venetian Blinds - (Transition Completion 15%, Direction
+90°, Width 5, Feather 1.0). Then I export this file as 1920x1080p, Frame Rate - 30fps,
Pixel Aspect Ratio: Square Pixels. Next text animation was “Alien. They exist or not…”. At first
I took a fresh After Effects scene, 1920x1080p, Frame Rate - 30fps. I typed that text on the
scene by using text tool. I used here a font name “Conthrax”. In the layer drop down menu,
in the animation properties > Opacity. Fill Opacity - 0%, Smoothness - 0%, Based On -
Characters. In the Range Selector 1 animate (Start 0% to 100%) after few frames and End
will be 100%. After animating the text, I duplicated the text layer two times. And I applied
“Shift Channels” effects on those layers to make a chromatic aberrations feel. I also added
“Bad TV 2 - old” effects on it. Figure 4.3.116: Message Text Animation For the name card
text animation, I used an After Effects preset called “Unique” text animation. I took different
text layers and typed text to those text layers and placed those one after one. Then I applied
“Unique” text preset on those to make the text animations. I used “Conthrax” font, “Shift
Channels” and “Bad TV 2 - old” effects on those. Figure 4.3.117: Name Card Text Animation
For the lower third text animations and the “They Just Arrived” text animation I collected
some sci-fi glitch text animation template from the internet. After that, I customized them
with my text and I applied some effects like “Shift Channels” and “Bad TV 2 - old” on those
text. For the font I used here “Conthrax” font which is a very cool looking font. Figure
4.3.118: Lower Third Text Animations Compositing, Editing and Color Correction: For
Compositing, at first I started adding the sequence rendered images to the After Effects
project panel. The scene 1 (Train Station Scene) was 4k resolution. So, I took a 1920x1080
comp with 30fps and placed all the sequence images one after one to the scene and scale
those down 50% to fit it with the comp size. Next, the scene 2 (DSRA Scene) sequence
images I place after the scene 1 accordingly. I merged each sequence layer by key-framing
and animating the opacity. Next step was adding the SFX, BG music and voice to the scene. I
started editing the sounds by synchronizing with the sequence layers. Next step, I took
another comp and placed this sequence comp inside the new comp. After duplicating the
sequence layer two times I applied “Shift Channels” effects on those layers for a chromatic
aberrations feel. Sequence comp Shift Channels effects info: 1st layer: Take Alpha From -
Alpha, Take Red From - Red, Take Green From - Full off, Take Blue From - Full off. 2nd layer:
Take Alpha From - Alpha, Take Red From - Full off, Take Green From - Green, Take Blue From
- Full off. 3rd layer: Take Alpha From - Alpha, Take Red From - Full off, Take Green From -
Full off, Take Blue From - Blue. Next, I took an adjustment layer on the top of all layers to
apply some sci-fi and cinematic effects and color correction. I applied “Bad TV 2 - old” effects
on that adjustment layer. Bad TV 2 - old effects info: Wave Warp - off, Box Blur - (Blur
Radius 2.0, Iterations 1, Blur Dimensions - Horizontal), Color Balance - Saturation 5, Noise -
(Amount of Noise 2.0%, Noise Type - Use Color Noise, Clipping - Clip Result Values),
Venetian Blinds - (Transition Completion 10%, Direction +90°, Width 4, Feather 0.5). I also
added a letter box to the entire composition to give a cinematic look and its resolution was
1920x870. The letter box was just a solid layer and I inverted its mask to create it. Figure
4.3.119: Editing and Compositing The Scenes Next step was adding scan effects on the
screen. There is a scene where the scanner scanning the main character. At that point, I
created a layer mask using the pen tool to make that effect. Here, Mask Path - Shape, Mask
Feather - 48 pixels, Mask Opacity - 100%, Mask Expansion - (-10 pixels). By animating the
position of the mask with the main scanner I created this scanner effect on the scene. Figure
4.3.120: Scanning Effect Final Output: Finally, I took a new comp with 1920x1080 and
30fps. I started placing all the intros, Alien message animation, scene comps, title animation
and name card text animation one after one. Then I finally rendered the sci-fi short animated
film. Render Setting: Render Resolution – (Width 1920px & Height 1080px), Pixel Aspect
Ration – Square Pixels, Frame Rate – 30 Frames per Second, Resolution – Full, Duration –
0:05:00:00 Minutes, Format – AVI/MP4, Video Output Channels – RGB. CHAPTER 5 Result
5.1 3D Product Modeling (Bubble Tea Shop) Final Result Bubble Tea: Cranberry, Passion Fruit,
Kiwi, Original, Taro, Yin Yang final render result. I combined these six render output into one
image. Figure 5.1.1: Bubble Tea Final Render Image 1 Bubble Tea: Last eight bubble tea
models final render result. Figure 5.1.2: Bubble Tea Final Render Image 2 5.2 3D
Visualization (Sato V Trap Installation Process) Final Result It’s a single render image of Sato
V Trap. Main file is actually an animated video file. Figure 5.2: A single Render Image of Sato
V Trap Animation ©Daffodil International University 5.3 Story Based 3D Animation (Story
Based Short CG Animation) Final Result Alien - First Kill: Two render images from the
animation video. One is from scene 1 and another is from scene 2. Figure 5.3.1: Subway
Train Station Render Image (Scene 1) Figure 5.3.2: Daffodil Space Research Association
Render Image (Scene 2) CHAPTER 6 Conclusion The field of 3D modeling, visualization and
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animation has seen tremendous growth in recent years and it continues to expand and
evolve at an incredible pace. These techniques have dramatically altered the way in which
designers, artists and engineers bring their ideas to life and communicate their concepts.
From product design and architecture to gaming and film, the applications for 3D modeling,
visualization and animation are incredibly diverse and continue to expand. It is clear that the
future of 3D modeling, visualization and animation is very promising. With the ongoing
advancements in technology, the potential for these techniques is endless. We can expect to
see continued growth and development in this field, leading to new and innovative
applications and even more advanced and sophisticated techniques. Whether you are a
designer, artist, or engineer, it is an exciting time to be involved in 3D modeling, visualization
and animation, and it will be fascinating to see how this field continues to grow and evolve in
the years to come. REFERENCES 1. FutureLearn (March 18, 2022).
https://www.futurelearn.com/info/blog/general/what-is-3d-modelling [Accessed on: 11th
December, 2022 at 09.45 am] 2. Yahong Zhang and Ritesh Patil (July 14, 2019),
Hapticmedia. https://hapticmedia.com/blog/3d-visualization-definition-benefits-software
[Accessed on: 11th December, 2022 at 10.00 am] 3. DD3D-Studio. https://www.dd3d-
studio.com/frequently-asked-questions/general- dd3d-qa-2/what-is-3d-visualization
[Accessed on: 11th December, 2022 at 10.10 am] 4. (December 14, 2020), Point in Time
Studios. https://hapticmedia.com/blog/3d- visualization-definition-benefits-software
[Accessed on: 11th December, 2022 at 10.25 am] 5. Renderforest Staff (May 11, 2021),
Renderforest. https://www.renderforest.com/blog/3d-animation [Accessed on: 11th
December, 2022 at 11.00 am] 6. Justin Beegel, Infographic World.
https://infographicworld.com/what-is-3d- animation [Accessed on: 11th December, 2022 at
11.15 am] 7. Holly Landis (April 15, 2022), Skillshare.
https://www.skillshare.com/en/blog/3d- animation-a-brief-history-and-a-look-to-the-future
[Accessed on: 12th December, 2022 at 09.23 am] 8. (February 4, 2022), Animation
Explainers. https://animationexplainers.com/the- history-of-3d-animation [Accessed on:
12th December, 2022 at 09.29 am] 9. AAVA 3D. https://aava3d.com/about-aava-3d-
animation-journey [Accessed on: 12th December, 2022 at 09.59 am] 10. (April 21, 2020),
3D for Science. https://3dforscience.com/types-of-medical- animation [Accessed on: 12th
December, 2022 at 10.07 am] 11. Devon Scott Leslie (April 19, 2022), Cad Crowd.
https://www.cadcrowd.com/blog/3d-modeling-overview-history-industry- applications
[Accessed on: 13th December, 2022 at 08.19 am] 12. UFO 3D. https://ufo3d.com/history-of-
3d-modeling [Accessed on: 13th December, 2022 at 08.35 am] 13. Ch B Minnegalieva, Lilia
Khairullina, R I Gabdrakhmanov and A I Khambelov (April 2020), ResearchGate.
https://www.researchgate.net/publication/341372981_3D_modeling_in_the_study
_of_the_basics_of_computer_graphics [Accessed on: 13th December, 2022 at 09.03 am] 14.
EDUCBA. https://www.educba.com/what-is-3ds-max [Accessed on: 13th December, 2022 at
10.33 am] 15. Kevin Kennedy (March 22, 2020), All3DP. https://all3dp.com/2/what-is-3ds-
max- simply-explained [Accessed on: 13th December, 2022 at 10.48 am] 16. EDUCBA.
https://www.educba.com/what-is-blender [Accessed on: 14th December, 2022 at 08.09 pm]
17. Tanner Hartmann (May 21, 2020), All3DP. https://all3dp.com/2/blender-simply-
explained [Accessed on: 14th December, 2022 at 08.48 pm] 18. Javatpoint.
https://www.javatpoint.com/blender [Accessed on: 14th December, 2022 at 09.26 pm] 19.
Wikipedia. https://en.wikipedia.org/wiki/Blender_(software) [Accessed on: 14th December,
2022 at 10.03 pm] 20. Wikipedia. https://en.wikipedia.org/wiki/RealFlow [Accessed on: 14th
December, 2022 at 10.41 pm] 21. Toolfarm.
https://www.toolfarm.com/buy/next_limit_realflow_standard_license [Accessed on: 14th
December, 2022 at 11.23 pm] 22. Wikipedia.
https://en.wikipedia.org/wiki/Adobe_After_Effects [Accessed on: 15th December, 2022 at
07.19 am] 23. EDUCBA. https://www.educba.com/what-is-after-effects [Accessed on: 15th
December, 2022 at 07.37 am] 24. Techopedia.
https://www.techopedia.com/definition/32364/adobe-photoshop [Accessed on: 16th
December, 2022 at 04.17 pm] 25. (March 18, 2022), American Graphics Institute.
https://www.agitraining.com/adobe/photoshop/classes/what-is-photoshop [Accessed on:
16th December, 2022 at 04.39 pm] 26. Gloria Lotha and Erik Gregersen (September 22,
2022), Britannica. https://www.britannica.com/technology/Adobe-Illustrator [Accessed on:
17th December, 2022 at 09.39 am] 27. June Escalada (April 4, 2022), Illustrator How.
https://illustratorhow.com/what-is- adobe-illustrator [Accessed on: 17th December, 2022 at
10.17 am] 31 50 73 87 101 120 147 ©Daffodil International University ©Daffodil
International University ©Daffodil International University ©Daffodil International University
©Daffodil International University ©Daffodil International University ©Daffodil International
University ©Daffodil International University ©Daffodil International University ©Daffodil
International University ©Daffodil International University ©Daffodil International University
©Daffodil International University ©Daffodil International University ©Daffodil International
University 1 ©Daffodil International University 2 ©Daffodil International University 3 ©

javascript:void(0);
javascript:void(0);
javascript:void(0);


Daffodil International University 4 ©Daffodil International University 5 ©Daffodil
International University 6 ©Daffodil International University 7 ©Daffodil International
University 8 ©Daffodil International University 9 ©Daffodil International University 10 ©
Daffodil International University 11 ©Daffodil International University 12 ©Daffodil
International University 13 ©Daffodil International University 14 ©Daffodil International
University 15 ©Daffodil International University 16 ©Daffodil International University 17 ©
Daffodil International University 18 ©Daffodil International University 19 ©Daffodil
International University 20 ©Daffodil International University 21 ©Daffodil International
University 22 ©Daffodil International University 23 ©Daffodil International University 24 ©
Daffodil International University 25 ©Daffodil International University 26 ©Daffodil
International University 27 ©Daffodil International University 28 ©Daffodil International
University 29 ©Daffodil International University 30 ©Daffodil International University 31 ©
Daffodil International University 32 ©Daffodil International University 33 ©Daffodil
International University 34 ©Daffodil International University 35 ©Daffodil International
University 36 ©Daffodil International University 37 ©Daffodil International University 38 ©
Daffodil International University 39 ©Daffodil International University 40 ©Daffodil
International University 41 ©Daffodil International University 42 ©Daffodil International
University 43 ©Daffodil International University 44 ©Daffodil International University 45 ©
Daffodil International University 46 ©Daffodil International University 47 ©Daffodil
International University 48 ©Daffodil International University 49 ©Daffodil International
University 50 ©Daffodil International University 51 ©Daffodil International University 52 ©
Daffodil International University 53 ©Daffodil International University 54 ©Daffodil
International University 55 ©Daffodil International University 56 ©Daffodil International
University 57 ©Daffodil International University 58 ©Daffodil International University 59 ©
Daffodil International University 60 ©Daffodil International University 61 ©Daffodil
International University 62 ©Daffodil International University 63 ©Daffodil International
University 64 ©Daffodil International University 65 ©Daffodil International University 66 ©
Daffodil International University 67 ©Daffodil International University 68 ©Daffodil
International University 69 ©Daffodil International University 70 ©Daffodil International
University 71 72 ©Daffodil International University 73 ©Daffodil International University 74
©Daffodil International University 75 ©Daffodil International University 76 ©Daffodil
International University 77 ©Daffodil International University 78 ©Daffodil International
University 79 ©Daffodil International University 80 ©Daffodil International University 81 82
©Daffodil International University 83 ©Daffodil International University 84 ©Daffodil
International University 85 ©Daffodil International University 86 ©Daffodil International
University 87 ©Daffodil International University 88 ©Daffodil International University 89 ©
Daffodil International University 90 ©Daffodil International University 91 ©Daffodil
International University 92 ©Daffodil International University 93 ©Daffodil International
University 94 ©Daffodil International University 95 96 ©Daffodil International University 97
©Daffodil International University 98 ©Daffodil International University 99 ©Daffodil
International University 100 ©Daffodil International University 101 ©Daffodil International
University 102 ©Daffodil International University 103 ©Daffodil International University 104
©Daffodil International University 105 ©Daffodil International University 106 ©Daffodil
International University 107 ©Daffodil International University 108 ©Daffodil International
University 109 ©Daffodil International University 110 ©Daffodil International University 111
©Daffodil International University 112 ©Daffodil International University 113 ©Daffodil
International University 114 ©Daffodil International University 115 ©Daffodil International
University 116 ©Daffodil International University 117 ©Daffodil International University 118
©Daffodil International University 119 ©Daffodil International University 120 ©Daffodil
International University 121 ©Daffodil International University 122 ©Daffodil International
University 123 124 ©Daffodil International University 125 ©Daffodil International University
126 ©Daffodil International University 127 128 ©Daffodil International University 129 ©
Daffodil International University 130 ©Daffodil International University 131 ©Daffodil
International University 132 ©Daffodil International University 133 ©Daffodil International
University 134 135 ©Daffodil International University 136 ©Daffodil International University
137 ©Daffodil International University 138 ©Daffodil International University 139 ©Daffodil
International University 140 ©Daffodil International University 141 ©Daffodil International
University 142 ©Daffodil International University 143 ©Daffodil International University 144
©Daffodil International University 145 146 ©Daffodil International University 147 ©Daffodil
International University 148 ©Daffodil International University 149 ©Daffodil International
University 150 ©Daffodil International University 151

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

